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FME Server Authoring

Workspace Authoring for FME Server Training Manual
This is the manual for the training course Workspace Authoring for FME Server.

This training provides a framework for authoring workspaces for FME Server. We hope that you will learn all the tools upon
which to base your work, and go home with many new FME ideas!

Course Structure
The full course is made up of five main sections. These sections are:
Introduction to FME Server
Running Workspaces on FME Server
Self-Serve with FME Server
Real-Time with FME Server
Automation with FME Server

Current Status
The current status of this manual is: COMPLETE: this manual can be used for training.
The status of each chapter is:
Chapter 0: Complete content. No exercises
Chapter 1: Complete content and exercises
Chapter 2: Complete content and exercises
Chapter 3: Complete content and exercises
Chapter 4: Complete content and exercises
Chapter 5: Complete content and exercises
Chapter 6: Complete content. No exercises
NB: Even for completed content, Safe Software Inc. assumes no responsibility for any errors in this document or their
consequences, and reserves the right to make improvements and changes to this document without notice. See the full licensing
agreement for further details.
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Introduction

About This Document
This manual is the introductory-level training course for authoring translations for FME Server.

Look out for residents of the City of Interopolis, who will appear from time-to-time to give you advice and dispense FME-related
wisdom. In fact, here comes someone now:

Mr. E.Dict (Attorney of FME Law) says...
On behalf of the City of Interopolis, welcome to this training course. Here is the standard legal
information about this training document and the datasets used during the course.
Be sure to read it, particularly if you're thinking about re-using or modifying this content.

Licensing and Warranty
Permission is hereby granted to use, modify and distribute the FME Tutorials and related data and documentation (collectively, the
“Tutorials”), subject to the following restrictions:
1. The origin of the Tutorials and any associated FME® software must not be misrepresented.
2. Redistributions in original or modified form must include Safe Software’s copyright notice and any applicable Data
Source(s) notices.
3. You may not suggest that any modified version of the Tutorials is endorsed or approved by Safe Software Inc.
4. Redistributions in original or modified form must include a disclaimer similar to that below which: (a) states that the
Tutorials are provided “as-is”; (b) disclaims any warranties; and (c) waives any liability claims.
Safe Software Inc. makes no warranty either expressed or implied, including, but not limited to, any implied warranties of
merchantability, non-infringement, or fitness for a particular purpose regarding these Tutorials, and makes such Tutorials available
solely on an “as-is” basis. In no event shall Safe Software Inc. be liable to anyone for direct, indirect, special, collateral,
incidental, or consequential damages in connection with or arising out of the use, modification or distribution of these Tutorials.
This manual describes the functionality and use of the software at the time of publication. The software described herein, and the
descriptions themselves, are subject to change without notice.
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Data Sources
City of Vancouver
Unless otherwise stated, the data used here originates from open data made available by the City of Vancouver, British Columbia.
It contains information licensed under the Open Government License - Vancouver.

Others
Forward Sortation Areas: Statistics Canada, 2011 Census Digital Boundary Files, 2013. Reproduced and distributed on an "as is"
basis with the permission of Statistics Canada. © This data includes information copied with permission from Canada Post
Corporation.
Digital Elevation Model: GeoBase®
Fire Hall Data: Some attribute data adapted from content © 2013 by Wikipedia, used under a Creative Commons AttributionShareAlike license
Stanley Park GPS Trail: Used with kind permission of VancouverTrails.com.

Copyright
© 2005–2016 Safe Software Inc. All rights are reserved.

Revisions
Every effort has been made to ensure the accuracy of this document. Safe Software Inc. regrets any errors and omissions that may
occur and would appreciate being informed of any errors found. Safe Software Inc. will correct any such errors and omissions in a
subsequent version, as feasible. Please contact us at:
Safe Software Inc.
Phone: 604-501-9985
Fax: 604-501-9965
Email: train@safe.com
Web: www.safe.com
Safe Software Inc. assumes no responsibility for any errors in this document or their consequences, and reserves the right to make
improvements and changes to this document without notice.

Trademarks
FME® is a registered trademark of Safe Software Inc. All brand or product names are trademarks or registered trademarks of their
respective companies or organizations.

Document Information
Document Name: FME Server Authoring Training Manual 2016
All screenshots and functionality relate to FME Desktop and FME Server 2016.1.1, Build 16601
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Course Overview
This training material covers how to create FME translation models for use on FME Server.
The training will introduce basic concepts and terminology, help you become an efficient FME Server user, and direct you to
resources to help apply the product to your own needs.

Prerequisites
This training material is intended for persons with some prior experience of using FME. It assumes a basic familiarity with the
concepts and practices covered of FME Desktop; at the very least to the extent covered by the FME Desktop Tutorial.
In particular it would be helpful to be familiar with:
Parameters and published parameters
Managing Readers, Writers and feature types in a workspace
Using transformers similar in complexity to the Clipper and Joiner

Course Structure
The full course is made up of five main sections. These sections are:
Introduction to FME Server
Running Workspaces on FME Server
Self-Serve with FME Server
Real-Time with FME Server
Automation with FME Server
The instructor may choose to cover as many of these sections as they feel are required, or possible in the time permitted. They
may also cover the course content in a different order and will skip or add new content to better customize the course to your
needs.
Therefore the length and content of the course may vary, particularly when delivered online.

About the Manual
The FME Server authoring training manual not only forms the basis for FME Server training – in-person or online – but is also
useful reference material for future work you may undertake with FME.
Each chapter has a short appendix with troubleshooting suggestions; general hints to follow in case FME Server causes problems
for you.
This training material is designed specifically for use with FME2016. You may not have some of the functionality described if you
use an older version of FME.

.1 UPDATE
The FME development cycle includes a number of follow-up releases; service packs we used to call them
A dialog box like this denotes features new or updated in FME2016.1, the first service pack since the .0
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Course Resources
A number of sample datasets and workspaces will be used in this course.

On Your Training Computer
The following applications may already be installed, licensed, and located on your training computer (real or virtual):
Java Virtual Machine
Apache Tomcat
FME Desktop Version 2016
FME Server Version 2016
PostgreSQL / PostGIS
The data used in this training course is based on open data from the City of Vancouver, Canada.
Most exercises ask you to assume the role of a city planner at the fictional city of Interopolis and to solve a particular problem
using this data.
Whether it's a local computer or a virtual computer hosted in the cloud, you'll find resources for the examples and exercises in the
manual at the following locations:
Location

Resource

C:\FMEData2016\Data

Datasets used by the City of Interopolis

C:\FMEData2016\Resources

Other resources used in the training

C:\FMEData2016\Workspaces

Workspaces used in the student exercises

C:\FMEData2016\Output

The location in which to write exercise output

< documents>\My FME Workspaces

The default location to save FME workspaces

You should also find a digital copy of this manual.
Please alert your instructor if any item is missing from your setup.
You can find the latest version of FME Desktop and FME Server for Windows, Mac, and Linux - together with the latest Beta
versions - on the Safe Software web site.

Course Etiquette
For online courses, please consider other students and test your virtual machine connection before the course starts. The instructor
cannot help debug connection problems during the course!
For live courses, please respect other students’ needs by keeping noise to a minimum when using a mobile phone or checking email.
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Introduction to FME Server
FME Server is a powerful product for handling large volumes of data at the enterprise level!
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What is FME Server?
FME Server is a powerful product for handling large volumes of data at the enterprise level. It has three core capabilities: SelfServe, Real-Time, and Automation!

Self-Serve
Self-Serve is the ability for the end-user to select and download the data they require, in the format and structure they require; or
to upload data for processing. It eliminates the need for a data manager/analyst to carry out manual data distribution tasks.

Real-Time
Real-Time is the ability to react to real-time events and sensors, to carry out immediate updates, and to deliver instant
notifications. It allows subscribers to have the most up-to-date information for their business decision making.

Automation
Automation is the ability to carry out data processing at a specific schedule, and to spontaneously move data through different
systems and web services – even onto mobile platforms and devices. It allows data to move from anywhere, to anywhere, without
manual intervention.

FME Server vs FME Desktop
FME Server expands on the local processing tools of FME Desktop by providing the same core data translations and
transformations, but at an enterprise level, and with the above enterprise-level capabilities.
With these capabilities, FME Server can take advantage of a huge variety of different communication technologies. This means it
can provide many different ways to:
Start a workspace
Structure a translation
Deliver the output
FME Server does not include an authoring tool, so FME Desktop is used to create these workspaces.
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The focus of this course is how to create these workspaces in ways that will take full advantage of FME Server’s enterprise
capabilities.
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FME Server Roles
When using a product with the range and scope of FME Server, it’s no surprise that there are a number of different roles available
to different users. Each different role usually has different interests in FME Server

Author
An author is someone who creates translations (workspaces) using FME Desktop and publishes them to FME Server for use by
end-users. This particular role is the focus of these training materials.
Typically an author would work at the analyst level, and would be an experienced FME Desktop user with a good understanding
of Readers, Writers, transformers, and other FME Workbench functionality.

User
A user is defined as a person who accesses data using an FME Server Service.
It is not expected that a user in this sense has, or needs to have, any experience of FME and does not even need to be aware of
FME Desktop or FME Server.
The user might be someone like a CAD operator checking out spatial data, a business manager looking at corporate data in an
FME Server client, or members of the public who want to download data for personal use.

Developer
FME Server can be used as the back-end to power other software applications.
A developer (in FME Server terms) is someone who creates applications that submit jobs to FME Server and then handle the
results. This role is somewhat covered by these training materials.
Web developers may choose to include FME Server Services within their own web applications or create their own services using
the FME Server API.

Administrator
An FME Server administrator is the person responsible for installing and maintaining FME Server and its related services.
The administrator’s tasks include:
Planning system architecture
Installing prerequisite applications
Installing and licensing FME Server
Setting up FME Server services
Monitoring FME Server services
Troubleshooting
Scaling FME Server

Miss Vector says...
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Hi, I'm Miss Vector, FME schoolteacher. I'll be here now and then to test you on your new FME Server
knowledge. For now, answer me this: Which of these is not one of the three core capabilities of FME
Server?
1. Automation
2. Real-Time
3. NoSQL Database
4. Self-Serve
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FME Server Architecture
FME Server consists of a number of different components.
The architecture of FME Server looks something like this:
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FME Server Components
Don’t worry about trying to understand the whole structure, just be aware of the main components of FME Server:
FME Engines: To carry out data transformation processing
Server Core: To queue jobs, handle scheduling, and manage load balancing
Web Services: To handle networking capabilities

FME Engines
FME Engines process job requests by running FME Workspaces. This is the same core engine, carrying out the same processing,
that is used by FME Desktop. An FME Server installation can possess multiple engines.

Each FME Engine processes a single request at a time.
FME Server processing can be scaled by adding FME Engines to the same computer or to separate computers within a distributed
FME Server environment.

Server Core
The FME Server Core manages and distributes job requests (queuing, request routing, scheduling), the repository contents
(workspaces, custom formats, custom transformers, data), and notification requests.

The FME Server Core contains a Software Load Balancer (SLB) that distributes jobs to FME Engines.

Web Services
Much of the FME Server networking capabilities are handled using what we call "Services". Services are software whose
interface provides communication between server and clients.
FME Server has a number of services:
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Data Download
Data Upload
Data Streaming
Job Submitter
KML Network Link
OGC Services (WFS and WMS)
Catalog
Token Security
Web Connection (SOAP)
REST
Notification
Some services (for example, Data Download) are “transformation” services that carry out data transformation, whereas others (for
example, Catalog) are non-transforming "utility" services.

Miss Vector says...
Here's a question to see if you grasp, not the details, but how FME Server works in general. I have an
FME Server with two engines. Four users submit jobs at the same time. What happens?
1. Two jobs are processed. Two jobs are returned to their authors.
2. Two extra engines will fire up automatically to process all four jobs.
3. The four jobs will be processed simultaneously, sharing the two engines.
4. Two jobs are processed. The other two sit in a queue until an engine becomes free.
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Deploying FME Server
FME Server can be deployed in a number of configurations

Platforms
FME Server can be deployed on a variety of platforms:

Local Infrastructure (Physical Hardware)
This is the traditional platform where you purchase FME Server and install it on your own hardware systems.

Infrastructure as a Service (Virtual Hardware)
This is where you purchase FME Server and install it on virtual hardware that is provided as service by a company such as
Amazon.

Platform as a Service (FME Cloud)
This is where FME Server is delivered pre-installed on an Amazon virtual computer, with the whole platform provided by Safe
Software on a pay-as-you-go basis.

Distributed Systems
A distributed system is when different components of a system are located on separate, networked, computers.
For example, in a distributed environment FME Engines can run on a computer or computers that are separate from the FME
Server host. Administrators can configure the FME Engines to register with a failover FME Server host, which acts as a backup if
the primary FME Server host fails.
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NEW
This layout reflects the architecture of FME2016, which no longer uses a FlexLM license server. Instead
licensing is now stored in the FME Server System Share, which multiple FME Server Cores can point
towards.
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FME Workbench and FME Server
FME Workbench is the authoring environment for FME Server translations. It has functionality specifically for FME Server.

FME Desktop as an FME Server Authoring Tool
FME Server can be called a model-driven architecture, because the specification for a translation is expressed as a model. In FME,
these models are better known as workspaces.
Workspaces are created – we call it “authored” – using FME Desktop. In particular, the FME Workbench application is used.
FME Workbench is a client of FME Server, and so they form a client-server pair. However, both share the same core engine and
process data the same way.

Police-Chief Webb-Mapp says...
Hello, hello, hello. I'm the police chief, responsible for guiding you through this chapter - and for tracking
down crimes against FME.
So, let's make sure you get the terminology right. The application itself is called FME “Workbench”, but
the process defined in the canvas window is called a “Workspace”. The terms are so similar that they are
easily confused, but please don't, otherwise I will have to send my grammar squad to arrest you!
Although mistreating FME terminology is a minor offence the ignominy of being caught is long lasting!

The Workspace Authoring Workflow
The four basic steps to creating and using a workspace on FME Server are:
Author the workspace in FME Workbench
Publish the workspace from FME Workbench to FME Server
Run the workspace on FME Server
Maintain the workspace by downloading it from FME Server, making any required updates in FME Workbench, and republishing it back to FME Server.

Police Chief Webb-Mapp says…
Be aware that FME Workbench is part of the FME Desktop product and is not included as part of FME
Server.
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Workspace Management
Because Workbench is a client of FME Server, workspaces may be transferred to and from an FME Server repository. In fact the
only way to move a workspace to FME Server is using FME Desktop.

Transferring Workspaces
FME Workbench has the ability to:
Publish a workspace (upload it to FME Server)
Republish a workspace (upload a previously published workspace)
Download a workspace (retrieve it from FME Server)
These three capabilities are accessed in FME Workbench either through the menubar:

...or the toolbar:

Repositories
Repositories are storage facilities for FME Server workspaces. Each FME Server may have multiple repositories, but any
workspace can only belong to one of them.
Published workspaces are held on FME Server in a file-based part of the repository.
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All metadata related to the workspace is held separately in FME Server’s repository database. This metadata includes information
about source and destination datasets, workspace feature types, and published parameters.

Repositories are managed by the FME Core. They can be accessed (by authors and administrators) through the web user interface.

Police Chief Webb-Mapp says…
Security in FME Server is very important, and never more so than for repositories.
You can think of each repository as being like a folder on a file-system, with the same ability to grant
access rights to individuals and groups. So, for each repository you create, be sure to check the security
settings. If you don’t then end-users may not get access to the repository!

Miss Vector says...
If I wanted to find out about workspaces stored in a repository - for example I'm building a tool to
catalogue my workspaces - what is the best way to do it?
1. Use the FME Server REST API
2. Scrape the contents of the Server repository page
3. Get a file listing from the repository folder
4. Connect to the FME Server database to query it directly
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Publishing a Workspace
Once a workspace has been authored it is published to FME Server. The publish tool in Workbench opens a simple wizard
interface that connects to FME Server using the REST API.

Connecting to Server
The first dialog in the publishing wizard is where a connection is defined.
Workbench can connect to FME Server by web connection (using HTTP and the REST API). The web connection requires the
URL of the Server. HTTP is used when the FME Server is not on the same Local Area Network, but on a web-accessible server.

The dialog also provides fields in which to define connection credentials. Note the ability to save time by reusing Windows
session credentials

TIP
To avoid entering the same parameters every time a connection is made, set the parameters, click the
Defaults button, and select ‘Save as My Defaults'. Now these parameter values will be used automatically
every time the connection dialog is opened.

Repository Selection
The next dialog defines the repository for the workspace:

Either an existing repository can be used, or a new one created. The workspace name can also be edited, even making it different
to what it is saved as locally.
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Connections Upload
This dialog only appears when there are database and/or web connections that need to be uploaded with the workspace.

Here there is both a database connection and a web connection that needs to be uploaded for this workspace to function on FME
Server. Notice that the web connection needs additional authentication before FME Server will be allowed to use it.

Workspace Registration
The final dialog defines which services the workspace is to be registered against.

The Job Submitter service allows FME Server to run a workspace as-is. This is the closest to running a workspace on FME
Desktop. All inputs and outputs are defined in the workspace so data is simply written out and not streamed or delivered in any
other manner.
Job submission is ideal for testing workspaces, and for running large-scale and batch translations that make use of the server
process queue.

Republishing a Workspace
Once a workspace has been published, the republish tool becomes active. Further updates to the workspace (within the same
session) can then be uploaded with a single click.
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The same parameters are used as before. If changes need to be made to these parameters, then the full publishing wizard should be
used.

Downloading a Workspace
Workbench can also “download” a workspace held in an FME Server repository. This is usually done in order to make edits to the
workspace. Note that downloaded workspaces are copies of the original, which remains in the FME Server repository.
The downloading wizard begins with the same connection dialog as the publishing wizard. From there, the second – and final –
dialog page is a repository and workspace selection tool:

The user is then prompted for a location to save the workspace. The default is <user>/FME/My FME Server Workspaces. The
workspace – and resources – are then downloaded.
Once downloaded, the workspace is automatically opened within Workbench for editing.

Ms. Analyst says…
Besides workspaces, it’s also possible to publish/download FME custom transformers and custom formats
to/from a server repository.
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Exercise 1

Earthquake Processing

Data

Earthquakes (GeoJSON)

Overall Goal

Create a workspace to read and process earthquake data and publish it to FME Server

Demonstrates

Publishing a workspace to FME Server

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Basics-Ex1-Complete.fmw

You're a technical analyst in the GIS department of your local city. You have plenty of experience using FME Desktop, and your
department is now investigating FME Server to evaluate its capabilities.
Within minutes of installing FME Server the building starts to shake. You deduce that the two events are not related and in fact a
(very minor) earthquake is taking place.
Because of this, and because emergency preparedness is a big topic, you start to wonder if there is anything you can do with FME
Server on the subject of earthquakes.

1) Inspect Feed
A colleague informs you about a feed of earthquake data at:
http://earthquake.usgs.gov/earthquakes/feed/v1.0/summary/all_day.geojson
Click on that link (or copy/paste it into your web browser) to view the raw data in the feed. It will look something like this:

OK. That looks like something we could handle in FME.

Police Chief Webb-Mapp says...
If you have lots of experience with FME Workbench - and if your instructor agrees - simply open the
workspace listed in the header above and skip to step 7

2) Start FME Workbench
Start FME Workbench by selecting it from the Windows start menu. You’ll find it under Start > All Programs > FME Desktop
2016.0 > FME Workbench 2016.0.
Once started, select Readers > Add Reader to start adding a Reader to the workspace. When prompted, enter the following details:
Reader Format

GeoJSON (Geographic JavaScript Object Notation)

Reader Dataset

http://earthquake.usgs.gov/earthquakes/feed/v1.0/summary/all_day.geojson
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Click OK to add the Reader to the workspace.

3) Inspect Source Data
Click on the Reader feature type in Workbench and choose the option to Inspect the data:

This will open up the source data in the FME Data Inspector and allow you to inspect it:

Tiles Courtesy of MapQuest

4) Add StatisticsCalculator
Let's calculate some statistics about the earthquakes we are reading. Place a StatisticsCalculator transformer and connect it after
the Reader feature type.
Open the parameters dialog. The first thing to do is set Group By to group-by the type attribute:

Type represents the type of event measured. Not only are there earthquakes, but also explosions and quarry blasts (browse the data
in the Data Inspector if you want to see if there are any).
Next set mag as the attribute to analyze:
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This will analyze the magnitude of the events and calculate statistics about them. The final step here is to specify which statistics
we want. To do so set:
Minimum Attribute

Min Magnitude

Maximum Attribute

Max Magnitude

Numeric Count Attribute

Number of Events

Mean Attribute

Average Magnitude

Empty all other fields, as we don't need those statistics:

5) Add AttributeRounder
Let's make sure those statistics are in a readable format. After the StatisticsCalculator place an AttributeRounder transformer. It
should be connected to the StatisticsCalculator:Summary output port:

Open the parameters dialog. Set up the transformer to round Min Magnitude, Max Magnitude, and Average Magnitude to 1
decimal place.
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6) Add Output
The final task in FME Workbench is to get the calculations out of the workspace. To do so, while we are just testing this exercise,
add a Logger transformer after the AttributeRounder.
This will cause the results to be written to the FME log file.

7) Publish to Server (Step 1)
Here comes the Server part of the process. In FME Workbench, choose File > Publish to FME Server from the menubar (or select
the same tool on the toolbar).
In the first dialog of the wizard you are prompted to enter connection parameters to FME Server.
Enter the parameters provided by your training instructor.
In most cases the parameters will be as follows:
FME Server URL: http://localhost
Username: admin
Password: admin

You may or may not (probably not) need to enter a port number with the hostname, depending on how the system is set up.
Click Next to continue. If the credentials are correct a connection will be made and you will move on to the next dialog in the
wizard.

8) Publish to Server (Step 2)
The next dialog prompts you to choose a repository in which to store the workspace.
For this exercise we’ll create a new repository by clicking the New button. When prompted enter the name Training.
Click OK to close the Create New Repository dialog. Enter a name for the workspace such as Basics-Ex1-Complete.fmw. The
Upload Data Files option should be greyed out, because we aren't using any source files in this case.

Then click Next to continue the wizard.
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9) Publish to Server (Step 3)
In the final screen of the wizard we can register the workspace for use with various services.
Select the Job Submitter service as this is the only service we are using for now and click Publish to complete publishing the
workspace.

After a workspace is transferred to Server, the log window displays a message reporting which workspace has been published to
which repository and for which services.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a workspace using a GeoJSON feed as the source
Publish a workspace to FME Server using the Publishing Wizard
Create a repository on FME Server using the Publishing Wizard
Register a workspace with the Job Submitter service using the Publishing Wizard
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Introduction to the FME Server Web Interface
Although translations are authored in FME Workbench, to use them on FME Server requires familiarity with the FME Server web
interface.
The web interface is accessed through the URL <servername>:<port>/fmeserver (the port may be optional) or through the start
menu:

Web Interface Home Page
The home page of the interface looks like this:

The home page is important because it includes several shortcuts to key functionality. For example, the top part of the page has
shortcuts to Run Workspace, Manage Schedules, and Manage Notifications:
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The lower part of the page has shortcuts to specific workspaces, grouped under Favourite Workspaces, Last Published
Workspaces, and Last Run Workspaces:

NEW
The Favourite, Last Run, and Last Published sections are new additions to an interface that was
redesigned for 2016

However, in general, functionality is accessed through the menu at the top of the home page:

The Manage menu has a number of options. A number of these come under the heading Administration:
Administration
Backup and Restore: Tools to backup the FME Server contents, or to restore a previous backup
CORS: Tools to manage Cross-origin Resource Sharing
Dashboards: Tools to monitor the health of FME Server through a series of reports
Engines and Licensing: Tools to license FME Server and manage the Server engines
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Security: Tools for setting security and access options
Services: Tools for managing the different services offered by FME Server
System Cleanup: Tools for cleaning up unwanted files such as logs and uploaded data
Other options provide access to a variety of tools:
Database Connections: Tools for managing pre-defined database connections
Web Connections: Tools for managing connections to web services
Jobs: Tools for managing jobs and reviewing job history
Notifications: Tools for setting up and managing notification services
Resources: Tools for managing data and other files uploaded to FME Server
Schedules: Tools for scheduling workspaces to run at specific times or specific intervals
Workspaces: Tools for browsing repositories and running workspaces

.1 UPDATE
The menu options Web Connections and Dashboards are new for FME2016.1
Also new for 2016.1 is the ability to add workspaces from the Last Published and Last Run lists to the
favourites list (i.e. in the above screenshots workspaces in these lists now have a star toggle button).
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Engines and Licensing
The engines and licensing page is the first stop to ensure FME Server is running correctly, is licensed, and has active engines. It is
accessed under Manage > Administration > Engines & Licensing on the menu.
The page looks like this:

The upper section relates to licensing. The labels show how many engines are licensing, when the license expires, and what the
machine key and serial number are. Buttons allow you to refresh the license, request a new one, or upload a license file.

The middle part shows the engines that are currently started, their FME build, operating system, and what jobs they are processing
(if any). The platform is important because a distributed FME Server setup can have engines running on a variety of operating
systems at the same time.
The lower part of the dialog allows you to easily change the number of engines running, up to the maximum provided for by the
current license:

38

Engines and Licensing

Miss Vector says...
Which of these are good reasons for running engines on multiple operating systems at the same time? Pick
all that apply.
1. A required format is only available on 32-bit or 64-bit, not both.
2. A required format is only available on Windows, or Linux, not both.
3. FME Desktop users author workspaces using a mix of Windows, Linux, and Mac platforms
4. You want to process heavy-scale jobs on a more powerful platform.
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Workspace Management
Workspaces are accessed through Manage > Workspaces in the web interface menu:

This brings up a list of repositories in which to browse for workspaces. Having selected a workspace in here (or by a shortcut on
the home page), all of the published parameters are shown along with a button to run the translation:

Having run, the interface will report the success of the translation:
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Jobs and Job History
The jobs and job history panel is used to find jobs that are currently running, that are queued to run, or that have completed
running. It is accessed through the Jobs tool on the menu:

.1 UPDATE
Notice that this menu has gained a new option - Web Connections - in FME2016.1.

The job page lists all of the jobs - here, the ones that have already been completed:

A drop-down menu allows you to select which user's jobs to display.

NEW
The ability to show jobs for a particular user is new for FME 2016. It's especially useful when the job
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history runs to thousands of workspaces from multiple users.

Queued or running jobs can be cancelled. Completed jobs can be examined in more detail by clicking on them. This brings up a
series of status and request information windows, plus a button to allow you to examine the FME log file:
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Server Dashboards
The FME Server Dashboards panel is used to display reports that show the general health of the FME Server installation.

.1 UPDATE
Dashboards and dashboard reports are a new feature for FME2016.1 (i.e. they are not part of
FME2016.0)

There are five default reports that exist in FME Server:

Each of these reports are simple HTML files. Clicking on a link opens that file in which a graph displaying the report information
is stored:
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In the above image, for example, the report shows how many jobs have been run on FME Server per day.

Police Chief Webb-Mapp says...
These reports are generated using - what else - FME workspaces. These workspaces use the
HTMLReportGenerator transformer and HTML format writer to create the graphs shown in reports.
These are fairly simple workspaces and it is entirely possible to create your own reports - preferably by
using an existing report as a template workspace. The Dashboards documentation explains how, but - in
brief - any HTML document that is written to the folder resources\dashboards\dashboards will appear as a
report in the Dashboards panel of the server web interface.

Generating and Using Reports
The reports in the dashboard panel are not generated and/or updated by default. To have them appear - and be updated - you must
carry out the following steps:
1. Browse to Manage > Workspaces and choose the Dashboards repository
2. Run the workspace JobHistoryStatisticsGathering.fmw to generate updated statistics
3. Return to Manage > Workspaces and choose the Dashboards repository
4. Run the workspace for the report you wish to add/update; for example DailyTotalJobs.fmw
5. Browse to Manage > Administration > Dashboards
6. Click on the chosen report to see the latest statistics
The workspace JobHistoryStatisticsGathering.fmw is also set up to run on a schedule. The schedule is called
DashboardStatisticsGathering, runs every 24 hours, and is set to Disabled by default. Therefore to get daily statistics automatically - requires this schedule to be first enabled.
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TIP
After FME Server Scheduling has been covered by this course, you'll find it very easy to change the
statistics-gathering schedule (say to hourly updates) and add schedules to re-run the dashboardgenerating workspaces too. Just be sure to schedule the dashboard workspaces to occur slightly *after*
the statistics-gathering workspace, so they are generating reports based on the latest information.
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Resources
FME Server has an inbuilt file management system that allows data, custom transformers, coordinate system definitions, and other
miscellaneous files to be published to a Server instance and used within all Server operations.
This setup is called Resources and is accessed using Manage > Resources from the web interface menu.
The resources home page looks like this:

Folders are opened by double-clicking on them in the interface.

NEW
This dialog used to be a tree view, with expandable folders showing files. However, this was changed in
FME2016 to a flat display where each folder is accessed and displayed separately. That's because - with
many hundreds of files - a tree view could become very, very lengthy, and very, very slow to display.

An individual folder in the Resources dialog looks like this:

Notice (highlighted) that this is the Data folder. It contains a single folder-based dataset called Zones. A number of buttons allow
data to be downloaded, deleted, copied, or moved.
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The View File button opens a pop-up dialog in which a file is selected to preview. Note that, like this PDF, it must be viewable in
a web browser:

The pop-up is closed by clicking the x button (highlighted).
In the main Resources window is also an option to upload files, or a folder of files. This can be used to upload any files that will
be needed by a translation. This includes datasets, custom transformers, coordinate systems, custom formats.

Miss Vector says...
Not just one, but two questions this time!
Firstly: I copy a workspace into a resources folder using the upload tool. What then?
1. I can run it by browsing the resources, selecting the workspace, and clicking run
2. I can run it through the Manage > Workspaces menu tools
3. I can run it by calling it with the FMEServerJobSubmitter transformer in FME Desktop
4. I can't run it because it's not properly published to a repository
Secondly: Uploading an entire folder of files come with what restriction?
1. Folder upload only works on certain web browsers
2. Folder upload requires the folders to be zipped into a single file
3. Folder upload only works on Windows C: drive (not D:, E:, etc)
4. Folder upload requires FME Desktop to be installed on the computer being uploaded from
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System Cleanup
When FME Server is used heavily for a long period of time, a number of files can build up and use system resources. These files
are either resource files (including multiple types of log file) or are job history records.
Both of these are cleaned up automatically by FME Server using tasks defined under Manage > Administration > System Cleanup

Resources
The resources cleanup dialog looks like this:

Notice that there are multiple types of logs and results files that can be cleaned. Each of these entries represents a task that is run
automatically by FME Server from time-to-time. When the task runs and finds files of the specified type, that are older than the
specified age, those files are deleted.
Should you wish to keep the files for longer than the pre-defined period you may either edit the file age setting (click on the task
to open a dialog for this), select and remove the task, or simply disable that task.
It's also possible to set up new tasks that search for files and clean them up. For example, you might create a cleanup task to
remove files that are periodically uploaded to a resources folder.

Job History
The job history cleanup dialog looks like this:
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It's a lot simpler dialog than for resources cleanup because there is only one type of information to clean. In this case you set the
maximum length of time that job history is kept for before being removed.

Miss Vector says...
What exactly are the entries in the resources cleanup dialog?
1. They are simply shortcuts to workspaces in the utilities category that I can run on demand
2. They are simply shortcuts to scheduling tasks that run at the described interval
3. They are specific tasks that FME Server runs once a day to help in system maintenance
4. They are specific tasks triggered when the system is low on resources
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Exercise 2

Earthquake Processing

Data

Earthquakes (GeoJSON)

Overall Goal

Create a workspace to read and process earthquake data and publish it to FME Server

Demonstrates

Examining the FME Server interface and running a workspace

Start Workspace

N/A

End Workspace

N/A

You're a technical analyst in the GIS department of your local city. You have plenty of experience using FME Desktop, and your
department is now investigating FME Server to evaluate its capabilities.
After creating a workspace to read a feed of earthquake data, and publishing it to FME Server, you now wish to log in to Server to
run that workspace.

1) Connect to Server
To log in to the server interface either select the Web User Interface option from the start menu or - in your web browser - enter
the address to your FME Server.

TIP
When FME Server is installed on either physical or virtual hardware, the address is
http://<servername>/fmeserver
If you are using FME Cloud, then the address is: http://<server name>.fmecloud.com/fmeserver

This will open the web user interface login screen for the FME Server being used. Bookmark this web address, since you will use
this link quite often.

2) Log In to Server
In the User Login dialog, enter a username and password for your FME Server account. A common username/password
combination for a training installation is admin/admin
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Click the Login button.

3) Examine the User Interface
This is your primary method for interacting with FME Server.
The first thing we should do is make sure FME Server is running correctly (the fact that we could log in is a good sign) and that
we are licensed and have engines running.
Click Manage > Administration > Engines & Licensing on the menu of the interface. This will open up the licensing section. You
should see a message informing you that FME Server is licensed and a list of the engines available:

TIP
If your machine is unlicensed, or is missing engines, then check with your instructor for troubleshooting
tips
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4) Select Workspace
Click the Home button on the menubar (or the FME icon in the top-left) to return to the Server interface home page. Notice that
the workspace created in the previous exercise is listed under Last Published Workspaces:

Click on this entry to open the web page for this workspace.

5) Run Workspace
The workspace page shows very few options, because this workspace did not have many published parameters:

So, simply click the Run button to run the workspace. The workspace will run to completion.

6) Examine Jobs Page
Click Manage > Jobs on the menu. A list of previously run jobs will open, including the one we just ran:
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Click on your job to inspect the results in more detail. You will be able to see the job ID number; the different times at which it
was submitted, queued, and run; the exact request made to FME Server; and the full results of the translation. You may also click
the View Log button to inspect the FME translation log file.

Police Chief Webb-Mapp says...
Remember, this workspace did not write any data, only sent it to the Logger. So, for now, to view any
results search for them in the log file.

Well done. You have now run a workspace on FME Server. But there are some more parts of the interface we should look into.

Advanced Exercise
If you have time, carry out the following steps to explore the FME Server web interface in a little more
detail.

7) Open Resources Page
Click Manage > Resources on the menu. This opens the Resources page. Feel free to explore the different folders. In particular
inspect the Engine folder, which is the location for custom tools that you might want to include in a translation:

Also check the data folder and, if you wish, upload some files from the C:\FMEData2016 folder.

8) Check Cleanup Tools
Click Manage > Administration > System Cleanup on the menu. This opens the dialog where all automated cleanup tasks are
defined.
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Take a look at the different cleanup tasks that are available. Note that the times are all specified in seconds.

Police Chief Webb-Mapp says...
If you change one of these parameters, don't expect it to take effect immediately. For example, if you
change the job logs time to be 1 second, they won't all disappear within a second. FME Server only runs
these tasks every hour, so it could be up to 60 minutes before the changes have any effect.

CONGRATULATIONS
By completing this exercise you have learned how to:
Log in to FME Server and check that it is running and licensed
Locate a workspace using the Last Published list
Run a workspace and inspect the job history to confirm it ran correctly
Find and upload resources to FME Server
Check the parameters for cleanup tools
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Scheduling
Scheduled Translations are the best way to kick off a workspace at a particular time or date

What is Scheduling?
Scheduling is the ability to program FME Server to run a workspace in a repository, at a specific time in the future. The schedule
can cause the workspace to run once or on a repeating basis.

Managing Scheduled Tasks
Scheduled tasks are set up in a the Web User Interface. Apart from a quick link on the main page for adding a scheduled task,
there is a section under the Manage menu:

The interface supports all the capabilities you would expect, including the ability to create new schedules, remove existing ones,
copy existing ones, and to enable and disable existing tasks:

Creating a Scheduled Task
There are a number of parameters involved in creating a scheduled task.
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The first parameters are very simple ones for naming and describing the schedule.

Notice that each schedule can be assigned to a particular category.
There is also a parameter for deciding whether the schedule will be enabled straight away.
The next few parameters concentrate on the workspace to be run.
Once a workspace is selected there will be a short pause while FME retrieves information about the workspace. It will then expose
any published parameters that exist in the workspace:

The key parameters, of course, are for setting the actual schedule. Here the workspace is set to run every week starting on the 30th
January at 2:00am
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There are also optional parameters for notification topics to trigger on completion of the scheduled task. These could be used to
inform an administrator of the success or failure of the translation.
Finally there are options to control job priority, job routing (which engine it should use) and job expiry (for jobs that are timesensitive and would be no longer useful if held back past a certain time by higher priority tasks).
Once the parameters are set for a scheduled task, it is added to the main Scheduling interface.
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Exercise 3

Earthquake Processing

Data

Earthquakes (GeoJSON)

Overall Goal

Create a workspace to read and process earthquake data and publish it to FME Server

Demonstrates

Scheduling a translation in FME Server

Start Workspace

N/A

End Workspace

N/A

You're a technical analyst in the GIS department of your local city. You have plenty of experience using FME Desktop, and your
department is now investigating FME Server to evaluate its capabilities.
You have already published a workspace that processes a feed of earthquake data, published it to FME Server, and ran it.
However... what happens if there is an earthquake in the night, when you are not at your post? Who will run it then?
The simplest method is to simply set up the translation to run on an automatic schedule.

1) Connect to Server
Open the FME Server interface, either through the Web User Interface option on the start menu or directly in your web browser,
and log in. Select Manage > Schedules from the menu.

2) Create Test Schedule
Just to confirm that scheduling does work, let's set up a test schedule. Click the New button to start this process. Set a name of
Test Schedule and add it to a Training category:

Under Workspace Settings, select the Training repository and from within that the workspace previously uploaded (Basics-Ex1Complete.fmw):

There are no user parameters we need to change for this workspace, so any can be ignored.
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3) Set Test Schedule
Now let's set some times for this schedule.
Set it to start immediately and run every 15 seconds. Set the end date to be approximately 30 minutes into the future (that way if
we forget to cancel the schedule it won't carry on for ever!)

Be aware that the times are given in 24-hour format, so 1:30 means AM and 13:30 means PM.
Now click OK to add the new schedule.

4) Examine Jobs Page
Click Manage > Jobs on the menu. A list of previously run jobs will open. You will find (if it was set up correctly) that there will
be jobs running to schedule:

5) Create Actual Schedule
Now we are confident that we know how to use the interface, let's set up an actual schedule. We want the workspace to run, say,
every two hours, each day of the week. There should also be no end date.
So, return to the Schedules page. You may now either:
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Click on the Test schedule and edit it to the required values
Delete the test schedule and create a new one with the required values

You may wish to check back periodically during this training to ensure the workspace runs as expected.

CONGRATULATIONS
By completing this exercise you have learned how to:
Schedule a translation in FME Server
Check the job history to ensure the scheduled translation took place
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FME Server Security
FME Server includes security to prevent unauthorized users from accessing services and other resources. All security information
for FME Server is stored in the repository database and is managed using the FME Server Web User Interface.
The key to setting up FME Server security is to have a clear plan on which services and accounts will be provided with open
access, and which need to be restricted.

Roles and Users
Security is implemented using a system of roles and users. A role is best described as a function of the person; for example user,
author, or administrator. Each user account is associated with one or more roles.
A default set of roles is defined when FME Server is installed. These are:
fmesuperuser: For users with unlimited access to the system
fmeadmin: For users who need to carry out specific administration tasks
fmeauthor: For users who are authoring workspaces to run on FME Server
fmeuser: For users who need to run (but not author) workspaces
fmeguest: For temporary users who need a minimal set of permissions
A number of default accounts are created too. These are:
admin: Assigned to the fmesuperuser and fmeadmin roles
author: Assigned to the fmeauthor role
user: Assigned to the fmeuser role
guest: Assigned to the fmeguest role

Police Chief Webb-Mapp says...
Don't forget, these are just default accounts that FME creates. You can create any role necessary for your
system, assign any specific security settings to it, and create any number of users assigned to that role.

Rather than apply security settings to individual users, FME Server allows you to apply them to specific roles. That way the
settings can be changed for multiple users at once.
There are a number of different policies that can be applied to each role.
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Role Policies
There are various sections of security policies that can be set for each role.

General
These are general policies such as the ability to manage jobs, services, and security. For example, if you don’t have the ability to
manage security, that item will be missing from the main menu of the user interface.

Topics
Topics are related to Notifications, which we’ll cover later. Different capabilities – read, write, publish, remove – can be assigned
for each topic you create.

Resources
Resources are files and datasets stored on FME Server. Different permissions – read, write, upload, delete – can be assigned to
each resource.

Services
Services are key items of functionality on FME Server. They are the different methods by which a workspace can be run and
output data delivered. Each role can be allowed – or not – to use a particular service.

Repositories
As you know, repositories are a place to store and categorize workspaces. Each role can be given different permissions for each
and every repository.

Connections
Connections are predefined logins to either web services or databases. Each role can be given permission to access different
connections stored in FME Server.

Applications
Applications are the different ways in which FME Server can be accessed. For example, it’s possible to control access to the FME
Server Web Interface for a specific role.

Other Security Functions
FME Security can be fully integrated with both Active Directory and Integrated Windows Authentication (IWA). The FME Server
Administrators Guide explains how this can be achieved.

Encryption
FME Server also allows Secure Sockets Layer (SSL) connections in order to encrypt transaction data. This is most important for
ensuring sensitive log in information is not exposed and is particularly important when you are using Active Directory.
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Again, the FME Server Administrators Guide explains the steps needed to implement this. In brief the process consists of two
steps:
Modify web service URLs to use HTTPS instead of HTTP
Enable SSL on the web and/or application server.

Police Chief Webb-Mapp says...
I am the law! The FMESuperUser role is the high court of FME Server and is granted all permissions on
all security settings. What’s more, these permissions cannot be revoked, unset, or appealed against!
So, be sure not to assign accounts to the FMESuperUser role unless you really, really mean for them to be
given that degree of power!

Miss Vector says...
If I want one user to have a higher level of access to other users in the same role (say I wish to let an FME
author be able to manage engines) what must I do?
1. Simply select that user from the user list and set the manage engine policy to yes
2. Promote that role to superuser status so that the user has a higher level of security
3. Create a new role with manage engines = yes and move that user to it
4. Create a new role with manage engines = yes and add that user to it as well as the original role
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Exercise 4

Earthquake Processing

Data

Earthquakes (GeoJSON)

Overall Goal

Create a workspace to read and process earthquake data and publish it to FME Server

Demonstrates

Setting security options in FME Server

Start Workspace

N/A

End Workspace

N/A

You're a technical analyst in the GIS department of your local city. You have plenty of experience using FME Desktop, and your
department is now investigating FME Server to evaluate its capabilities.
You've already created a workspace to read a feed of earthquake data and published it to FME Server. Now you want to make sure
that other users have permission to run it.

1) Connect to Server
Open the FME Server interface, either through the Web User Interface option on the start menu or directly in your web browser,
and log in. Select Manage > Administration > Security from the menu.

2) Create User
Let’s create a new user account for a person who might make use of this workspace. Click on the Users tab and then on the New
button:

When prompted, create a new user with the following parameters:
User Name: WebGuest
Full Name: Web Interface Account
Roles: fmeguest
Password: WebGuest1

3) Check Role Permissions
If this user is to have access to the web interface, we should check that in the security settings.
Click on the Role Policies tab and then choose the fmeguest role as the one to examine. At the very bottom of the list is a
parameter for FME Server Web User Interface. It will be turned off by default. This means someone in this role could not possibly
access the workspace through the web interface.
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We could simply turn on that parameter - but then that would give every guest user the ability to access the interface, and this
might not be a good idea. So, let's create a new role.

4) Create Role
Click the Role tab and select the checkbox for the fmeguest role. Click the Duplicate button to create a copy of it:

Call this role EmergencyPreparedness. Remove the guest account from this role and click OK to create it.

5) Set Role Permissions
Now back in the Role Policies tab choose the EmergencyPreparedness role as the one to examine.
Firstly check the option for Manage Repositories. This will let the user find workspaces and run them.
Next set the parameter for Web Interface access to yes:

Also scroll up slightly and check the settings for the Training repository. This role needs to have full access to this repository, as
shown:

Click the Apply Changes button to save the changes you have made.

6) Test Role
Log out of the web interface (Admin > Log Out) and then log in again as the new WebGuest account.
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Click the Run option on the menu and run the earthquake workspace.

Police Chief Webb-Mapp says...
If you don't see a Run option on the menu, you probably missed setting Manage Repositories = Yes in step
5.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a new user and new role on an FME Server installation
Set permissions on an FME Server role
Test a newly created role/account to ensure it works correctly
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Troubleshooting for Administrators
This section shows a few basic troubleshooting techniques in case of emergency

FME Workbench-FME Server Connection
If you are unable to connect from FME Workbench to FME Server then the following suggestions may be of help.
Check if there is a firewall running on either your computer or the FME Server. If so, you must open port 7071 to use Direct
Connection or port 80 (or 8080) to use the Web Connection.
Restart the FME Server Services. On Windows, go to Start > Programs > FME Server > Windows Service > right-click
Restart and select Run as administrator.

Web User Interface
If you are unable to access the Web User Interface then the following suggestions may be of help.
Confirm that FME Server is installed and running! The easiest way to be sure is to restart FME Server using Start >
Programs > FME Server > Windows Service > Restart
Check whether FME Server was installed using an application server port other than 80. For example, if port 80 was already
being used the installer might have used a different port; 8080 is most common. To check, try entering the URL with this
syntax http://<host>:<port>/fmeserver - for example http://localhost:8080/fmeserver

Workspaces are Queued but not Run
If a workspace appears in the FME Server queue, but is never executed, then it may be because no engines are running.
Check the Web Interface (Manage > Engine Management) to confirm engine status. If no engines are available check
licensing and update as necessary. Restart FME Server once a proper licence is in place.

Workspaces Fail when Run
If a workspace fails when it is being run, then the following suggestions may help
Run the workspace first on FME Desktop. If it does not work there, it will not work on FME Server.
Check the FME log file using Manage > Jobs > Completed in the Web Interface. This may help to explain why there is a
problem.

Scheduling
If a scheduled workspace appears to have not been run at the expected time, then the following suggestions may be of help.
Ensure an engine is available, and that the scheduled job is not in a queue.
Check the date and time very carefully to ensure the correct values were entered
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Check the timezone is correct. The web interface operates on local timezone, which is not necessarily the same timezone as
the server is physically located.
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Module Review
This module introduced you to FME Server and the Web user Interface used to access most of its functionality

What You Should Have Learned from this Module
The following are key points to be learned from this module.

Theory
FME Server is a powerful product for handling large volumes of data at the enterprise level. It has three core capabilities:
Self-Serve, Real-Time, and Automation.
FME Server provides the same processing core as FME Desktop, but on the enterprise level. It does not include an authoring
tool, for which FME Workbench is required.
Someone who creates translations for use on FME Server is called an author.
The three main components of FME Server are FME Engines, the Server Core, and Web Services
FME Server can be implemented on Physical hardware, Virtual hardware, or under a product called FME Cloud.
The FME Server interface has tools for running a workspace, examining job history, managing licensing and engines,
managing resources and data files, carrying out automatic cleanups, and scheduling jobs.
FME Server security is implemented using a system of roles and users.

FME Skills
The ability to open the FME Server Web User Interface
The ability to confirm the version of FME Server and check that FME core engines are available
The ability to browse repositories
The ability to check job status
The ability to schedule a job to run at a particular time
The ability to check and manage security settings

Further Reading
For further reading why not check out this blog article on deploying FME Server using Docker containers or take a look at this
blog article on the architecture of FME Cloud, which is both fascinating and instructive!
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Hi, I'm Miss Vector, FME schoolteacher. I'll be here now and then to test you on your new FME Server
knowledge. For now, answer me this: Which of these is not one of the three core capabilities of FME
Server?
1. Automation
2. Real-Time
3. NoSQL Database
4. Self-Serve
FME Server is many things - but it is not a NoSQL database!

Miss Vector says...
I have an FME Server with two engines. Four users submit jobs at the same time. What happens?
1. Two jobs are processed. Two jobs are returned to their authors.
2. Two extra engines will fire up automatically to process all four jobs.
3. The four jobs will be processed simultaneously, sharing the two engines.
4. Two jobs are processed. The other two sit in a queue until an engine becomes free.
Yes, the server core keeps a queue of jobs and submits them as engines become available. Extra engines
will not fire up, even if you do have spare licenses, and jobs will never be ignored just because no engine
is currently available.

Miss Vector says...
If I wanted to find out about workspaces stored in a repository - for example I'm building a tool to
catalogue my workspaces - what is the best way to do it?
1. Use the FME Server REST API
2. Scrape the contents of the Server repository page
3. Get a file listing from the repository folder
4. Connect to the FME Server database to query it directly
The REST API is a quick, simple, and official method to query the workspace repositories. Querying the
database directly is permissible, however, under no circumstances should you write into or update directly
the contents of the database.

Miss Vector says...
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Which of these are good reasons for running engines on multiple operating systems at the same time? Pick
all that apply.
1. A required format is only available on 32-bit or 64-bit, not both.
2. A required format is only available on Windows, or Linux, not both.
3. FME Desktop users author workspaces using a mix of Windows, Linux, and Mac platforms
4. You want to process heavy-scale jobs on a more powerful platform.
Basically some formats are only available on certain platforms and so you may need to mix of operating
systems to cover all your requirements. You may also want to redirect large-scale jobs to a more powerful
platform. However, it doesn't matter what platform the workspace author used; their jobs will run on
whatever system FME Server is based on.

Miss Vector says...
I copy a workspace into a resources folder using the upload tool. What then?
1. I can run it by browsing the resources, selecting the workspace, and clicking run
2. I can run it through the Manage > Workspaces menu tools
3. I can run it by calling it with the FMEServerJobSubmitter transformer in FME Desktop
4. I can't run it because it's not properly published to a repository
Basically, if you don't publish the workspace properly, you aren't able to have Server run it.

Miss Vector says...
Uploading an entire folder of files come with what restriction?
1. Folder upload only works on certain web browsers
2. Folder upload requires the folders to be zipped into a single file
3. Folder upload only works on Windows C: drive (not D:, E:, etc)
4. Folder upload requires FME Desktop to be installed on the computer being uploaded from
Folder upload works in Chrome, but not in Firefox, Internet Explorer, or any other web browser.

Miss Vector says...
What exactly are the entries in the resources cleanup dialog?
1. They are simply shortcuts to workspaces in the utilities category that I can run on demand
2. They are simply shortcuts to scheduling tasks that run at the described interval
3. They are specific tasks that FME Server runs once a day to help in system maintenance
4. They are specific tasks triggered when the system is low on resources
These are their own set of tasks, separate to anything defined as a schedule or utility workspace. They are
run once a day and remove any specified file older than the set time. However, #4 is partially correct.
When the system's free disk space reaches specified minimum levels, FME Server will trigger a critical
level cleanup event, in which all enabled cleanup tasks execute; the difference being it will disregard the
Remove Files Older Than setting.
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Miss Vector says...
If I want one user to have a higher level of access to other users in the same role (say I wish to let an FME
author be able to manage engines) what must I do?
1. Simply select that user from the user list and set the manage engine policy to yes
2. Promote that role to superuser status so that the user has a higher level of security
3. Create a new role with manage engines = yes and move that user to it
4. Create a new role with manage engines = yes and add that user to it as well as the original role
Security policy is set per role, not per user. You could create a new role (AuthorsWithEngines?) and move
that user to it, but - and this is the point - a user can have multiple roles. Our author can remain in the
author role, but also be assigned to a new role that allows engine management.

73

Running Workspaces with FME Server

Running Workspaces on FME Server
This section goes into a little more depth about running a workspace on FME Server
As we saw in chapter 1, running a workspace using the Web Interface can be very similar to running it in FME Workbench; you
simply locate the workspace and click a Run button.
In fact, as we'll now discover, it's most similar to running in FME Workbench with the prompt option turned on. That's because a
section of the FME Server dialog lets the user define what parameters are going to be set for the translation.
For example, here the user can specify where the source data is available, what feature types should be read, and what label
content/height is going to be created (presumably the workspace includes a LabelPointReplacer transformer):

Once the parameters are set the Run Workspace button completes the process.
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Source Data Management
Nearly every FME workspace starts by reading features from a source dataset.
In some cases that source dataset may be web-based, such as a real-time GeoJSON feed of earthquakes. On other occasions the
data may not be web-based, but is stored in folders that are shared for others to access.
These scenarios make the task of authoring workspaces for much easier. Generally what works on FME Desktop can be published
and run on FME Server without concern for the management of the source data.
However, most authors find it necessary to manage access to the source datasets, and there are various methods in FME Server
that lets them do that:
Database Connections
Publishing Datasets
Temporary Uploads
Resources Folders
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Database Connections
When the source data for a dataset is a database, instead of the workspace embedding connection parameters, a new technology
can be used.

NEW
Database connections were implemented in FME Desktop in FME2015, but Server support is entirely new
for 2016

What is a Database Connection?
Database connections are containers for a set of database connection parameters. These parameters include database server, port
number, username, password, and others that vary according to the database type.
The two main advantages of database connections are:
Connection parameters are no longer embedded in a workspace, meaning less of a security risk
For example, your parameters would not be exposed to anyone who downloaded the workspace
Connection parameters can be reused among multiple workspaces
For example, two workspaces that use the same database can use the same connection
Database connections can be published with a workspace from FME Desktop, or they can be added directly within FME Server.

Creating a Database Connection
Creating a database connection often starts in FME Desktop. This workspace has a connection for a PostGIS database:

When the workspace is published to FME Server a new dialog asks the author whether to also publish the database connection:
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When run on Server the database connection is now available as a parameter:

The workspace then runs to completion as normal.

Managing Database Connections
FME Server also has a section for managing database connections under Manage > Database Connections on the menubar. This
page allows administrators to create new connections, copy existing connections, delete existing connections, or edit existing
connections:
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Using Database Connections
When a workspace is run, if it has a database Reader (for example) the end-user is prompted and can select the database
connection to use (either one uploaded with the workspace or one defined separately in FME Server):

Sister Intuitive says...
Welcome. I'm here as your guide for this chapter of the FME Server training.
With database connections a workspace can be tested in FME Desktop using the author's connection
parameters, but then switched to a general account once published to Server; all in a way that is both
easy and secure.

Miss Vector says...
If I create a database connection that has superuser permissions then it would bypass any permission
checks the database would make for creating and dropping tables. So how do you think I might prevent a
user misusing that capability?
1. Remove that user's permission to run that workspace on FME Server
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2. Remove that user's permissions to access the entire repository that workspace resides in
3. Remove permission to access that particular database connection for that user's role
4. Remove from their role permission to manage database connections
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Web Connections
When the source data for a dataset is a web service, instead of the workspace embedding connection parameters, a new technology
can be used.

NEW
Web connections were implemented in FME Desktop in FME2015, but Server support is entirely new for
2016.1

What is a Web Connection?
Web connections are containers for a set of web service connection parameters. These parameters include the service, username,
password (or authenticated connection), and others that vary according to the service type.
The two main advantages of web connections are:
Connection parameters are no longer embedded in a workspace, meaning less of a security risk
For example, your parameters would not be exposed to anyone who downloaded the workspace
Connection parameters can be reused among multiple workspaces
For example, two workspaces that use the same web service can use the same connection
Web connections can be published with a workspace from FME Desktop, but not added directly within FME Server.

Creating a Web Connection
Creating a web connection starts in FME Desktop using Tools > FME Options > Web Connections in Workbench.

When the workspace is published to FME Server a new dialog asks the author whether to also publish the web connection:
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Notice how it must be re-authenticated for use on FME Server. By publishing and authenticating the web connection, the
workspace that uses it can run to completion on Server as it would on Desktop.

Managing Web Connections
FME Server also has a section for managing web connections under Manage > Web Connections on the menubar. Currently this
page allows administrators only to delete existing connections. The ability to create and edit connections is planned for FME2017

Using Web Connections
When a workspace is run, if it has a transformer or reader that references a web service (of the correct type) then the end-user is
prompted and can select the web connection to use

Sister Intuitive says...
As with database connections, this functionality allows a workspace to be tested in FME Desktop using
the author's connection parameters, but then switched to a general account once published to Server; all
in a way that is both easy and secure.
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Publishing Source Data
When the source data for a translation is stored as files (rather than a feed or database) it can be published to FME Server along
with the workspace.

Publishing Source Data
In this workspace the source dataset is MapInfo TAB:

A MapInfo TAB dataset is made up of a series of files (.tab, .dat, .id, .map). When this workspace is published the wizard allows
us to published the data files alongside it by simply checking the box labelled Upload data files.

FME automatically selects the files to upload based on what it thinks is necessary to run the translation. If there are other files you
wish to upload, or files FME selected that you don't wish to upload, the Select Files button allows you to make changes:
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This dialog also allows you to change where the files are published to, but for now we'll ignore that setting and go with the default
of publishing to the repository.
Once the publishing wizard is complete, those files are uploaded to FME Server and tagged for use with this workspace.

Using Published Source Data
When a workspace published with its data is run on FME Server, the uploaded data automatically is used as the source:

There are no other settings that need to be changed and the workspace will run to completion using the published data as its
source.

Miss Vector says...
Although simple, there is a major limitation to publishing data with a workspace. What do you think it is?
1. The data is only temporary and will be deleted once the workspace is run
2. The data is hidden within FME Server's system files and is inaccessible to any other use
3. The data becomes available to anyone regardless of role and security settings
4. The workspace cannot be run using any other data than that published with it
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Temporary Data Uploads
Publishing data to FME Server along with the workspace is fine, but it isn't a method that an end-user could use to have a dataset
translated.
Therefore, functionality exists to allow the end-user to upload data at run-time.

Uploading Source Data
This workspace was created with a dynamic Reader and Writer. That means it is possible to process any source dataset (of the
right format) and have it translated:

Of course, publishing the data with the workspace does not make much sense. It is better if the user uploads data at run time. They
can do this very easily in the FME Server interface in the Run Workspace page by clicking the browse button:

This opens a dialog with a button (highlighted) to use for uploading files (here a Parks dataset):

The next step is to click the file (here Parks.tab) to select it:
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Finally, click the [+] button to add it to the translation:

Any existing files in the selection window can be removed by clicking their X button (as must have been done here for
Zones/.tab).
Now when the workspace runs, the user-uploaded data gets translated.
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Cautions and Limitations
There are a number of cautions and limitations to be concerned about here.
Firstly - and perhaps most obviously to experienced workspace authors - the data chosen by the end user has to match the
workspace's schema definition, otherwise the translation will fail.
Secondly, data uploaded like this is not accessible by any other means and cannot be used by another workspace.
Finally, a look at the System Cleanup dialog shows us that files uploaded like this are only temporary; the default is to clean out
these datasets when they become more than 24 hours old.
So, although this is one way to get data onto the Server, it is perhaps not the best way.

NEW
In FME2016 this technique was altered slightly to store uploaded data to an accessible file in the
Resources setup:

So, technically, you could use that data as the source for another translation. However, in practice it's not
a long-term solution because of how the system cleanup tools will empty this folder within a day.

Miss Vector says...
The system cleanup tools will erase any data uploaded like this when it is more than a day old. But which
cleanup task is it that will do so?
1. Delete_DataUpload_Files
2. Delete_EngineResults_Files
3. Delete_Service_Post_Content_Files
4. Delete_UserData_Files
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Exercise 1
Data

Cycle Paths (Esri Shapefile)
Drinking Fountains (CSV (Comma Separated Value))

Overall Goal

Create an FME Server-hosted workspace to identify drinking fountains with 20 metres of a
cycle path

Demonstrates

Publishing source data and making temporary data uploads

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Running-Ex1-Complete.fmw

You're a technical analyst in the GIS department of your local city. You have plenty of experience using FME Desktop, and your
department has just purchased FME Server.
Today's task for you is to use two datasets - cycle paths and drinking fountains - to figure out which drinking fountains are close
(within 20 metres) of a cycle route. The output is to be written as a KML dataset.
You can easily do this using FME Desktop, and decide to publish it to FME Server too so that users can upload their own set of
cycle paths.

Sister Intuitive says...
If you have lots of experience with FME Workbench - and if your instructor agrees - simply open the
workspace listed in the header above and skip to step 7

1) Inspect Source Data
The first task in any new project is to inspect the source data, so let's do that. Use the FME Data Inspector to open these two
datasets:
Reader Format

Esri Shapefile

Reader Dataset

C:\FMEData2016\Data\Transportation\Cycling\BikePaths_L.shp

Reader Format

CSV (Comma Separated Value)

Reader Dataset

C:\FMEData2016\Data\Engineering\DrinkingFountains.csv

You can view the CSV data as a table only, or you can set the Schema Attributes (in the parameters dialog) to ensure the X/Y
coordinate fields are interpreted as coordinate values. The data will look like this:
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2) Create Workspace
Having seen what the data looks like, let's create a workspace to process it. Start FME Workbench and select the Generate
Workspace tool. When prompted create the workspace with these parameters:
Reader Format

CSV (Comma Separated Value)

Reader Dataset

C:\FMEData2016\Data\Engineering\DrinkingFountains.csv
Coordinate System: utm83-10
Schema Attributes: x_coord, type = x_coordinate
Schema Attributes: y_coord, type = y_coordinate

Reader Parameters

Writer Format

Google KML

Writer Dataset

C:\FMEData2016\Output\DrinkingFountains.kml

3) Add Cycle Path Reader
The workspace, at this point, looks like this:
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You'll notice that the reason we created the workspace with the CSV data is because it contains the attributes we want on the
output. But now we should also add the cycle path data.
Select Readers > Add Reader from the menubar. When prompted select the source data as follows:
Reader Format

Esri Shapefile

Reader Dataset

C:\FMEData2016\Data\Transportation\Cycling\BikePaths_L.shp

Workflow Option

Single Merged Feature Type

Click OK to add the Reader to the workspace. The reason we selected the Merged Feature Type option is because there are other
cycle path datasets in that folder that we may wish to read in the future, and this option will allow each data file to pass into the
workspace.

4) Add Transformers
There are various ways we could find the closest water fountains to the cycle paths, but the simplest is perhaps to buffer the cycle
paths, overlay the two datasets, and then check for overlaps.
To do this requires three transformers: a GeographicBufferer, a PointOnAreaOverlayer, and a Tester. Place one instance of each
transformer and connect them up in this configuration:

CSV Reader > PointOnAreaOverlayer:Point
Cycle Reader > GeographicBufferer:Input
GeographicBuffer:Output > PointOnAreaOverlayer:Area
PointOnAreaOverlayer:Point > Tester
Tester:Passed > KML Writer

5) Set Transformer Parameters
Now the transformers are placed, let's set the parameters.
GeographicBufferer: Units=Metres, Distance=20
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PointOnAreaOverlayer: None
Tester: Test Clause: _overlaps >= 1

These parameters will ensure we create a 20m buffer around each cycle path, count the number of times a drinking fountain
overlaps the buffer, and filter through only drinking fountains with a count of 1 or greater.

6) Set Writer Schema
The only last thing to do is clean up the writer schema. We don't need to write out the x_coord or y_coord attributes in the output,
and we don't need to see the kml attributes that have been exposed. Plus the feature type name for the output should be something
other than "CSV".
So open the feature type properties for the KML Writer feature type.
In the general tab change the name from CSV to CyclePathFountains. In the user attributes tab remove the x_coord and y_coord
attribute and any other kml attributes that have been added.
The result will look like this:

Save the workspace and run it to make sure the output looks correct.

Sister Intuitive says...
If the workspace fails with the error KML: Feature does not have a coordinate system specified then you
did not set the coordinate system when you generated the workspace. Find the Reader coordinate system
parameter in the Navigator window, set it to utm83-10, and try again!

7) Publish to Server
Now we should publish the workspace to Server. We'll experiment by publishing one dataset with the workspace and uploading
one through the web interface when we run the workspace.
So, start the FME Server publishing wizard (File > Publish to Server).
Specify the connection parameters as usual. Choose Training as the repository to upload to, but then check the Upload Data Files
box and click the Select Files button:
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In the Select Files dialog, deselect the five files belonging to the Shape dataset, and leave only the CSV file selected:

You will receive a warning about the lack of Shape data, but that can be ignored. Finish the publishing process by registering the
workspace with the Job Submitter and Data Download services.

8) Run On Server
Now open the FME Server web interface and select the workspace we just published (if you visit the home page it will be in the
Last Published Workspaces section).
Firstly make sure the Service parameter is set to Data Download.
Next check the Published Parameters section. The source CSV is set to be read from the dataset published with the workspace. For
the Shape dataset click the browse button:

In the dialog that opens, make sure it is on the Temporary Uploads tab, then click the Upload button:
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Browse to and select the five files in the Shape dataset and click OK to upload them:

Sister Intuitive says...
If you set Single Merged Feature Type when you added the Shape Reader to the workspace, you should be
able to select any of the Shapefile datasets here - or even all of them!

Click the "garbage can" icon to remove the currently chosen dataset:

Now click the .shp file you uploaded (you only need to select the .shp file now, not all five files), then click the add button to add
it as the newly chosen dataset:
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Click OK to close the dialog. Click the Run Workspace button to run the workspace.
The workspace runs using a mixture of published data and a temporary upload of Shape data.

9) Check Logs
If you had correctly selected the Data Download service, running the workspace would have returned a link through which to
download a dataset of the output. For now, don't click that.
Click the Home button instead, and then click the translation just carried out in the Last Run Workspaces section:

This will open the job summary page for the workspace. Notice that you can view the FME log file, but also download the result
of the translation, as the URL to access it is also recorded here.

NEW
The listing of the data download URL in this window is new for FME2016. Previously you had no way of
finding this link to the output data once you left the Run Workspace page!
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CONGRATULATIONS
By completing this exercise you have learned how to:
Create a workspace using two Readers and find features within X radius of another
Publish a workspace to FME Server and include source data
Select a source dataset to upload temporarily at run-time
Locate a data download result through a workspace summary page
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Resources System
The final method of managing source data in FME Server is to use the system of tools called Resources.

What are Resources?
"Resources" is an inbuilt file management system that allows data (and other files) to be published to an FME Server instance and
used within all Server operations. It is accessed using Manage > Resources from the web interface menu.
The Resources web page looks like this:

Although there are a number of different folders data can be stored in, the Data folder is the most logical location:

In this window are options to upload either a selection of files or an entire folder. Additionally, new folders can be created, and
existing data moved, copied, or deleted.

Using Uploaded Data
Using uploaded data in a translation is very simple. Here, for example, a user has created a new subfolder in the resources file
system (Home > Data > StreetLighting), and has uploaded some MapInfo data to it:
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Now when the workspace is run, the end-user clicks the browse button and is able to select data from the Resources folders, like
so:

In fact, it's even possible to set the output data folder to be a Resources folder too:

Other Upload Methods
Besides the web interface, there are other ways of getting data into the Resources filesystem.
Firstly, the FME Server publishing wizard in FME Workbench allows this. Where the default method is to select the files and
upload them to the same repository as the workspace, it is permitted to change the location to the resources filesystem:
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Alternatively, FME Server resources actually exists on the operating system's filesystem, meaning the data can be copied there
directly. The default location (on a Windows operating system) is C:\ProgramData\Safe Software\FME Server\resources:

Finally, the Resources system also allows connections to Amazon S3:
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This allows data stored in S3 buckets to be used as the source for a translation on FME Server.

Sister Intuitive says...
The Resources filesystem was (prior to FME2016) located within the FME Server installation folder on
the operating system, but was moved in 2016 as the installation folder is (or should be) a restricted space
off-limits to most users. To find it, try looking in %programdata%

Benefits for Data Management
The advantage of these Resources, compared to other methods, is that data can be uploaded and referenced by any workspace,
without having to upload it every time. This is particularly useful when access to the file system is restricted (like on an FME
Cloud system).
If the workspace author does have access to the file system, then Resources are still useful, as a Resources folder can be mapped
and shared among many users as a physical drive.
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Authoring for the Resources System
Using the FME Server web interface it's simple to select data from the resources folder at run-time. However, in some cases the
author will want to read data from a resources folder without the end-user having to select it.
To do this requires the use of an FME parameter to define the data as coming from the resources folders.

FME Parameters for Server
In FME Workbench the Navigator window has a section called user parameters. You might have noticed that one part of this is a
list of FME Server-specific parameters:

The uses of these are many and varied; for example FME_SECURITY_USER returns the name of the user running the
workspace, and could be used to either write to a custom log or perhaps filter data in different ways in the workspace based on the
specific user. FME_TOPIC would return the name of the notification topic (if any) that invoked the workspace.
However, when authoring for resources data, the most useful parameter is FME_SHAREDRESOURCE_DATA

WARNING
A common factor to all these parameters is that they only have an effect when the workspace is run on
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FME Server. If the workspace is run on FME Desktop, it won't return a value. Therefore to test a
workspace containing such a parameter requires you to provide a dummy value.

FME_SHAREDRESOURCE_DATA
What the FME_SHAREDRESOURCE_DATA parameter does is return the path of the shared resource data. When authoring a
workspace to read data directly from the resource folder, you can therefore enter this into the source dataset field as the path to the
data:

Leaving the Navigator window looking like this:

When the workspace is run the parameter is replaced by the actual path and the data is read as expected.

Accessing Resource Paths Directly
Once a dataset has been uploaded to FME Server as a resource, the path for that shared resource can also be obtained by
examining its properties in the FME Server Resources pages:
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This path can then be copied and pasted into a workspace in order to reference that dataset directly without manually entering it.
Of course, this does require that the data has already been uploaded to FME Server, and isn't going to be uploaded with the
workspace when it is published!

Miss Vector says...
So I can make my workspace read specific data from the resources folders - but how do I stop the end-user
from being able to change that?
1. Remove their security permissions for the Job Submitter service
2. Remove their security permissions for the Resources folders
3. Make the source dataset parameter optional for that Reader
4. Delete the published parameter for that source dataset from the workspace
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Exercise 2
Data

Cycle Paths (Esri Shapefile)
Drinking Fountains (CSV (Comma Separated Value))

Overall Goal

Create an FME Server-hosted workspace to identify drinking fountains with 20 metres of a
cycle path

Demonstrates

Uploading data to a resources folder and authoring a workspace to make use of it

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Running-Ex2-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Running-Ex2-Complete.fmw

You're a technical analyst in the GIS department of your local city. You have plenty of experience using FME Desktop, and your
department has just purchased FME Server.
Today's task for you is to use two datasets - cycle paths and drinking fountains - to figure out which drinking fountains are close
(within 20 metres) of a cycle route. The output is to be written as a KML dataset.
So far you have created the workspace and published it to FME Server along with a set of data. However, it would be better
practice to upload the source data to the FME Server Resources file system. That way the data could be used not only for this
project, but any other that wished to use it.
We could also ensure that the output data is written to the resources folders too.

1) Open FME Server Web Interface
Open and log in to the FME Server web interface. Choose Manage > Resources on the menubar to navigate to the resources
management pages.

2) Create Folder
Most data should go under the Data folder, so double-click on Data in the dialog to open that folder. To avoid mixing datasets our
data should go into its own subfolder. So click on the New Folder button and create a folder called Cycling:

Next double-click on Cycling and within that folder create another new one called Output.

3) Upload Cycle Path Data
Now, within the cycling folder, click the upload button and upload the five files for the cycling dataset:
Reader Dataset

C:\FMEData2016\Data\Transportation\Cycling\BikePaths_L.shp
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Also upload into that folder, the source data for the drinking fountains:
Reader Dataset

C:\FMEData2016\Data\Engineering\DrinkingFountains.csv

So we now have both source datasets and a folder to write the output data to.

4) Run Workspace
Now locate and run the workspace published in exercise 1 (or else open the workspace listed above and publish it to FME Server).
In the published parameters for the workspace be sure to click the browse button, navigate to the resources folder Cycling, and
select the appropriate files:

Click Run Workspace to finish running the workspace.

Sister Intuitive says...
You should also set the output location to the Cycling/Output folder - though of course there won't be an
output folder location if you run this using the Data Download service!

5) Open Workspace for Editing
Although the workspace ran correctly, and used the data in the resources folder, that's only because we selected that data at run
time. It is not a permanent feature of the workspace.
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For example, if I downloaded the workspace into FME Workbench, it would point to the original (local) data files, not the
resources folder.
It would be much better if the workspace was programmed to look into the resources folders automatically.
So, start FME Workbench and open the workspace from exercise 1 (or the begin workspace listed above).

6) Delete Published Parameters
If we do set the workspace to read from the resources folders, we don't want to give users the chance to change that. So in the
Navigator window locate the three parameters for source and destination datasets and delete them:

7) Set Source/Destination Parameters
Now, in turn, double-click the source and destination dataset parameters and change them to:
CSV Reader

$(FME_SHAREDRESOURCE_DATA)\Cycling\DrinkingFountains.csv

Shape Reader

$(FME_SHAREDRESOURCE_DATA)\Cycling\BikePaths_L.shp

KML Writer

$(FME_SHAREDRESOURCE_DATA)\Cycling\Output\DrinkingFountains.kml

Sister Intuitive says...
Remember, you can also obtain these file paths by locating the files in the FME Server web interface,
right-clicking, and choosing Properties.

The result will look like this:
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Save the workspace and publish it back to FME Server.

Sister Intuitive says...
This time you won't be able to test-run the workspace in FME Workbench, because it won't recognize the
shared resource parameter. Only FME Server will return a value for that parameter.

8) Re-Run Workspace
Now run the workspace on FME Server. Be sure to use the Job Submitter service (not Data Download) so the output is written to
the required file. This time you will not be prompted with a parameter to select the source (or destination) datasets, but they will
be used in the resources folders just the same.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create resources folders and upload data to them
Run a workspace and select data from resources folders
Edit a workspace to permanently use the resources folders
Delete parameters to prevent the end-user changing them
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Running the Job Submitter using a URL
All job requests to an FME Server are a variation on an HTTP request. This makes running a workspace via a URL very simple,
provided you know what form the request will take.
The easiest way to find that URL is in the workspace dialog in the FME Server web interface. Notice that there is a little
spanner/wrench icon:

Click this and developer information, including a URL to run the workspace, are displayed:

The URL shown uses a HTTP GET request whereas the HTML form uses a HTTP POST request.
This information is a useful tool for building your own web applications that access FME Server services, because you can copy
the HTTP request and embed it on your own website or application.
You could also embed the URL or form into an email, or paste the URL directly into a web browser.

TIP
There are limits to the amount of data you can send in a GET request because URLs have length
restrictions that vary depending on the browser being used. If you anticipate that your request parameters
may include very long strings, use a POST request.
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Authoring Job Chains
Workflow Management is a technique for controlling workspaces in sequence or branching with in-built logic. Part of this
technique is being able to author workspaces that are "chained together" to run one after another.

What are Job Chains?
A chain of jobs is one that is run in sequence one after the other. There are various ways to implement this.

The FeatureWriter Transformer
The easiest way to chain workspaces... is not to! A chain is often necessary because one workspace writes data that the next must
then process. However, the FeatureWriter transformer allows data to be written and then further transformation to take place
within the same workspace!

In the above workspace, data is validated and validation errors written out to a series of datasets according to the error type. These
datasets are uploaded to Amazon S3 and a tweet sent to alert someone to the problems.
Without the FeatureWriter, such a project might have taken two or maybe three workspaces chained together. Here it only requires
one.

NEW
The FeatureWriter transformer is new for FME2016, and advances the capabilities of FME Server by a
huge amount. Further information is available in this blog post and in the FME2016 Deep Dive webinars
on the Safe web site.

A Simple Chain
It's fairly simple to get one workspace to run another; all that is needed is a transformer or shutdown script to send the command.
Given that each workspace in FME Server can be run using a URL, and that there is a REST API to do similarly, it's quite simple
to run a HTTP command using a HTTPCaller transformer or a shutdown script.
Alternatively, an FMEServerJobSubmitter transformer can be used. This transformer triggers a workspace to run on FME Server.
It has various parameters that allow the author to define which workspace on which FME Server is to be run.
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By adding this transformer to multiple workspaces a chain of almost any length can be created.

In this workspace the data is sent to a FeatureWriter transformer, and the results of that sent as a single summary feature that
triggers the FMEServerJobSubmitter.
However, don't think a FeatureWriter is a necessity for a chain of data. It's equally valid for a step in the chain to not write data,
but just carry out an action and trigger the next step.

Sister Intuitive says…
The first workspace in a chain may start with a Reader that reads a source dataset, where each source
feature triggers the FMEServerJobSubmitter. For example, the source data may be a list of files that are to
be translated.
But more often the next job needs to be triggered just once. This requires only a single feature and to
produce this a Creator transformer can be used instead of a Reader, or a Sampler transformer used to
restrict the flow of features to a single one.

A Parent-Child Approach
Instead of a chain of workspaces where one calls the next, a different approach is to have a control (parent) workspace that runs a
series of (child) workspaces in turn.
Like in a simple chain, a master workspace runs other workspaces by using a transformer such as the FMEServerJobSubmitter.
Here a control workspace is using the FMEServerJobSubmitter to run three further FME workspaces. Maybe each workspace is a
separate step in a database update process:

If a particular task fails then the output is routed to a text file Writer – meaning this could be used in a notification system to send
an email to an administrator alerting them to the failure. Successfully executing all three results in a tweet being sent.
Instead of "Parent-Child", this setup is sometimes also known as the "Master-Slave" approach.

Conditional Processing
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In some scenarios there might be several workspaces, only one of which should be run. To do so the logic for deciding which
workspace is executed can be made using a Tester, or other filter transformer.
For example, here an organization runs a daily process to upload field updates into a database. Once a week it does the same, but
also exports all files to Dropbox (for example):

The test is carried out by a Tester, and the daily/weekly processes are each defined in a separate workspace.

FMEServerJobSubmitter and Portability
The FMEServerJobSubmitter transformer has connection parameters in which to define the Server instance and port number on
which the job is to be submitted:

Here, for example, the workspace is to be run on a server called "MyFMEServer" which is connected to via port 8080.
However, many FME Server installations include not one, but two servers. One for development and testing and the other the live
system. If you develop a solution using an FMEServerJobSubmitter that connects to MyFMEServerDev (for example) then you
would need to go back to each workspace and manually change the server name within each transformer.
So, best practice for this scenario is to not hard-code these values, but to add them as FME Server parameters. There are two
specific parameters that can be used: FME_SERVER_HOST and FME_SERVER_PORT.
FME_SERVER_HOST can be used individually by selecting it from the drop-down menu on the right-hand-side of the FME
Server URL parameter.
FME_SERVER_PORT can be incorporated by using the text editor (select Open Text Editor from the drop-down menu) and
concatenating it with FME_SERVER_HOST
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Now this chain of workspaces will work on whatever Server installation it is deployed.
Of course, if the initial (Parent/Master) workspace uses this technique it MUST also be run on the same Server installation. You
couldn't run it on FME Desktop (for example) because FME Desktop won't have values for those two System Parameters.

WARNING
Interestingly, for either method, the initial/control workspace can be run on either FME Desktop (e.g.
Workbench) or FME Server. The FMEServerJobSubmitter works on both platforms.
However, there's a difference. On FME Desktop the control workspace runs immediately, but each child
job executed by an FMEServerJobSubmitter transformer is submitted to the FME Server queue and may
have to wait for an engine. On FME Server - if you have Wait for Job to Complete = Yes - it's the reverse:
the control workspace is submitted to the queue, but each child job executed by an
FMEServerJobSubmitter bypasses the queue and runs immediately.
This means that on Desktop the child processes are affected by the FMEServerJobSubmitter Job Priority
and Job Tag parameters. But on Server (when Wait for Job = Yes) those parameters are ignored because
the child processes are run immediately and not queued. In short, those FMEServerJobSubmitter
parameters only apply when the call comes from FME Desktop, because only then are the jobs queued.
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Exercise 3
Data

Voting Divisions (GML (Geography Markup Language))
Addresses (Esri Geodatabase (File Geodb API))

Overall Goal

Create workspaces to:
- process voting divisions
- to assign voting divisions to addresses
- to chain the previous two translations together

Demonstrates

Authoring workspace chains

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Running-Ex3-CompleteA.fmw
C:\FMEData2016\Workspaces\ServerAuthoring\Running-Ex3-CompleteB.fmw
C:\FMEData2016\Workspaces\ServerAuthoring\Running-Ex3-CompleteMaster.fmw

You're a technical analyst in the GIS department of your local city. You have plenty of experience using FME Desktop, and your
department has just purchased FME Server.
A municipal election is about to happen and Elections Interopolis have provided a dataset of new voting divisions in GML format.
Your first task today is to create a workspace to translate these voting divisions to a SpatiaLite database format for use within the
city, and write the data to a resources folder on FME Server so that everyone can use it.
Coincidentally, the planning department heard of this update and has asked you to assign voting division IDs to each of the
records in the city's address database, for use in election planning.
You realize that you can chain these two translations together to execute consecutively under a master workspace. So in all you
have three workspaces to create!

1) Start FME Workbench
Start FME Workbench and generate a translation with these parameters:
Reader Format

GML (Geography Markup Language)

Reader Dataset

C:\FMEData2016\Data\Elections\ElectionVoting.gml

Writer Format

SpatiaLite

Writer Dataset
The Writer dataset can be left empty for now. When prompted, leave both source feature types (layers) selected.

2) Create Resources
We'll handle the input and output of this workspace using the resources folders on FME Server. So, log in to the FME Server web
interface and navigate to Manage > Resources > Data
In here create a new folder called Voting. Double-click on the folder to enter it. Upload the source GML dataset to that folder (you
should upload both the .gml and .xsd files):
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3) Edit Workspace to use Resources
Back in FME Workbench delete the two existing published parameters. They should be called SourceDataset_GML and
DestDataset_SPATIALITE
Next set the source and destination datasets as follows:
GML Reader

$(FME_SHAREDRESOURCE_DATA)\Voting\ElectionVoting.gml

SpatiaLite Writer

$(FME_SHAREDRESOURCE_DATA)\Voting\VotingDivisions.sl3

One final tweak: change the Writer parameter Overwrite Existing Database to Yes

4) Save, Publish, and Run Workspace
Save the workspace (remember the filename, it will be important later) and publish it to FME Server. It should be registered with
the Job Submitter service.
Locate the workspace in the Server web interface and run it to make sure it runs to completion. The evidence will be the log and
an sl3 file in the resources folder.
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Select the sl3 dataset and click the button to download the file. This is important; we'll need the file to set up our next workspace.
Save the file to the Elections folder, so you will remember where it is; i.e. C:\FMEData2016\Data\Elections\VotingDivisions.sl3

5) Generate Workspace
That was the first workspace in our project. Now for the second.
Open Workbench and generate a new workspace with these parameters:
Reader Format

Esri Geodatabase (File Geodb API)

Reader Dataset

C:\FMEData2016\Data\Addresses\Addresses.gdb

Writer Format

Esri Geodatabase (File Geodb API)

Writer Dataset

C:\FMEData2016\Output\NewAddresses.gdb

When prompted, leave both source feature types (tables) selected.

6) Add Reader
To assign voting divisions we need to have that data in our workspace. So, select Readers > Reader from the menubar and add a
Reader with the following parameters:
Reader Format

SpatiaLite

Reader Dataset

C:\FMEData2016\Data\Elections\VotingDivisions.sl3

When prompted, select only the source feature type (table) votingdivisions. If you can't find that sl3 file, go back to step 4 and
make sure you downloaded the result of the first workspace.
The workspace will now look like this:

7) Add Transformer
Now let's add a transformer to assign voting divisions. Place a PointOnAreaOverlayer transformer into the workspace. Connect it
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as follows:

Geodatabase:PostalAddress > PointOnAreaOverlayer:Point
SpatiaLite:votingdivisions > PointOnAreaOverlayer:Area
PointOnAreaOverlayer:Point > Geodatabase:PostalAddress

8) Edit Writer Schema
That transformer will copy the division attribute on to each address, but that attribute won't be written unless we also add it to the
output schema.
So, click the parameters button on the Writer feature type PostalAddress. In the User Attributes tab add a new attribute called
division (of type int):

division is case-sensitive, since we want it to match what is coming in from the votingdivisions table.

9) Test Run Workspace
Before we start adjusting the dataset paths for use on FME Server, run the workspace to ensure it produces the correct output; i.e.
that each address now has a division attribute.

10) Create Resources
We'll also handle the input and output of this workspace using the resources folders on FME Server.
Firstly, we can upload a File Geodatabase as a folder/file only if we're using the Chrome web browser. Just in case you aren't,
locate the File Geodatabase in your file system and compress it into a single zip file:
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Next, log in to the FME Server web interface and navigate to Manage > Resources > Data > Voting
Upload the zipped address file to that folder:

11) Edit Workspace to use Resources
Back in FME Workbench delete the three existing published parameters. They should be called SourceDataset_FILEGDB,
SourceDataset_SPATIALITE, and DestDataset_SPATIALITE
Next set the source and destination datasets as follows:
Geodatabase Reader

$(FME_SHAREDRESOURCE_DATA)\Voting\Addresses.gdb.zip

SpatiaLite Reader

$(FME_SHAREDRESOURCE_DATA)\Voting\VotingDivisions.sl3

Geodatabase Writer

$(FME_SHAREDRESOURCE_DATA)\Voting\NewAddresses.gdb.zip

One final tweak: change the Writer parameter Overwrite Geodatabase to Yes
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12) Save, Publish, and Run Workspace
Save the workspace (remember the filename, it will be important later) and publish it to FME Server. It should be registered with
the Job Submitter service.
Locate the workspace in the Server web interface and run it to make sure it runs to completion. The evidence will be the log and a
zipped geodatabase file in the resources folder.

You may wish to download the newly created dataset to inspect it and make sure the output is correct.

13) Create Workspace
That was the second workspace in our project. Now for the third and final workspace. This workspace will be used to chain the
previous two workspaces. It is going to be the master, with the two prior workspaces as children.
So, open Workbench and start with an empty canvas. Place a Creator transformer followed by two FMEServerJobSubmitter
transformers:
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14) Set Parameters
Open the parameters dialog for the first of the FMEServerJobSubmitter transformers. Notice that it is a wizard-style, very similar
to the publish workspace wizard.
In the first dialog enter your FME Server connection parameters. In the second select the first workspace (the one that converted
election divisions from GML to SpatiaLite):

The third dialog is where we set the parameters for the translation. There are no published parameters, so we don't need to worry
about those. However, set Wait for Server Job to Complete to Yes. If we didn't do this then the second job submitter transformer
would run before the first had finished!
We can also change the output location of the data. For now set it to "As Specified in Workspace and Parameters".

Click Finish to close the wizard. Repeat the same process for the second FMEServerJobSubmitter, this time selecting the second
workspace (the one that did the overlay of addresses on divisions).

15) Save, Publish, and Run Workspace
Save the workspace and publish it to FME Server. It should be registered with the Job Submitter service.
Locate the workspace in the Server web interface and run it to make sure it runs to completion. It will run each of the two child
workspaces in turn.
The evidence will be the log, a new sl3 file in the resources folder, and a new zipped geodatabase file in the resources folder:
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Notice that the timestamps will be very similar for the two datasets; the VotingDivisions.sl3 file should be created first and then
NewAddresses.gdb.zip shortly after (here, 6 seconds after).

16) Adjust Child Workspace
Now we have three workspaces on our FME Server. The first two can be run, by themselves, at any time that is required. We also
have a master workspace that can run the two in sequence.
However, the thought occurs... what if someone edited the first workspace to change the name of the output dataset? Then the
second workspace would fail in my chain because it would not know how to find the data.
Can we work around that? Yes, we can.
Back in FME Workbench open workspace number 2 (the one with the PointOnAreaOverlayer). Locate the source dataset
parameter for the SpatiaLite Reader. Right-click on it and choose Create User Parameter:

In the dialog that opens simply click OK to accept the default values. We have now replaced the source dataset parameter that
used to be published.
Save the workspace and publish it back to Server. You'll need to use the full publish tool - republish won't work for what we have
changed.

17) Adjust Master Workspace
Now open the master workspace in FME Desktop.
Open the wizard for the first FMEServerJobSubmitter transformer. This time set the Output Data Location parameter to
Temporary Folder.
Open the wizard for the second FMEServerJobSubmitter transformer. This time the Job Parameters dialog will include a
parameter for the source dataset.
Click the drop-down arrow and choose Attributes > output_datasets{}.path:
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You'll be prompted to select a list number. Simply select 0 (zero).
What we have done is told the second FMEServerJobSubmitter to use as its input the name of the dataset output by the first
FMEServerJobSubmitter. So if the first child workspace ever changes its output dataset name, it will be passed on to the second
child workspace automatically.
Publish the master workspace back to FME Server and run it to make sure all is still working correctly.

Sister Intuitive says...
The drawback of passing the output name from one workspace to another is that the data is no longer
permanently written in the first workspace. i.e. if you look at the Voting folder VotingDivisions.sl3 will not
have been updated.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create child workspaces that read and write resources datasets
Create a master workspace that runs the child workspaces using the FMEServerJobSubmitter
Set up an FMEServerJobSubmitter to automatically use as input the output from a previous
workspace
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Troubleshooting for Administrators
This section shows a few basic troubleshooting techniques in case of emergency

Workspaces Fail when Run
If a workspace fails when it is being run, then the following suggestions may help
Commonly data paths cause problems when moving from a local Desktop machine to a Server environment. Check the
dataset parameters (Reader and Writer) to ensure they are not referring to a local path that does not exist on the Server. You
may need to change the parameter to use the Resources dialog (Browse) and not a file path dialog (Specify Location).
If you are trying to read data with a UNC path, ensure that the FME Server Windows Service is being run by a user with the
proper domain access permissions.
If you are using an FMEServerJobSubmitter transformer, be sure to check the server name when porting from a test
environment to a live environment - or use FME System Parameters to avoid the problem
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Module Review
This module introduced you to running workspaces on FME Server.

What You Should Have Learned from this Module
The following are key points to be learned from this module.

Theory
Some workspaces read data from a feed or shared folder and so can be uploaded to FME Server and used immediately.
Others need source data to be managed to integrate with a Server workspace
Databases can have a container of connection information created and stored on FME Server
Data (and other related files) can be uploaded and stored on FME Server in various ways; either published data, temporary
uploads, or as “Resources”
Workspaces can be authored in FME Desktop specifically to use data stored in FME Server resource folders
Developer information is provided to help run workspaces via a URL
Workspaces can be run in a series of translations using a technique called chaining

FME Skills
The ability to create and use a database connection
The ability to publish data with a workspace, upload data for a workspace, or manage data in resource folders
The ability to create a workspace that references data into a resource folder
The ability to chain together workspaces using a parent-child model
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
If I create a database connection that has superuser permissions then it would bypass any permission
checks the database would make for creating and dropping tables. So how do you think I might prevent a
user misusing that capability?
1. Remove that user's permission to run that workspace on FME Server
2. Remove that user's permissions to access the entire repository that workspace resides in
3. Remove permission to access that particular database connection for that user's role
4. Remove from their role permission to manage database connections
You should know it can't be 1 or 2, because security is based on roles, not individual users. You could
remove permission to manage connections (4) but that won't prevent access to ones already created. You
should look for that connection under Object Policies in the security pages and remove from it any roles
that should not have access.

Miss Vector says...
Although simple, there is a major limitation to publishing data with a workspace. What do you think it is?
1. The data is only temporary and will be deleted once the workspace is run
2. The data is hidden within FME Server's system files and is inaccessible to any other use
3. The data becomes available to anyone regardless of role and security settings
4. The workspace cannot be run using any other data than that published with it
The limitation is that a dataset published in this way can only be referenced by this workspace, and by no
other. None of the others are true (it won't be deleted, it isn't open to anyone, and the workspace can be
run using other data if required).

Miss Vector says...
The system cleanup tools will erase any data uploaded like this when it is more than a day old. But which
cleanup task is it that will do so?
1. Delete_DataUpload_Files
2. Delete_EngineResults_Files
3. Delete_Service_Post_Content_Files
4. Delete_UserData_Files
It's #1. fyi #4 isn't even a real task!
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Miss Vector says...
So I can make my workspace read specific data from the resources folders - but how do I stop the end-user
from being able to change that?
1. Remove their security permissions for the Job Submitter service
2. Remove their security permissions for the Resources folders
3. Make the source dataset parameter optional for that Reader
4. Delete the published parameter for that source dataset from the workspace
Yes, in the Navigator window look for a published parameter that relates to the source dataset, and
remove it. The option to change the dataset will then not be presented to the user.
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Self-Serve with FME Server
Self-Serve takes the tedious tasks away from staff and leaves them to concentrate on more important things.

What is Self-Serve?
Self-Serve is the term for a system set up to allow the end-user to carry out their own data translations and transformations. In this
way, routine data management tasks are offloaded from staff to the user, who is empowered to carry out processes at their own
convenience.
Usually the system is set up in such a way that the end-user needs no prior FME experience or training to carry out their goals; for
example, they can access the functionality through a web interface customized to their particular needs. In fact the user does not
even need to know of FME, or that FME is the engine driving their applications!

Self-Serve Types
In general there are two types of self-serve systems.
Data Upload systems are where the user is able to upload their data to be processed on FME Server. A typical application would
be a user uploading data to be validated. The data is run against a number of tests in an FME workspace and the results sent back
to the user.
Data Download systems are where the user is able to serve themselves with data. A typical application would be an organization
that frequently provides data to either staff or customers. With a Data Download system the user can fetch their own data, rather
than having to be provided with it in a more manual way. Data can be downloaded as a set of files, or streamed directly into an
application.

Self-Serve and Services
Self-Serve is implemented through a number of Services on FME Server. A Service is a particular method of communication
between client and server. Different services allow different forms of data distribution to take place.

Self-Serve and Parameters
FME translations and transformations are controlled by parameters. To enable users to select the requirements for their
translation, FME includes functionality called Published Parameters. A parameter that is published becomes available for the enduser to set.

Miss Vector says...
For each of these scenarios, tell me if it is a Data Download project, Data Upload, both, or neither.
1. The user logs on to a web page, draws an area on the map, and is sent a copy of the data within that
area
2. The user submits a dataset to a web site that scans the data for errors, and returns a corrected copy
3. The user publishes a workspace that writes data to the user's account in an online PostGIS database
4. The user starts a GIS application, clicks File > Add Data to Map, and pastes in a URL from FME
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FME Server Services
Many standard operations using FME Server take place using something called a ‘service’. FME Server provides a wide range of
services to carry out common tasks.

What is a Service?
In the simplest of terms, a service is a piece of software that handles communications between a client and a server. In other
words, it’s a tool that allows users to access complex functionality through a simplified interface.

In terms of FME Server, the client is often—but not always—a web browser that passes requests to FME Server using a service.

For FME Server, a service lets you send specific types of requests to FME Server and provide results to client applications in a
specific way.
For example, instead of just running a workspace, you can have a web page ask for the results of the workspace as a package of
data compressed in a zip file.

Professor Spatial F.M.E., E.T.L. says...
Good morning class. I'm here to guide you through this chapter on Self Serve with FME.
Let's start with the idea of services. Although the concept sounds complicated, a service is just a simpler
way of communicating requests to FME Server than using the API. Also, FME Server includes a number
of predefined services that cover a lot of the functionality you are likely to need.

Available Services
FME Server includes the following services:
Data Download Service
Data Streaming Service
Transformation Services
Job Submitter Service
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KML Network Link Service
Data Upload Service
Token Service
Utility Services
Web Connection (SOAP) Service
REST Service
Notification Service

Notification Services

Remember that services can communicate in both directions. Transformation services – for example Data Download – are
primarily Self-Serve tools for Server to deliver data to the end user.
Utility services can be described as “helper” services. They interact with FME Server to assist in menial tasks such as uploading
data or providing token security. In most cases these are facilities that an author or developer will be using in a way that’s hidden
from the user.
The Notification Service is used for passing short messages into and out of FME Server. Incoming messages notify FME Server to
take some action, whereas outgoing messages alert an end-user (or system) that some sort of event has occurred.

NEW
Prior versions of FME had services specifically for OGC services such as WMS and WFS. Beginning with
2016.0, Safe Software now recommends that customers looking to provide OGC Web Services do so using
a combination of a workspace that implements the standard and the data streaming service that serves the
output.
This new method of providing OGC Services is more flexible as you have full control over implementation
of OGC features. See the FME Server documentation for more information and links to example
workspaces.

Workspaces and Services
When a workspace is published to FME Server it can be registered with a particular service.
The Job Submitter service is automatically selected in the FME Server publishing wizard, whenever a workspace is published, but
many other services are available too.
Registering a workspace with a service makes the workspace available for use in that service although, as you’ll discover, not
every workspace is capable of being used by every service.

Be aware of the Edit button to the right of each service.
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Every service has a set of parameters available that determine how a workspace will be run with that service:

Notice how these parameters include ones for notification topics to trigger on completion of the workspace.

WARNING
It’s important to understand that a workspace may be registered against one service, many services, or no
services at all!

Miss Vector says...
When a workspace is not registered against any service, how can you run it? Select all that apply.
1. With the FMEServerJobSubmitter transformer
2. With the run dialog in the web interface
3. With the URL specified under Developer Information in the run dialog
4. By setting it to run under a schedule
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Data Uploads
A Data Upload system is one where a user provides data to FME Server for it to process.
Data Upload can be used from any FME Server client, including:
The FME Server web interface
An FME workspace
A custom web application
Data Upload is often used for submitting data to an organization; for example a property developer submits a planning application
containing a DWG dataset to a municipal planning department.
It is also often used for publishing data to be processed on FME Server; for example FME Server is set up as a data validation web
service and an end-user uploads a set of data to be checked.
It’s worth noting that data upload also includes not just data, but other resources that may be required for a translation to run; for
example custom transformers or text-file lookup tables may also be uploaded.

Implementing Data Upload
On FME Server there are two ways to upload data. There is a specific Data Upload Service and there is also the Resources
filesystem.
The Data Upload Service uploads data to a particular workspace in a particular repository. The data is held temporarily for the
workspace to be run.
The Resources filesystem allows data to be uploaded to a folder for use by any workspace in any repository. This upload is
persistent and the data held there for as long as it required.
When creating a customized solution that involves data upload, the developer can choose whether to use to Data Upload service or
whether to use the Resources filesystem instead.
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Data Download Service
The Data Download service is the key tool for Self-Serve setups, where users are selecting their own choice of data to download.
It operates in a different way to simply running a workspace.
When you run a workspace with the Job Submitter service the data is written to the location specified by the workspace; for
example a file, directory, or database.
The Data Download service instead writes the output to a zip file and presents the user with a link to that file. This makes it ideal
for self-serve, because the data is delivered directly to the user.

Creating and Using a Data Download Service
A workspace becomes available for data download use when the author registers it against the Data Download service when
publishing it to FME Server:

Once registered this way, Data Download options become available in the FME Server Web interface for that particular
workspace:

The results of the workspace are not written to a specific output location; instead they are delivered to the user in the form of a
hyperlink to a zipped dataset:
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Miss Vector says...
When a workspace is registered against the Data Download service (and no other), how can you run it?
Select all that apply.
1. With the FMEServerJobSubmitter transformer
2. With the run dialog in the web interface
3. With the URL specified under Developer Information in the run dialog
4. By setting it to run under a schedule
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Exercise 1
Data

Orthophoto images (GeoTIFF)

Overall Goal

Create an FME Server Data Download system for orthophotos

Demonstrates

Creating a workspace and running it with Data Download

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex1-Complete.fmw

As a technical analyst in the GIS department of your local city you have plenty of experience using FME Desktop, and are just
getting started with FME Server.
Other departments frequently ask the GIS team for orthophoto imagery of the city. Their format of choice is usually JPEG.
Currently you use FME Desktop to translate the data, adding to your workspace any special requests they have such as a particular
resolution, a specific area of interest, or even sets of vector data stamped onto the raster.
However good you are with FME Workbench, it does take time to set up each of these individual requests. It would be far better if
the other departments could help themselves to the raster data, with options for all of their special requests built in.
Of course, you very soon realize that a Data Download system implemented on FME Server would be an ideal solution.

Miss Vector says...
If you have lots of experience with FME Workbench - and if your instructor agrees - simply open the
workspace listed in the header above and skip to step 6. But make sure you inspect the transformers and
their parameters, so you know what you are working with.

1) Create Workspace
Let's start off by creating a basic FME workspace to translate and transform the source raster data. Start FME Workbench and
select Readers > Add Reader. When prompted enter these parameters:
Reader Format

GeoTIFF (Geo-referenced Tagged Image File Format)

Reader Dataset

C:\FMEData2016\Data\Orthophotos\06-07-LM.tif

Reader Parameters

Feature Type Name(s): From File Name(s)

Workflow Options

Single Merged Feature Type

It's important to use the Single Merged Feature Type option because there are many source tiles of data, and we may want to read
any of them without having to add them as individual feature types.
The Feature Type Name parameter is important because it will help us later allowing the user to select which layers to read.

2) Add Writer
Now we need a Writer. Select Writers > Add Writer from the menubar. When prompted enter these parameters:
Writer Format

JPEG (Joint Photographic Experts Group)
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Writer Dataset

C:\FMEData2016\Output

Add Feature Types

Copy From Reader

Your workspace will now look like this:

3) Add Transformers
We'll start out with two transformers in our workspace; a RasterResampler and a RasterMosaicker. So place one of each of these
and connect up everything in the workspace:

.1 UPDATE
The RasterResampler transformer gained a Rejected port in FME2016.1

4) Set Transformer Parameters
Open the RasterResampler parameters dialog and set:
Size Specification

Cell Size

X Cell Spacing

5

Y Cell Spacing

5

Now open the RasterMosaicker parameters dialog. You can check the parameters but there really aren't any that need changing at
the moment, so simply click OK to close the dialog again.

5) Save and Run Workspace
Save the workspace and - just to ensure that all is well - run it in FME Workbench. The result should be a JPEG file
(GEOTIFF.jpg) along with a world file (GEOTIFF.wld).
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6) Publish Workspace
Now publish the workspace to FME Server. Register it with the Data Download service. If you are working on a remote server,
such as an FME Cloud instance, you'll need to either publish the data with the workspace or upload it to an FME Server Resources
folder.

7) Run Workspace
Log in to FME Server, locate the workspace, and run it.
The workspace will run and you will be presented with a hyperlink to a zip file of the output dataset:

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a workspace to read and write raster data
Publish and run a workspace using the Data Download service
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Self-Serve and Parameters
Workspace parameters are the key to controlling Self-Serve and the Data Download service

What are Parameters?
Parameters are what control a translation.

Chef Bimm says…
Order food in my restaurant and I'll decide how long it needs to be cooked, at what temperature, and
using what equipment. I'll also decide the amount of seasoning it needs and what plate to present it on.
Like an FME author, these are the parameters that control the results, and as the creator of the meal I get
to choose how best to set them.
Remember that a translation has a hierarchy of different translation components:

Each different level of the hierarchy has a set of parameters that belong to it. That means there are:
Workspace Parameters
Reader Parameters
Writer Parameters
Feature Type Parameters

Published Parameters
Published Parameters are those that have been exposed to the end-user, so they can set the values themselves. They are also called
“User Parameters”. In a self-serve application, published parameters are important to let the end user control how the data is
served in terms of style and structure.
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Chef Bimm says…
Of course, I will let you have some decision on your meal. For example, I'll let you decide how your steak
should be cooked - rare, medium, or well done - and what sauce you wish to add. I'll also let you select the
side dishes. These are what you would call the Published Parameters in FME; workspace controls that the
user gets to wield instead of the author.

Parameter Uses in FME Server
For self-serve systems, published parameters are most commonly used to set:
What coordinate systems to deliver data in
What feature types (layers) to deliver
What geographic area (Bounding Box or Area of Interest) to deliver
Any other Reader, Writer, or Transformer parameters of use to the user
With FME Server, the key to successful workspace authoring is flexibility. Workspaces need to be flexible to allow end-users to
make choices without seeing all of the complexity of the workspace or the data behind it. Parameters are one way to accomplish
this.
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Miscellaneous Published Parameters
Any parameter in FME can be published and presented to the user as a choice to be made when running a workspace. They don’t
have to be specifically related to the Data Download service.
Parameters are published in FME Desktop (i.e. FME Workbench) for use in FME Server.

Publishing a Parameter
In Workbench parameters are located in several places, but the FME Workbench Navigator window is the one place where you
will find them gathered in a single location:
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As you can see, there are parameters for the source data location (1) and the destination data dataset (2), which is the one that the
Data Download service overrides. There are also parameters for controlling the coordinate system (3), general Reader and Writer
parameters (4), parameters for each feature type (5) and parameters for transformers (6).
Parameters are published by right-clicking on them and choosing “Create User Parameter”. For example, here a workspace author
is publishing a parameter on the LabelPointReplacer transformer:

The author gets to choose the type of parameter (in this case a floating point number), the user prompt, and the default value.
When the workspace is run the end-user will now be able to decide what size they want labels to appear as:
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Key Parameter Types
There are multiple types of parameter, mainly related to the data type required; for example integer, float, string. However, two
key parameter types for a self-serve setup are "Choice with Alias" and "Scripted".

Choice with Alias
A Choice parameter is where a user is presented with a list of choices and their selected is returned directly to FME. A Choice
with Alias parameter is the same thing - the user is presented with a choice - but this time a different value is returned to FME
based on a lookup table.
For example, here the author wishes the user to select the height of labels to be created in the output dataset:

The user is presented with the list of (more intuitive) options on the left, but the value returned to FME will be the (more useful)
number on the right.
On FME Server this parameter type is very useful for Data Download tasks. That's because many of the values we want to pass to
FME - for example format or coordinate system names - have an abbreviated format that wouldn't make sense if presented to the
user. A Choice with Alias parameter allows us to provide a user-friendly list of options that hides a more complex response to the
server.

Scripted
Scripted parameters are a way to generate a parameter value using a Python or Tcl script.
For example, setting the size of labels in an output dataset might be a bit more complex than just a single number. It may involve
calculations related to the type of feature being labelled, the scale of any map being produced, the coordinate system used, and
many other factors.
In that case a scripted parameter could be used to calculate the required value in a Python script and return it to FME as a user
parameter.
Most importantly, a scripted parameter can include references to other user parameters; for example the scale of map being
produced might be selected by the user in a choice parameter, and label height calculated using that as one of the factors.
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On FME Server this is again very useful for Data Downloads. This time it's because some values we want to return - for example
a list of feature types - need to be constructed from a number of inputs. A scripted parameter allows us to accept input from the
user and incorporate that into a script that constructs the actual, more complex, response to the server.

Miss Vector says...
How well do you know the types of FME published parameters? Decide which of the following are real
parameters, and which are fake.
1. Color
2. Double
3. Password
4. Text (Multiline)
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Exercise 2
Data

Orthophoto images (GeoTIFF)

Overall Goal

Create an FME Server Data Download system for orthophotos

Demonstrates

Creating published parameters for user control in Data Download

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex2-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex2-Complete.fmw

As a technical analyst in the GIS department of a city you have just commenced a project to allow other departments to download
orthophoto data, rather than having to ask you to create it for them. Not only will their requests be processed quicker, you will also
spend less time on that task.
So far you have created a simple workspace to translate orthophotos to jpeg format, and published it to a Data Download service
on FME Server.
Now you need to start customizing the workspace to allow the end-users to have a degree of control over the output.

1) Open Workspace
Open the workspace from exercise 1, or the starting workspace listed above. You can see that it consists of a Reader, a Writer, and
two transformers.
In this step we'll give the end-user control over the transformation stages.

2) Create User Parameter
If you look at the parameters for the RasterResampler transformer you'll see parameters for X Cell Spacing and Y Cell Spacing.
We should let the end user choose what spacing they want.
So, in the Navigator window of FME Workbench, locate the section marked User Parameters. Right-click on there and choose the
option Add Parameter:

The dialog that opens allows us to create a new parameter. Create one using the following parameters:
Type

Integer

Name

CellSpacing

Published

Yes
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Optional

No

Prompt

Enter Resolution (1-50)

Default Value

50

Click OK to close the dialog.

3) Apply User Parameter
Currently we've created a user parameter, but not applied it to anywhere.
Open the parameters dialog for the RasterResampler transformer. Click the drop-down arrow to the right of the X Cell Spacing
parameter, and choose User Parameter > CellSpacing
Do the same for the Y Cell Spacing parameter. The dialog will now look like this:

Notice that we're using the same values for the X and Y cell sizes. That's OK. Although we could use rectangular raster cells, for
this exercise we'll stick with square.

4) Create User Parameter
Another setting we might give control of to the user is file compression. This is not defined in a transformer, but in the Writer
feature type. However, we can still create a published parameter in the same way.
So, right-click on User Parameters in the Navigator window and choose Add Parameter again.
This time we'll do this a little bit differently. Compression can be a value from zero to one hundred, but we'll present the user with
the choice of None, Low, Medium, and High.
So create a parameter with the following:
Type

Choice with Alias

145

Exercise: Published Parameters in a Data Download Service

Name

Compression

Published

Yes

Optional

No

Prompt

Select Compression Level

For the configuration field, click the [...] browse button. In the dialog that opens, set the following:
Display Name

Value

None

0

Low

25

Medium

50

High

75

Click OK and OK again to close these dialogs and create the parameter.

5) Apply User Parameter
To apply the parameter, click the cogwheel button for the JPEG feature type to open its properties dialog. Click the Format
Parameters tab. Set the compression parameter to User Parameter > Compression
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Click OK to close the dialog. If you press the run button now - with the prompt option set - you'll see that there are now two new
prompts for cell size and compression.

6) Publish and Run Workspace
Now publish the workspace to FME Server again. As before, register it with the Data Download service.
Locate the workspace through the FME Server web interface and run it. This time you will be prompted to set the cell size and
compression.

Run the workspace a few times, varying the cell size and compression, to confirm that the parameters are having an effect.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create an integer user parameter and apply it to two transformer parameters
Create a choice user parameter and apply it to a Writer feature type parameter
Publish a workspace and use published parameters
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Format and Coordinate System Selection
Self-serve systems allow an end-user to download data in the schema of their choice. This schema includes both data format and
data coordinate system.

Format Selection
To control format at run-time requires use of the Generic reader/writer in FME. The Writer has a parameter that controls which
format of data is being written.

By publishing this parameter, the user gets to choose the output format at run-time.
There are a couple of points to keep in mind when using the writer:
The output format parameter is automatically published, but in FME Server’s interface it appears only as a text field. Best
practice decrees this should be replaced by a new Choice with Alias parameter. That will make it easier for the user to select
a format, and the author can reduce the list of formats to a reasonable set of choices, each with a descriptive name.
Each writer format has its own specific parameters, and these may still need to be set when a generic writer is used. This can
be achieved by adding a writer of the same format and setting the parameters in that writer. The Generic writer will inherit
the parameters of this dummy writer, even if no features are connected to it.

Coordinate System Selection
Regardless of format, each Writer in FME has a coordinate system parameter, and publishing this parameter allows the end-user to
receive data in a coordinate system of their choice.
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Alternatively a transformer – such as the CSMapReprojector – can be used, in which case the relevant parameters can be found
under the Transformers section of the Navigator window. The obvious advantage to using a transformer is that you have control
over other reprojection factors, such as the geographic transformation and grid height.

Using Choice with Alias for Formats/Coordinate Systems
When creating a Choice with Alias parameter for a format or coordinate system, it's not necessary to manually enter display
names and values. Instead an import option allows the author to select the supported formats from a list:

Here the author has opened the list of coordinate systems and has selected several:
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These selections then appear in the parameter definition window:

Now when the end-user runs this workspace they will be presented with a list of coordinate systems to select from. The list will
show only the four selected systems and will pass on the short form of the name, which is what FME expects.
Besides coordinate systems, this functionality also supports reader and writer formats, for use in the Generic Reader and Writer.

Miss Vector says...
Let me throw an easy question at you! If the Generic Writer parameter is published to determine what
format to write data in a data download system, what would the Generic Reader parameter be used for?
1. To determine what format of data to read in a Data Download system
2. To determine what format of data to read in a Data Upload system
3. To determine the correct Styler transformer to use in the workspace
4. To determine whether I'm connected to a Data Upload or a Data Download system
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Exercise 3
Data

Orthophoto images (GeoTIFF)

Overall Goal

Create an FME Server Data Download system for orthophotos

Demonstrates

Controlling output format and coordinate system in Data Download

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex3-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex3-Complete.fmw

As a technical analyst in the GIS department of a city you have just commenced a project to allow other departments to download
orthophoto data, rather than having to ask you to create it for them. Not only will their requests be processed quicker, you will also
spend less time on that task.
So far you have created a simple workspace to translate orthophotos to jpeg format, added published parameters for
transformation, and published it to a Data Download service on FME Server.
Now you need to give the end-users control over the output format and output coordinate system.

1) Open Workspace
Open the workspace from exercise 2, or the begin workspace listed above. You can see that it consists of a Reader, a Writer, and
two transformers, plus some published parameters.
In this step we'll give the end-user control over format and coordinate system.

2) Add Writer
To give control over format needs a Generic format writer. Select Writers > Add Writer from the menubar. When prompted enter
these parameters:
Writer Format

Generic (Any Format)

Writer Dataset

C:\FMEData2016\Output

Writer Parameters

Output Format: JPEG (Joint Photographic Experts Group)
MIME Type: img/jpeg

Add Feature Types

Copy From Reader

The MIME type setting doesn't apply for a Data Download service, but we'll set it anyway. It can't hurt. Your workspace will now
look like this:

The upper (unconnected) feature type belongs to the Generic Writer.

3) Switch Feature Types
We want to write to the Generic Writer, not the JPEG Writer, so switch the connection from the JPEG feature type to the Generic
feature type. They are both labelled "GEOTIFF" so be sure to open the properties dialog to check if you need to.
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Don't delete the JPEG Writer though, or its feature type. We'll need those for reasons to be explained shortly.

4) Create User Parameter
To give control over format requires a published parameter. So in the Navigator window of FME Workbench, locate the section
marked User Parameters. Right-click on there and choose the option Add Parameter.
Set the parameter values as follows:
Type

Choice with Alias

Name

OutputFormat

Published

Yes

Optional

No

Prompt

Select the Output Format

For the configuration field, click the [...] browse button. In the dialog that opens, click on Import > Writer Format(s):

This will open a list of FME-supported formats. Choose a few simple raster formats such as JPEG, PNG, and GeoTIFF. Click OK
to close the dialog and return to the previous one:

WARNING
Be sure to use the PNG format called PNGRASTER. Don't select the format called PNG Rasterizer (PNG)
as that is for rasterizing vector data, not writing raster data.

Click OK and OK again to close these dialogs and create the parameter.
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5) Apply User Parameter
Now we've created a user parameter, we have to apply it.
Locate the Generic Writer in the Navigator window, expand its parameters and locate the parameter called Output Format. This is
already linked to a published parameter that FME created automatically, but we want to ignore that and use our own.
So, right-click on Output Format and choose the option to Link to User Parameter:

When prompted select the OutputFormat parameter that we just created:

The parameter FME created (GENERIC_OUT_FORMAT_GENERIC) will be automatically deleted. FME realizes that we don't
need it any more and, since it is used nowhere else, will remove it.

6) Create User Parameter
The next parameter required is to give control over output coordinate system. The process is very similar to that of format. In the
Navigator window of FME Workbench, locate the section marked User Parameters. Right-click on there and choose the option
Add Parameter.
Set the parameter values as follows:
Type

Choice with Alias

Name

OutputCoordSys

Published

Yes

Optional

No

Prompt

Select the Output Coordinate System

154

Exercise: Format and Coordinate Systems in a Data Download Service

For the configuration field, click the [...] browse button. In the dialog that opens, click on Import > Coordinate System(s). This
opens a list of FME coordinate systems. Choose a few simple systems that will apply to this part of Canada, such as LL84,
BCALB-83, and UTM83-10.
Click OK to close the dialog and return to the previous one:

Click OK and OK again to close these dialogs and create the parameter.

7) Apply User Parameter
Once more, now we've create a user parameter, we have to apply it.
Locate the Generic Writer in the Navigator window, and this time look for the parameter called Coordinate System:

Right-click on this parameter and choose Link to User Parameter. When prompted, select the published parameter called
OutputCoordSys that we just created.
If you now use the Run button in Workbench you'll see that both these parameters are now published.

8) Publish to FME Server
Save the workspace and publish it to FME Server. However! When you register it with the Data Download service be sure to
click the Edit button to edit the service properties. In that dialog you MUST change the writer from "Output [JPEG]" to "Output
[GENERIC]".
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If you don't do that, then the Data Download will consist of the output of the JPEG Writer. Since that is not connected, there will
be no output and so no zip file!
Once published locate the workspace in the FME Server web interface and run it.

Choose different options for output format and coordinate system to see what happens in the output.

Professor Spatial F.M.E., E.T.L. says...
Right now I imagine you have some questions!
Q) Why didn't we delete the original JPEG Writer when we added the Generic Writer?
A) It's because we have a parameter published for JPEG compression. If we deleted the JPEG Writer we
would no longer have access to that parameter.
Q) But we're not even using the JPEG Writer any more, so how would that parameter work?
A) Because the Generic Writer picks up parameters for the format it is writing from any Writer of that
format! So you could add a dummy PNG format Writer and the Generic Writer would use the dummy's
parameters when writing PNG.

CONGRATULATIONS
By completing this exercise you have learned how to:
Add a Generic Writer and set up its format and MIME type parameters
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Create an output format user parameter and apply it to a Generic Writer
Create an output coordinate system user parameter and apply it to a Generic Writer
Apply a parameter from a dummy Writer to the generic Writer
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Layer Selection and Handling
Spatial data is often organized in layers (groups, classes, categories, feature types) and a common way that users will wish to
choose data in a self-serve system is on a layer-basis.
In FME, feature type (layer) flexibility can be achieved through the Feature Types to Read parameter.

Selecting Layers
Each reader in FME has a parameter called Feature Types to Read. This parameter is used to tell FME which of the feature types
in the workspace should be used in the translation.
Here a Reader contains eight feature types. The Feature Types to Read parameter has been set up to read just three of these
(Libraries, Parks, TransitStations).

In the above, the parameter had been set by the author. However, when this parameter is published, the workspace will accept a
list of layers to read from the user.

TIP
Technically, what the end-user thinks they are selecting is a list of output layers, when in fact we are
giving them a list of source data. If the two are not an exact match, then use the Grouped Layers method
outlined below.
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Publishing Feature Types to Read
The dialog for publishing this parameter is different to that for formats and coordinate systems:

This is because FME can automatically scan the workspace and provide a list of available feature types. It's not necessary to
manually set up the list or even add them semi-automatically with an import option.
Additionally, the Use Alternate Display Name allows the author to publish alternate names (for example Road Centrelines instead
of RdCtrLns) in a similar way to the “Choice with Alias” parameter.

TIP
By default the Feature Types to Read list is fixed (as in the above screenshot).
However, if any of the Reader feature types has a merge filter set, then the Feature Types to Read option
presents the end-user with a list of ALL feature types in the source dataset, whether or not they are
specifically added to the workspace!

Grouped Layers
The choice of data by layer is easily handled if the layers correspond to Feature Types in the source data. However, on some
occasions we wish to present “groups” of layers, rather than a simple, separate list.
For example, we may wish to present “Water” as a choice to the end-user, where water is a group made up of multiple source
feature types such as Lakes, Rivers, and Streams.
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This type of scenario can be achieved using a parameter of type “Choice with Alias (Multiple)”.
Here the author has eight feature types, but they are organized in three groups (Amenities, Environment, Buildings) and he wishes
to present them to the end-user in this way:

The first step is to create a parameter of type “Choice with Alias (Multiple)”. In the parameter configuration, all feature types
from the same group are given the same display name:

Finally, the Feature Types to Read parameter is linked to the newly created Choice with Alias parameter.

160

Layer Selection and Handling

Now when the workspace is run, the end-user is presented with a set of three options (Environment, Buildings, and Amenities)
that reflect a series of different layers/feature types:

161

Exercise: Layers in a Data Download Service

Exercise 4
Data

Orthophoto images (GeoTIFF)

Overall Goal

Create an FME Server Data Download system for orthophotos

Demonstrates

Adding vector data. Handling layer selection in Data Download

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex4-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex4-Complete.fmw

As a technical analyst in the GIS department of a city you have just commenced a project to allow other departments to download
orthophoto data, rather than having to ask you to create it for them. Not only will their requests be processed quicker, you will also
spend less time on that task.
So far you have created a simple workspace to translate orthophotos to jpeg format. To this you have added published parameters
for transformation, format, and coordinate system. The workspace was published it to a Data Download service on FME Server.
One of the frequent requests you get when you translate orthophoto data is to add vector data as an overlay on the raster. This is
very simple in FME with the VectorOnRasterOverlayer transformer. However, to deploy this on FME Server means you need to
give the end-users control over which vector layers are included.

1) Open Workspace
Open the workspace from exercise 3, or the begin workspace listed above. You can see that it consists of a Reader, two Writers,
and two transformers, plus some published parameters.
To add - for example - road features to the raster output first requires a Reader for those road features, so that is the first step...

2) Add Reader
Select Readers > Add Reader and use the following setup:
Reader Format

Bentley MicroStation Design (V8)

Reader Dataset

C:\FMEData2016\Data\Transportation\RoadsDGN.dgn

Reader Parameters

Group Elements By: Level Names

Workflow Options

Single Merged Feature Type

We'll use the Single Merged Feature Type option here because there are multiple source layers and yet - because they are being
overlaid onto the raster as a group - we don't really need to have them divided in any way.

3) Add VectorOnRasterOverlayer Transformer
Add a VectorOnRasterOverlayer transformer. Connect the DGN feature type to the Vector input port, and the output of the
RasterMosaicker transformer to the Raster input port:
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You can check the parameters for this transformer but, for now at least, we'll leave them as they are.

.1 UPDATE
The VectorOnrRasterOverlayer transformer gained a Rejected port in FME2016.1

4) Create User Parameter
Now we have some source data we can create a parameter to control which layers in that data should be read.
In the Navigator window find the DGN Reader's parameters, expand the Features to Read section, and locate the parameter called
Feature Types to Read. You will see that it is already published - a result of us using the Single Merged Feature Type:

Right-click on the parameter and choose Edit User Parameter Definition. This will bring up a dialog that looks like this:
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Professor Spatial F.M.E., E.T.L. says...
The Feature Types to Read parameter tells FME which layers to read from the source. When you use a
Single Merged Feature Type (or manually set a merge filter) it is published automatically. It also is set to
update automatically.
This means when the end-user is prompted to select feature types, FME will automatically scan the source
dataset for the list. This is particularly useful for databases, where the table list will often change.
However, for this project we're going to assume a fixed list of feature types.

5) Edit User Parameter
In the Modify Feature Types List dialog, check the box that is labelled Fixed List, and also the box that is labelled Use Alternate
Display Name.
Click List > Add From Current Dataset and - when prompted - select all of the feature types in this dataset. Click OK and the
dialog will now look like this:
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What we could do is just create a display name for each road type and close the dialog. The end-user will then be able to select
any of the individual layers. However, for this project I think we should give them a simpler choice, and we will do that by
grouping the layers.
So, under the Display Name, enter values to match as follows:
Display Name

Feature Type

Primary Roads

Arterial

Primary Roads

Collector

Other Roads

NonCity

Other Roads

Private

Secondary Roads

Residential

Secondary Roads

Secondary

Other Roads

Other

The list will sort itself by display name and look like this:
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What this will do is give the user a choice of three options: Primary Roads, Secondary Roads, Other Roads. Whichever they
choose will return all of the source layers for that choice.
One final task. In the lower part of the dialog, change the prompt to something like "Vector Roads to Overlay":

It's just a small thing but will help with the end user experience.

6) Save and Run Workspace
Save the workspace and then run it in FME Workbench to test it. You should be able to select any of the three types of roads, or
even none of them:

Check that the output includes whatever roads you selected.

7) Clean User Parameters
If your workspace is like mine, there are a number of extra published parameters we don't really need right now. Plus the order of
parameters is not good. Let's take this opportunity to clean it up.
Locate and delete the following published parameters:
SourceDataset_GEOTIFF
SourceDataset_DGNV8
DestDataset_JPEG
DestDataset_GENERIC
Finally, let's change the order of parameters. You can do this by dragging one above the other in the Navigator window. So do this
and put the parameters in the order that seems best to you:

8) Raster User Parameters
Now let's do something with the source raster. We want the user to be able to select the files to read, without having to upload
them. Locate the Reader in the Navigator window and double-click the Source GeoTIFF File(s) parameter. When prompted, select
all of the GeoTIFF files in the Orthophotos folder.
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This would normally mean that all files would get read into the translation; but the Feature Types to Read parameter will let the
user actually choose which ones to read. We do, however, need to make some edits.
Open the definition of the GeoTIFF Feature Types to Read parameter. Click the option for a Fixed List. To list all of the available
tiles select List > Add From Current Dataset and select all the files.
Finally change the prompt to something sensible like "Raster Tiles to Read".

Now run the workspace again to check on our improved parameters dialog.

WARNING
At this point you might find, on running the workspace, that no filenames appear. Instead all you get is a
single option called "Geotiff" in the file prompt.
The reason for that is you made a mistake way back in exercise 1, step 1. You missed out setting the
parameter "Feature Type Name(s)" to "From file name(s)".
The only solution to this is to delete the GeoTIFF reader, and re-add it, this time being sure to set that
parameter!
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9) Publish to FME Server
Save the workspace and publish it to FME Server. There are two things to note.
Firstly, because we removed the Source Dataset parameters FME will suggest we upload the data. If your data is on the same
computer as FME Server (or on a path otherwise accessible to the Server), then you don't need to do this and can uncheck that
box:

Secondly, remember to make sure the Data Download service is using the "Output [GENERIC]" writer.
In the FME Server web interface, run the workspace, taking time to admire the new, cleaner set of parameters that are available:

Outside of a training environment we might want to order the raster tiles into groups, but we'll live with it as-is for now.

CONGRATULATIONS
By completing this exercise you have learned how to:
Add vector data onto raster
Use the Feature Types to Read parameter in automatic mode
Edit the Feature Types to Read parameter to create a manual list
Edit the Feature Types to Read parameter to create a grouped manual list
Clean up unnecessary user parameters and change the display order
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Geographic Selection
Although most workspaces are designed around FME feature types, this may not be how the end-users see the data, or how they
need to select it. An installation that provided selection only by layer (or even a group of layers) would be very limiting indeed.
Besides layers, other methods of data selection revolve around spatially defining an area of interest. There are three obvious ways
of doing so:
A simple, rectangular bounding box
An existing boundary (any area feature such as a regional or municipal boundary)
An ad-hoc boundary (an area drawn by the user as needed)
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Bounding Box
A bounding box can be defined in several ways, but the easiest is to use a set of parameters.
All FME readers have parameters to define the bounding box (envelope) of data that is being read:

The parameters include not just the coordinates of the bounding box, but also a parameter to define the coordinate system. The
coordinate system for the bounding box does not have to be the same as the coordinate system the data is stored in, meaning tools
that return lat/long coordinates can be used to clip data in UTM (very useful for mobile FME Server solutions).
There is also a parameter specifying whether to clip features to the exact envelope boundary. If set to No then features that overlap
the boundary will be included in their full (unclipped) form. For a Data Download service it's more likely than not that this
parameter should be set to yes.
The workspace author can manually set these parameters, but by publishing them the end-user is able to enter values that define
the extent of the data he/she is interested in.

Ms. Analyst says…
Using reader parameters is the most efficient method of selecting an area of interest because it can mean
FME does not have to read the entire dataset first and then clip it to size; it can read only what data is
necessary. It applies to both vector and raster datasets and is particularly efficient if the source format has
a spatial index.

Web Mapping and Bounding Boxes
Bounding box parameters are particularly useful when a web mapping application (for example Google Earth) is requesting data.
The application will provide the extents of the current map view and the workspace restricts itself to reading features within those
extents.
This, of course, is done using published parameters. The parameters in the workspace need to be given specific names when
published, as follows:
bboxWest
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bboxEast
bboxNorth
bboxSouth
A KML Network Link service will automatically make use of these parameters. In fact, if you publish a workspace and click the
Edit button for KML Network Link properties, you will notice how these are used to pass information back to the workspace:
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Existing Boundaries
An existing area feature can be read into a workspace, but it cannot then be forced into the clip boundary parameters of a Reader,
and is anyway irregularly shaped rather than a rectangle.
So, instead of using Reader parameters, an existing boundary is used to clip data either with a FeatureReader transformer or with a
Clipper transformer.

Selecting the Existing Area
If the existing area feature is a single feature in a dataset, then it can be read into the workspace and used immediately.
If, however, it is part of a larger dataset, then it needs to be filtered from the rest of the data. If the Reader has a where clause (and
the feature can be identified in that way) then it is the most efficient way of filtering the data:

Here the data from a Geodatabase is filtered down to the one required feature using a WHERE clause. If the Reader has no
WHERE clause parameter, then the full dataset can be read and the required feature filtered out using transformers such as the
Tester or TestFilter.

FeatureReader
The existing area feature is routed into the FeatureReader like so:

Here a single garbage schedule area (Blue zone, north) is passed to the FeatureReader for use as a filter. The idea is to return only
addresses that fall inside that garbage zone. The parameters dialog is set up like this:
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Notice that the FeatureReader is set to read from an address geodatabase. The Spatial Filter parameter tells the transformer to only
read features inside the incoming area feature.

Clipper
The Clipper transformer is a means to spatially filter data that is already read into a workspace (other similar transformers are the
PointOnAreaOverlayer, or the SpatialFilter).
Here the address database is read into a workspace and the Clipper used to filter out those addresses that fall inside the chosen
garbage collection zone:

Ms Vector says...
In the above examples, the results of the Clipper and FeatureReader will be exactly the same. So why is
the FeatureReader the preferred option? Pick all the reasons that apply:
1. It can be quicker and more resource efficient
2. It allows multiple areas to be used as the existing areas
3. It work with raster data
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4. It has more choices for spatial filtering
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Ad Hoc Boundaries
Sometimes the geographic area for data download is not a previously known shape. Sometimes it is simply defined by the user on
a web map as it is needed.
In this scenario a different technique is needed for your FME workspaces, one that involves a published parameter.

Passing Ad Hoc Boundaries to FME
The way to pass an area boundary to FME is with the geometry defined as a string. The geometry could be, for example, either
WKT (Well-Known Text) or XML. The string is passed to FME using a published parameter.
One simple method would be to use an AttributeManager transformer and publish the Value part:

This information could be used in a sequence like this; the translation is triggered with a Creator, the geometry string retrieved
with the AttributeCreator, the attribute contents converted into true geometry with a GeometryReplacer, and then the real data read
with a FeatureReader:

With these methods, a web mapping interface that allows the user to define their own custom area of interest can pass it to the
FME workspace to be used as the area of interest in a Clipper or FeatureReader.

Ms Vector says...
If the incoming geometry string is XML, there is a shortcut to the above example. What is it?
1. Use an XML Reader with the source dataset parameter published
2. Publish the source dataset parameter in the FeatureReader to send the XML straight into it
3. Replace the GeometryReplacer with an XMLTemplater
4. Use a Creator transformer with the geometry parameter published
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Exercise 5
Data

Orthophoto images (GeoTIFF)

Overall Goal

Create an FME Server Data Download system for orthophotos

Demonstrates

Handling selection by geographic area

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex5-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex5-Complete.fmw

As a technical analyst in the GIS department of a city you have just commenced a project to allow other departments to download
orthophoto data, rather than having to ask you to create it for them. Not only will their requests be processed quicker, you will also
spend less time on that task.
You've implemented a lot of different options for transformation, format, coordinate system, and layers to process. However, endusers also often ask for raster data for a particular neighborhood of the city, and that's easy to do using a Clipper transformer.

1) Open Workspace
Open the workspace from exercise 4, or the begin workspace listed above. You can see that it consists of a Reader, two Writers,
three transformers, and various published parameters.
To clip data to a particular neighborhood first requires a Reader for those neighborhood features, so that is the first step...

2) Add Reader
Select Readers > Add Reader and use the following setup:
Reader Format

Google KML

Reader Dataset

C:\FMEData2016\Data\Boundaries\VancouverNeighborhoods.kml

When prompted, select only the feature type for Neighborhoods:
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Once added, remove the published parameter for SourceDataset_OGCKML. We don't need to prompt to user to select this dataset.

3) Add Published Parameter
Currently the KML Reader will read all of the neighborhoods. However, we need the user to select one of these to clip the data
with. To select the neighborhood we'll use a published parameter.
So, add a new parameter. Set the parameter values as follows:
Type

Choice

Name

Neighborhood

Published

Yes

Optional

Yes

Prompt

Select the Neighborhood

For the configuration field, click the [...] browse button. In the dialog that opens, enter the names of the neighborhoods of
Vancouver. These are:
Downtown
Fairview
Kitsilano
Mount Pleasant
Strathcona
West End
Notice that this parameter is optional. The user should not have to select a value if they don't want to. Also, this is a choice field
alone; an alias is not needed because the proper values are clear enough.

4) Add Tester
Now we need to filter the neighborhood data by the user's choice. So add a Tester transformer to the workspace, connected to the
Neighborhood feature type:

Open the parameters dialog and set up the parameters to test where NeighborhoodName = the neighborhood published parameter:

Click OK to close the dialog.

5) Add CsmapReprojector
One interesting part of the neighborhood dataset is that it is in a Latitude/Longitude coordinate system, whereas all other data is in
UTM83-10. To be able to clip one with the other requires both datasets to be in the same coordinate space.
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So, place a CsmapReprojector transformer after the Tester, connected to the Tester:Passed port. Set it up to reproject to UTM83-10

Professor Spatial F.M.E., E.T.L. says...
Why does the CsmapReprojector come after the Tester? Because it has less work to do. If the data was
reprojected first then we would be reprojecting data that is subsequently filtered out. It might only be a
small difference here, but this is the type of detail that really helps workspace performance in larger
projects.

6) Add Clipper
Now to clip the raster data. Add a Clipper transformer to the workspace. Connect the CsmapReprojector to the the Clipper:Clipper
port. Connect the output from the VectorOnRasterOverlayer to the Clipper:Clippee port:

Check the parameters. The only parameter to change is one specifically related to raster data: Preserve Clippee Extents. Set this
parameter to No and click OK to close the dialog.

7) Publish to FME Server
Save the workspace, publish it to FME Server, and run it. You should now be able to choose all source tiles and clip them to a
chosen neighborhood, like so (here, the Downtown neighborhood):
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CONGRATULATIONS
By completing this exercise you have learned how to:
Set up a workspace for a user to select a specific area feature
Clip data to a chosen area for use in a Data Download system
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Other Self-Serve Services
Although most people look at self-serve mostly in the context of Data Download, that is not the only Self-Serve Service available.

Data Streaming
Data Streaming is another service that a workspace can be registered against:

Whereas the Job Submitter service writes data, and the Data Download service returns a link to the data, a Data Streaming service
returns a file of the data itself, streamed back to the client.
For example, if the URL for a workspace is posted into a web browser, the data will be automatically downloaded and opened in
whatever application the browser associates with that file type (some data might open directly in the web browser itself).
Alternatively, the URL can be used directly as the source for a client application, like a GIS tool. When the client actively
downloads the contents on a regular basis – as a GeoRSS reader would – then you have a feed, which is significantly different to a
regular data download service.

Professor Spatial F.M.E., E.T.L. says...
Data Streaming is a slight misnomer in that a data streaming service does not supply a continuous stream
of data; it merely provides a snapshot of the data at a particular point in time.

What Formats can be Streamed?
You can use any workspace with the data streaming service, provided it writes data in a format that is file-based or folder-based
(i.e. not to a database or web URL).
If an output dataset is comprised of more than one file, the data streaming service automatically creates a compressed (zip) folder
out of the data. For example, AutoCAD DWG format could be streamed, whereas ESRI Shape would be returned in a zipped file.
The most popular formats to stream are those that have a suitable client to read the feed. Some of the main formats that are output
using the data streaming services include:
RSS
GeoRSS
GeoJSON
KML
HTML
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JSON

MIME Types in Workspaces
A MIME header is a component of a file or e-mail message that is capable of indicating the content type of the file; for example,
Content-Type: text/plain indicates a simple text file.
The application that opens a streamed file will depend on the MIME type and file association on the client’s system. MIME type is
provided in FME by the first Writer added to the workspace.
The only Writers in FME with a MIME type setting are the TextLine (text file) and Data File Writers.

Here the author is saying that the content of the text file is valid HTML and should be opened in the default HTML application
(presumably a web browser).

KML Network Link
Google describes a KML Network Link as a type of bookmark; a link from Google Earth (or any other KML-reading application)
to the true set of data.
In FME you can register any KML-writing workspace as a KML Network Link service, however you must also registrer it under
Data Streaming as well:

Running the workspace using this service merely returns a small KMZ (zipped KML) file that contains this "bookmark". The
bookmark is a link back to the workspace whose URL points to the Data Streaming service.
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When Google Earth opens a KML Network Link service from FME Server, it receives the link to the workspace:

When the link is followed it triggers FME Server into running the workspace and returning the results as a stream of KML data.
Because Google Earth permits a refresh rate for network links, the translation can be re-run at a user-defined interval. This way
the results are always as up-to-date as the chosen interval.
Of course, in this scenario the output is never written to a permanent dataset; the resulting data is simply streamed to the browser,
which writes it to a cache.
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Exercise 6
Data

Orthophoto images (GeoTIFF)

Overall Goal

Create an FME Server Data Streaming system for orthophotos

Demonstrates

Data streaming

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex6-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\SelfServe-Ex6-Complete.fmw

As a technical analyst in the GIS department of a city you have just created a system to allow other departments to download
orthophoto data, rather than having to ask you to create it for them.
Sometimes the end-users download data as JPEG just to open it in a browser or image viewer to inspect it. You realize that, in
cases like this, they may be able to use a data streaming service, instead of a data download.

1) Open Workspace
Open the workspace from exercise 5, or the begin workspace listed above. You can see that it consists of various Readers, Writers,
transformers, and other functionality. Most importantly there is an unconnected JPEG Writer that could be used to stream data.
Currently the JPEG Writer is disconnected, so connect it back into the workspace, this time to the Clipper:Inside output port:

2) Publish to FME Server
Now publish the workspace to FME Server.
In the final dialog of the publishing wizard, check the boxes to register the workspace with both Data Download and Data
Streaming (but don't click Finish yet):

Now click the Edit button for the Data Download service. Ensure that service is using the output of the Generic Writer.
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Next click the Edit button for the Data Streaming service. Ensure that service is using the output of the JPEG Writer (for now
we're limiting the streaming of data to JPEG format).

3) Run Workspace
In the FME Server web interface locate the newly published workspace and run it. In the parameters for the workspace be sure to
set the web service to Data Streaming instead of Data Download:

The result of this translation is not a streamed jpeg file. Instead, the translation returns a zip file:

If you open the zip file you'll see that it includes both a jpeg file and a wld file. That's why FME returned a zip file. It will zip the
results of a Data Streaming service whenever the result is multiple files.

4) Turn off wld File Creation
To really stream the data we should turn off the wld file creation in the workspace. Open the properties dialog for the JPEG
Writer's feature type and click the Format Parameters tab. Set the Generate World File parameter to No:
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Click OK to close the dialog.

5) Publish and Run Workspace
Re-publish the workspace and run it on FME Server. You should find that the results of the translation are returned as a streamed
jpeg file. Most likely it will open directly in your web browser:

CONGRATULATIONS
By completing this exercise you have learned how to:
Set up a workspace for use in a Data Streaming service
Published a workspace to the Data Streaming service
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Troubleshooting for Administrators
This section shows a few basic troubleshooting techniques in case of emergency
Data Download: No Output
If no zip file is output at the end of a Data Download process then the following suggestions may be of help.
Run the workspace on FME Desktop to confirm that it does actually write some data. If there is no output data then no zip
file will be delivered.
Check that the FME Server has access to the source data. If the source data is not available to FME Server then there will be
no output.
On FME Server check the log file using Jobs > Completed to confirm that the process did actually try to write some data. If
not an error message may help to indicate why.
Data Download: Empty Output
If an empty zip file is output at the end of a Data Download process then the following may be of help.
Ensure that when you publish the workspace to FME Server you check the Data Download parameters and choose an output
dataset to be associated with the Service. If you don’t, then FME has no way to determine which Writer will provide the
output.
Data Streaming: Zipped Output
If the Data Streaming service does not provide a dataset, but a zip file, then the following may be of help.
If the output format is one composed of a number of files – for example Esri Shape – then the Data Streaming service will
create a zip of the output.
Often raster Writers will write an additional world file, and vector Writers a prj file, in order to preserve coordinate system
information, and this can unexpectedly cause this issue. In most cases wld/prj file creation can be turned off with either
Writer or Feature Type parameters.
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Module Review
This module introduced you to FME Server’s Self-Serve Services and related functionality in FME Workbench

What You Should Have Learned from this Module
The following are key points to be learned from this module.

Theory
Services handle communication between FME Server and its clients. Each workspace published to FME Server can be
registered with any number of services.
The Data Download service overrides the destination dataset parameter and presents data to the end-user as a link to a zip file
Parameters control the different actions of a Data Download system, including the output coordinate system.
The Generic Writer is a writer whose format is only defined at run time. This can be provided by the user through a published
parameter.
Selection of source data by layer is achieved using the Feature Types to Read parameter
Selection of source data by area can be achieved using Bounding Box parameters, or a transformer such as the Clipper or
FeatureReader
Other FME Services allow data to be streamed live into a suitable application

FME Skills
The ability to publish a workspace and register it to the FME Server Data Download service
The ability to create and use published parameters
The ability to give the end-user control over format, coordinate system, layers, and area of interest
The ability to use Data Streaming and KML Network Link services

Further Reading
For further reading why not check out this guide to sharing open data using FME Server, or this fine blog article that explores how
to implement an open-data portal using FME, Amazon S3, Leaflet, JQuery, and a whole lot more!

189

Q+A Answers

Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
For each of these scenarios, tell me if it is a Data Download project, Data Upload, both, or neither.
1. The user logs on to a web page, draws an area on the map, and is sent a copy of the data within that
area: Data Download
2. The user submits a dataset to a web site that scans the data for errors, and returns a corrected copy:
Both Data Upload and Data Download
3. The user publishes a workspace that writes data to the user's account in an online PostGIS database:
Neither Data Upload or Data Download
4. The user starts a GIS application, clicks File > Add Data to Map, and pastes in a URL from FME
Server: Data Download
#1 is a simple download of data. #2 is obviously both. #3 is neither. Publishing a workspace is not Data
Upload and writing to a database is not Data Download. #4 would be a special type of Data Download.
In FME we call it Data Streaming; the workspace runs and the output is sent directly to the application
that requested it.

Miss Vector says...
When a workspace is not registered against any service, how can you run it? Select all that apply.
1. With the FMEServerJobSubmitter transformer
2. With the run dialog in the web interface
3. With the URL specified under Developer Information in the run dialog
4. By setting it to run under a schedule
You cannot run the workspace in the web interface (the run button won't work unless services are
available) or with a URL (none will be provided).

Miss Vector says...
When a workspace is registered against the Data Download service (and no other), how can you run it?
Select all that apply.
1. With the FMEServerJobSubmitter transformer
2. With the run dialog in the web interface
3. With the URL specified under Developer Information in the run dialog
4. By setting it to run under a schedule
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It will actually run under all of these tools. Of course, only the web dialog and the URL return a zip file
for download. The others just output the data to the specified workspace location.

Miss Vector says...
How well do you know the types of FME published parameters? Decide which of the following are real
parameters, and which are fake.
1. Color: Real
2. Double: Fake
3. Password: Real
4. Text (Multiline): Real

Miss Vector says...
Let me throw an easy question at you! If the Generic Writer parameter is published to determine what
format to write data in a data download system, what would the Generic Reader parameter be used for?
1. To determine what format of data to read in a Data Download system
2. To determine what format of data to read in a Data Upload system
3. To determine the correct Styler transformer to use in the workspace
4. To determine whether I'm connected to a Data Upload or a Data Download system
Right, I'm uploading some data and I'm going to tell FME Server what format it is. Why would I care (#1)
about what format of data is being read in a Data Download system (and how could I tell)? Similarly (#3)
it's the output format that determines which Styler to use, not the input format. #4 is just plain nonsense!

Miss Vector says...
Why is the FeatureReader the preferred option [for filtering data in a self-serve system]? Pick all the
reasons that apply:
1. It can be quicker and more resource efficient
2. It allows multiple areas to be used as the existing areas
3. It work with raster data
4. It has more choices for spatial filtering
The FeatureReader is more efficient where the source dataset is a format that has a spatial index, because
it won't have to read all of the source data. It also has more filtering choices than a Clipper transformer
(though not a SpatialFilter)
The FeatureReader does allow multiple areas to be used, and it does support raster data - however so
does the Clipper transformer, so there is no difference between the two in those scenarios. Additionally,
the two are equivalent in performance where there is no spatial index (i.e. both will need to read the full
dataset)

Miss Vector says...
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If the incoming geometry string is XML, there is a shortcut [to passing/using it in a workspace]. What is
it?
1. Use an XML Reader with the source dataset parameter published
2. Publish the source dataset parameter in the FeatureReader to send the XML straight into it
3. Replace the GeometryReplacer with an XMLTemplater
4. Use a Creator transformer with the geometry parameter published
If you publish the geometry parameter in a Creator transformer you can pass XML directly into it and
FME will automatically generate a spatial feature from it. This removes the need for any
AttributeManager and GeometryReplacer transformers.
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Real-Time with FME Server
Real-Time systems are those that act on events as they happen, and send information as it becomes available.
Real-time is often implemented to monitor sensor networks, run event-driven processing, and/orto send alerts to mobile devices
such as cell phones. Therefore real-time is usually related to small amounts of information (rather than large datasets) that arrive
either as individual events or as a continuous communication stream.
Real-world examples include processing simple location data from a vehicle tracking system, or handling a continuous stream of
data from a temperature sensor or lightning detector. A simpler example would be sending email to a system administrator in
response to database table updates.
Real-time data in FME Server is handled in two ways: Notifications and Message Streams. Message streams are covered in the
next chapter.

Notifications
Notifications are how FME Server handles individual messages and alerts.
FME Server has a specific Notification Service that can be set up to listen for an incoming message from outside of FME, and
trigger a certain action in response; or that can be set up to send a single alert in response to an event that takes place on FME
Server.
Protocols supported include email, websockets, and notifications for Apple and Android devices.
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The Notification Service
The Notification Service is a way for data to be pushed to and from FME Server in the form of short messages.

What is a Notification?
A notification is a simple message (sometimes called an “alert”) that informs someone or something that a particular event has
happened.
Notifications on FME Server can occur in two different forms: incoming and outgoing.
Incoming notifications alert FME Server to an event that has taken place elsewhere.
Outgoing notifications alert users to an event that has taken place on FME Server.

In this way, FME Server can take action in response to an event notification, or a user can take action in response to a notification
from FME Server.
The Notification Service is the part of the FME Server architecture that handles incoming and outgoing notifications.

When to Use Notifications
Notifications should be used when you want to trigger an FME Server response to an event that is reported from outside of FME.
The event should not be a continuous series of messages; if there is more than one message per second you should consider using
Message Streaming techniques instead.
Notifications are also for when you want to send a message about something that happened on FME Server, to an outside
subscriber. Again, if there is likely to be more than one message per second you should consider using Message Streaming.
In either case a notification is for sending a brief message, usually in order to trigger an action from the recipient. It’s not intended
to be used for transmitting large amounts of spatial data. At most you should use it for a single geographic feature such as a point
location.
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Elements of the Notification Service
The Notification Service includes a number of different components.
Clients: An external user or system that sends or receives a notification
Publications: An event handler that listens for incoming notifications
Subscriptions: An event handler that dispatches outgoing notifications
Topics: A subject that describes what the notification is about
Protocols: Methods by which FME Server can receive or send notifications

Ms Analyst says...
As well as Publications/Subscriptions you'll also hear the terms Publishers/Subscribers. These are
alternative names for clients. Publishers are clients that publish to FME Server Publications. Subscribers
are clients that subscribe to FME Server Subscriptions. Try not to get the terms muddled!

Miss Vector says...
All notification setups must have which of these:
1. Incoming components (Publisher, Publication) AND outgoing components (Subscription, Subscriber)
2. Incoming components OR outgoing components OR both
3. Incoming components OR outgoing components but never both
4. None of the above
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Clients
A client is a user or system that sends or receives a notification. The client may be a physical person, or may just be a component
in a computer system. Either way, a client is not a core part of FME Server, rather someone or somthing that interacts with it.

For example, a database update might cause a trigger to send a notification to FME Server, in which case the database system is
the client. But a client could also be a person who, for example, triggers a notification by sending an email to FME Server.
Likewise, FME Server can send a notification for another client system to receive. Alternatively this client can also be a real
person, who might receive a notification in the form of an email.

Publishers vs Subscribers
Clients that send a notification to FME Server are called Publishers.
Clients that receive a notification from FME Server are called Subscribers.
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Publications
A Publication is a component that receives incoming notifications from a client.

To receive notification in FME Server a user must create a new Publication. A Publication is created in the FME Server Web User
Interface under the Notifications section.

Subscriptions
A Subscription is a component that sends outgoing notifications to a client.
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To send a notification in FME Server a user must create a new Subscription.
A Subscription is created in the FME Server web interface under the Notifications section.

FME automatically creates some subscriptions on installation, to alert clients to the success or failure or jobs that have been run.

IMPORTANT
Although the actions may seem odd in regard to the name – Publications receive messages, Subscriptions
send them – it is correct. The name refers to the Client, not the Server. So FME Server receives a
Publication because the client is publishing it. Likewise, FME Server sends a Subscription because the
client is subscribing to it.
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Topics
A Topic is a component that acts as a mediator for messages and defines the message content. Think of it as a mix of subject line
for notifications and a trigger for them to occur.

Like Publications, a Topic is created in the FME Server Web User Interface, under the Notifications section:

FME automatically creates some topics on installation, to trigger the subscriptions that it creates.

Publications and Topics
All Publications are linked to a Topic so that when an incoming message is received it is categorized and the related Topic is
triggered.
A Publication can be linked to multiple Topics, each incoming message can trigger multiple actions to occur. Additionally,
multiple Publications can trigger the same topic.
For example, a lightning strike sensor might publish to the topics WeatherEvent and AircraftAlerts, whereas a flood sensor might
publish to the topics WeatherEvent and RoadConditions.
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Daily Interop Reporter, Chad Pugh-Litzer says…
When I write a news article I publish the article to the Daily Interop web site, tagged with a number of
topics to describe it. For example, a report about a soccer team’s tax return would be filed under both
‘Financial’ and ‘Sports’ because it relates to both.

Subscriptions and Topics
All Subscriptions are also linked to a Topic. When a topic is triggered an outgoing message is sent.
A subscription can be linked to multiple Topics, each topic being triggered causes an outgoing notification. Each Topic can also be
subscribed to by multiple Subscriptions.
For example, a police headquarters might subscribe to the RoadConditions topic, to receive notifications on that subject. The local
TV weather channel also subscribes to the RoadConditions topics, but in addition subscribes to WeatherEvent to hear about those
particular events.

InteropGeek68 says…
I subscribe to articles published on the Daily Interop web site according to their topic. For example, I
subscribe to reports with the topic financial, whereas my friend – InteropJock72 – subscribes to sports
articles. Because Chad's article has both tags, we'd both receive it.

Miss Vector says...
Please don't get this wrong! Publications and Topics have what relationship?
1. One:One (Each publication has one topic, each topic belongs to one publication)
2. One:Many (Each publication can have many topics, each topic belongs to one publication)
3. Many:One (Each publication has one topic, each topic can belong to multiple publications)
4. Many:Many (Each publication can have many topics, each topic can belong to multiple publications)
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Protocols
A protocol is a system of data exchange between FME Server and a client.
We already know that FME sends and receives notifications. Protocols are the method by which these notifications are sent and
received. Each Publication and Subscription is defined using a particular communication protocol.
To trigger a Publication by email – for example – you would use the Email protocol. To send a notification to subscribers with an
Apple mobile device, you would use the Apple Push protocol.
There are many different protocols available in FME Server; some of them are only for use on Publications, some are only for
Subscriptions, and some of them can be used with both notification types.
This table lists the different Publication and Subscription protocols and the following pages go into detail on some of the most
important.
Protocol

Description

Publications

Subscriptions

Amazon S3

Communication with Amazon’s Simple Storage Service

Y

Y

Amazon SNS

Communication with Amazon’s Simple Notification
Service

Y

Y

Amazon SQS

Communication with Amazon’s Simple Queue Service

Y

Y

Apple Push
Notification

Communication with Apple mobile devices

Directory Watch

Monitoring a folder for new files as a trigger mechanism

Y

Dropbox Watch

Like Directory Watch, but monitoring folders stored in the
Dropbox web service

Y

Dropbox

Communication of a notification (file) to the Dropbox web
service

Email (IMAP)

Communication via an email service

Y

Email (SMTP)

Communication via an email server

Y

Y

FTP/SFTP/FTP
Watch

Communication with an FTP site

Y

Y

Google Cloud
Messaging

Communication with Android mobile devices

JMS

Communication with a Java Message Service

Logger

Output to a simple log file

Y

Push

Communication via HTTP requests

Y

UDP

Communication via a User Datagram Protocol port

Y

WebSockets

Communication via a WebSockets channel

Y

Workspace

Communication of notifications to an FME workspace

Y

Y

Y
Y

Y

Y
Y

.1 UPDATE
The Dropbox subscription and Dropbox Watch publication protocols are new for FME2016.1
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Protocols are pre-defined components in the FME Server architecture and do not need to be defined in the Web User Interface.
However, a number of fields are made available to configure them when a Publication or Subscription chooses to make use of that
protocol.
For example, here are the parameters for an Amazon SQS Subscription:

These parameters must be set when the Subscription is created as they are needed in order to be able to send out a notification
using the protocol.

Miss Vector says...
Tell me, which one of these statements is correct:
1. SMTP and IMAP can both be used as either a Subscription and/or a Publication protocol
2. SMTP can be used as both a Subscription and a Publication; IMAP can only be used for a Publication
3. SMTP can only be used for a Publication; IMAP can only be used as both a Subscription and a
Publication
4. SMTP can only be used for a Subscription; IMAP can only be used for a Publication
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Available Protocols
Probably the two most important protocols are Email and Workspaces, and they are covered in detail in the next few sections.
Some other commonly used protocols are:

Watch Notifications
There are several watch notification protocols: Directory Watch and FTP Watch are the two most common.
These are Publication-only protocols that monitor folders and FTP sites for new files to be added. When a file appears in that
directory then the Topic to which it is tied becomes triggered. The name of the affected file is passed on through the topic
message.
An obvious use is for monitoring a folder in which datasets are stored. When a new dataset is placed into the folder then a
workspace automatically runs to process it.
This protocol allows files to be filtered by the action type, so that it is not just the creation of a new file that can be monitored. It's
also possible to monitor for file deletions and modifications.

Mobile Notifications
Mobile Notifications are Subscription-only protocols that send notifications to mobile devices. The two protocols available are
Apple Push Notification and Google Cloud Messaging.

Apple Device Notifications
The Apple Push Subscriber allows delivery of messages to an Apple iOS device, like an iPhone. Messages are sent from FME
Server to the device via a cloud service called the Apple Push Notification service (APNs).
The FME Server Reference Manual explains how to set up such a notification and what is required in terms of Apple “SSL
Keystore” and device tokens.

Android Device Notifications
Google Cloud Messaging is the Android equivalent to Apple notifications. Again they involve sending content to a mobile device
from an FME Publication.

Amazon Notifications
Several Amazon protocols are supported by FME Server notifications. SNS and SQS are two types of notification system. FME
Server is capable of pushing messages to both of them and receiving messages from both of them. The difference (if you are
interested) is that SNS pushes messages to subscribers immediately, whereas SQS stores the messages in a queue until the
subscriber fetches them.
Amazon S3 is an online file storage service. It can be either a publisher or subscriber in FME Server; i.e. FME can be notified to
read from an S3 "buckets" and can issue a notification in the form of writing to an S3 bucket. The S3 publisher is actually a
"Watch" type notification. FME Server can watch for files arriving there and trigger a notification in response.
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WebSockets Notifications
A WebSocket is an TCP-based line of communication. FME Server can accept and send notifications from/to another WebSockets
client. WebSocket protocols are supported by most web browsers, meaning any web application can communicate to FME Server
and FME Server can send notifications (even small quantities of data) directly to a web browser.
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Exercise 1

Shape Dataset Processing

Data

Orthophoto images (GeoTIFF)

Overall Goal

Trigger notification for new files

Demonstrates

Notification topics and Directory Watch publications

Start Workspace

N/A

End Workspace

N/A

As a technical analyst in the GIS department you want to start trying out notifications. The Directory Watch protocol seems like a
good place to start, and you already were thinking about a shared folder where users occasionally put Shape datasets for adding to
the corporate database.

1) Create Resources Folder
The first step is to create a Resources folder to copy the data to. Open the FME Server web interface and navigate to Manage >
Resources
Browse to the Data folder and create a new sub-folder called ShapeContours:

2) Create Topic
Now to create a publication and topic that will be triggered by a new file. Navigate to Manage > Notifications, click the
Publications tab, and then click the New button.
Enter "Incoming Shape Datasets" as the new publication's name. Then click in the text box under Topics to Publish To. Type in
ShapeIncomingFile and click on "Click to Add". This will create a new topic and assign it to this publication.
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3) Create Publication
Now select Directory Watch as the protocol for this publication. In the dialog that opens below select the newly created resources
folder:

Under the Filter setting, remove the Modify and Delete actions. All we really want to monitor are new files arriving, not old ones
being removed:

Click OK to create the new publication.

4) Monitor Topic
Click on the tab for Topic Monitoring. Add the ShapeIncomingFile topic to the list being monitored:
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5) Test Topic
Now let's test the topic. Locate the source Shape datasets in C:\FMEData2016\Data\ElevationModel\Contours - select a set of
Shape files (.dbf, .prj, .shp, .shx) and create a zip file out of them.
Copy the zip file into the newly created Resources folder. You can do this through the file system (by copying the file to
C:\ProgramData\Safe Software\FME Server\resources\data\ShapeContours) or using the web interface. If you use the web
interface, open a new window or tab, so as not to stop the topic monitoring.

Check back in the topic monitoring window and you will see that the topic has been triggered by the new file:

So now we know how the Directory Watch notification works. For now you can put this project to one side - but come back to it
later when you've learned how to process this information.

CONGRATULATIONS
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By completing this exercise you have learned how to:
Create a new Publication
Create a new Topic as part of the Create Publication process
Use Directory Watch to trigger topics/notifications
Test a publication/topic using Topic Monitoring
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An Introduction to Email Notifications
It’s important to cover email notifications in some detail because they are the most commonly used type of notification on FME
Server.
“Email” is actually a protocol used by Publication and Subscription components. Email Publications receive incoming email from
Publishers and Email Subscriptions send outgoing email to Subscribers.

Email Protocols
FME Server can make use of email messages as both an incoming and outgoing notification protocol. There are two email-related
protocols available in FME Server: SMTP and IMAP.
The SMTP protocol is the ability to directly send or receive an email through an email server built into FME Server.
The IMAP protocol is an indirect process that connects to an email account on a server elsewhere. When that account receives an
email the IMAP protocol passes it on to FME Server.
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SMTP Publications
SMTP Publications are when data is published to FME Server via a direct email. FME Server receives an email and triggers a
Topic in response.

Creating an SMTP Publication
Creating an SMTP publication is done in the Notifications section of the Web User Interface, by choosing the Email (SMTP)
protocol for a new Publication.
Once the protocol type is selected, the publication must also be given a name and an existing topic chosen to be triggered. The
final parameter is the Email User Name; in this example it is set up to be RoadInfo.

Notice the author is prefixing the publication and topic names with "Incoming" so that there is no confusion over which topics are
being used for incoming notification and which ones for outgoing.
Now, whenever an email is sent to RoadInfo@serverhost.com – for example someone is sending an email to report snow on the
road – the IncomingRoadInfo topic is triggered.

Setting up the Email Server
SMTP email publications are possible because FME Server includes an in-built email server as one of its components. However,
this does require that the server has a domain name registered with a DNS name server.
The steps to set up the email server for notifications are documented in the FME Server Reference Manual, and also in the
following exercises.
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Sister Intuitive says …
FME Cloud instances are automatically configured for email notification, and have a public domain name
too, so you don’t need to do any additional setup.
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IMAP Publications
IMAP (Internet Message Access Protocol) is a variation on email for incoming (Publication) notifications.
Instead of using the in-built email server, an IMAP Publication connects to another email server and monitors it for incoming
email. When an email arrives in that account then the Topic to which it is tied becomes triggered.

Creating an IMAP Publication
Like the SMTP protocol, IMAP Publications are set up in the Notifications section of the Web User Interface, by creating a new
Publication and choosing the Email (IMAP) protocol.
Here are the parameters for an IMAP Publication:

Notice that most parameters are for defining the IMAP (Email) server connection.
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Two important parameters let you decide the interval to check for emails and decide whether to fetch all unread emails or new
emails only.
There is also a parameter to select an FME Server resource location in which to store any email attachments:

Monsieur D. Server says …
Most email servers support IMAP functionality, as do the majority of cloud-based email providers such as
Gmail, Outlook.com, Yahoo!, etc; so it’s very easy to have FME Server scan a Gmail account (for
example) for incoming mail, and then act on its contents.
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Email Subscriptions
Email Subscriptions are when FME Server sends an email in response to a Topic. The in-built mail server in FME Server is only
for incoming mail, as is the IMAP protocol, and so messages need to be sent via an existing SMTP email server.

Setting up an Email Subscription
Creating an Email subscription is done in the Notifications section of the Web User Interface, by choosing the email protocol for a
new Subscription.
The Subscription is given a name and an existing topic chosen to be triggered. There are many more parameters for outgoing mail
because the full SMTP server connection parameters need to be defined.

Various fields for the email itself (From, To, Subject, Template) do not need to be hardcoded and can be passed through to the
Subscription from a workspace. Another important parameter is the Email Format, which can either be plain text or HTML.
See the following sections on workspaces for information on how to generate content for outgoing emails.
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Exercise 2

Orthophoto Notification System

Data

Orthophoto images (GeoTIFF)

Overall Goal

Provide email-driven access to orthophoto files

Demonstrates

Notification topics and email publications

Start Workspace

N/A

End Workspace

N/A

As a technical analyst in the GIS department a recent project involved setting up a Data Download solution for users to serve
orthophoto data to themselves. Having read up about notifications in FME Server, you think that it should be possible to also set
up a system that uses email-based automation.

Miss Vector says...
This exercise uses either the SMTP or IMAP protocol for email. To carry out this exercise you will need
access to at least one email account in one of these types.
For SMTP, this requires your FME Server to have a DNS record and SMTP configured.
For IMAP this requires access to an email server that supports the IMAP protocol. Gmail, Outlook, and
Yahoo! all are acceptable web-based solutions. However, be aware that IMAP connections to a Gmail
account can often be blocked as "less secure" leading FME Server to report the account credentials were
invalid. See this Google Support article for more information and a solution to this problem. Additionally,
be aware that this solution won't work for accounts set up with 2-step verification, which need an
application-specific password for less-secure apps to access the account.

1) Create Topic
The first step is to create a publication and topic that will be triggered by the email. So log in to the FME Server web interface and
click on the menu item labelled Manage > Notifications.
Click the Publications tab and then click the New button.
Enter EmailReceiver as the new publication's name. Then click in the text box under Topics to Publish To. Type in
ImagesIncomingRequest and click on "Click to Add". This will create a new topic and assign it to this publication.

216

Exercise: Orthophoto Notification System: Topics and Email

The new publication can be created to use either the Email protocol or the IMAP protocol.
SMTP is easier to set up but FME Server must reside on a server with a proper DNS record (all FME Cloud machines will have
this). IMAP is necessary where FME Server resides on an internal network.

Email Protocol
To use the Email protocol select Email (SMTP) as the Publication Protocol. This will open the Email User Name parameter. Enter
a name for receiving email, for example fmeimageprocessing

Clicking OK will create an email address fmeimageprocessing@<hostname> - for example:
Host

Example Email Address

FME Cloud

fmeimageprocessing@myfmeserver.fmecloud.com

Amazon AWS

fmeimageprocessing@ec1-23-456-789-012.compute-1.amazonaws.com

Now all emails sent to that address will trigger the ImagesIncomingRequest topic.

IMAP Protocol
To use the IMAP protocol select Email (IMAP) as the Publication Protocol. This will open a number of other parameters. Enter
them according to your email account.
In case it is of use, the server information for Gmail is as follows:
IMAP Server Host: imap.gmail.com
IMAP Server Port: 993
Connection Security: SSL
Verify SSL Certificate: Yes
You will also need to check the settings in your Gmail account to make sure IMAP is turned on (by default it is not). Regardless of
the email provider, you should set these parameters as follows:
Poll Interval: 1 minute
Emails to Fetch: New Emails Only.
Select a Resource Folder for attachments to be saved to and click OK to close the dialog and create the new Publication.

InteropGeek68 says …
For IMAP, if you don’t have access to a web-based email account, use fmeimageprocessing@gmail.com
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with the password FMENotifications.

2) Test Publication
Now let's test the publication. In the Notifications page on FME Server, click the tab marked Topic Monitoring. Select
ImagesIncomingRequest as the topic to monitor:

Now send an email to the address selected for the new publication. When the email is received by FME Server (SMPT) or FME
Server fetches it (IMAP) the topic will be triggered with a message:

Remember, an IMAP publication only checks for an email every 60 seconds, so the result might not be immediate.

Ms Analyst says...
In a training course more than one student might be using the IMAP account
fmeimageprocessing@gmail.com, so don't be surprised by multiple messages arriving!

CONGRATULATIONS
By completing this exercise you have learned how to:

218

Exercise: Orthophoto Notification System: Topics and Email

Create a new Publication
Create a new Topic as part of the Create Publication process
Use incoming email to trigger topics/notifications
Test a publication/topic using Topic Monitoring
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Notifications and Workspaces
Workspaces are what make FME Server the ideal engine for Spatial Data notifications

Message Transformation
The simplest setup for the FME Server Notification Service is an incoming message (Publication) tagged with a specific topic that
gets passed as an outgoing message to any Subscription registered with that topic:

However, that scenario does not include any transformation – restructuring – of the message contents. If the message needs to be
processed in some way then an FME workspace can be employed between Publication and Subscription.

A workspace is the key functionality of FME and with one you can read spatial data from a message, in almost any format, carry
out spatial transformations on that data, and then pass on the results to a set of subscribers.
This blend of live messaging with Spatial ETL is unique.
In this scenario a workspace is literally a Subscriber to the incoming Publication, and receives the message content from it. The
workspace then acts as a Publisher, sending an outgoing message to any Subscribers.

Partial System
Of course, the above diagram shows the full potential of a notification system. It would be just as appropriate to have a system
that triggered a workspace in response to a Publication, but without the workspace sending an outgoing message:

For example, a publication triggers a workspace that writes the incoming data to a database.
Similarly, it’s just as appropriate to have a workspace that is run by some other means, and which sends an outgoing message to a
Subscription when it is complete:
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For example, a workspace might be started as a scheduled task. When the task is complete FME sends a notification email to
inform an administrator.

Miss Vector says...
When a workspace is part of a notification system, processing incoming messages, it is a...
1. Subscription
2. Publication
3. Protocol
4. Client
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Workspaces as a Subscriber
When a workspace needs to react to an incoming notification it is done by connecting the workspace to a particular topic using a
specific Subscriber protocol called (as you might have guessed) workspace.

When that topic is triggered (by a Publication or any other means) any workspace connected to that topic through a workspace
protocol is run.

NEW
The workspace subscriber protocol is new for FME2016. It is now the default method to subscribe a
workspace to a particular topic. You should no longer use the Push protocol that was the previous method,
even though it still exists. The new subscriber protocol has more options and is twice as fast in triggering
a workspace.

Registering a Workspace
Registering is done by creating a new subscription using the workspace protocol. The workspace is examined and a list of its
published parameters provided:
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Having the parameters in a dialog like this means it is simple and easy to set up a workspace to run however you want it to in
response to a notification.

Passing Messages
A topic passes on a message in a notification, and the same is true here. For this protocol the topic message is written into a
temporary JSON file and the name of that file passed to a workspace via a published parameter.
There are two ways to set up a workspace to retrieve the filename information.
The first method uses an FME Server parameter called FME_TOPIC_MESSAGE. This is one of the fixed FME Server parameters
exposed inside FME Workbench:
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Another way to obtain the message file location is to send it to a user parameter of your own choice. When the workspace
Subscription is created, this parameter can be selected to receive the topic content file name, in the same way that
FME_TOPIC_MESSAGE does:

Remember, this is only passing the name of the file containing the message - it does not include the message itself. For that you
have to read the contents of that json file.
For instance, you could add a JSON (or Text File) Reader to your workspace and choose its source dataset parameter as the one to
receive the name of the json file. That way the data is read directly into the workspace.
Alternatively, you could use a transformer such as the AttributeFileReader to read the file contents.
Having got the message into Workbench, it's then necessary to deal with it.
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Exercise 3

Orthophoto Notification System

Data

Orthophoto images (GeoTIFF)

Overall Goal

Provide email-driven access to orthophoto files

Demonstrates

Running a workspace in response to a notification

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Notifications-Ex3-Complete.fmw

As a technical analyst in the GIS department a recent project involved setting up a Data Download solution for users to serve
orthophoto data to themselves. Having read up about notifications in FME Server, you think that it should also be possible to set
up a system that uses email-based automation.
So far you have set up a system for incoming email notifications to be registered by FME Server. Now you must create a
workspace to process these and publish it to FME Server. The workspace must then be triggered by a notification topic.

Miss Vector says...
This exercise continues where exercise 2 left off. You must have completed exercise 2 to carry out this
exercise.

1) Create Workspace
Start FME Workbench and begin with an empty workspace. Simply add a Creator and Logger transformer:

This will give us a workspace to run in response to an email; albeit one that doesn’t do much yet. We're just creating this to check
that we can get the setup to work.

2) Save and Publish Workspace
Save the workspace and publish it to FME Server. We only need it to be run (not do anything special) so register it only with the
Job Submitter service.

3) Create Subscription
Return to the FME Server web interface and navigate to the Notifications page. Click on the Subscriptions tab and click New to
create a new Subscription.
Call the subscription "Process Images Request". Subscribe to the topic ImagesIncomingRequest:
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Now set the protocol to Workspace and select the workspace uploaded in the previous step:

Click OK to create the subscription. This will cause the workspace to run every time an incoming email triggers the
ImagesIncomingRequest topic.

4) Test Subscription
Test the subscription by sending an email to the existing publication's email address.
This time, instead of monitoring the topic (although it will appear there again), check the Jobs page. You should see that the
workspace has been run in response to the email:

This proves that the workspace has run.

Ms Analyst says...
Again, in a training course more than one student might be using the IMAP account
fmeimageprocessing@gmail.com, so don't be surprised by multiple job results! Also, if you're using your
own personal email account, any email you receive is going to trigger the workspace, so you too should
not be surprised by multiple job results.

CONGRATULATIONS
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By completing this exercise you have learned how to:
Create a new Subscription
Use the Workspace subscription to run a workspace in response to a topic
Check the job history to prove a workspace was triggered correctly
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Message Content
The ability to interpret and process message content is a key reason for using FME workspaces as a subscriber. They can receive
the message and then transform it in whatever way is required.
As we have seen, when a workspace is triggered by a workspace subscriber, the message content is written to a temporary file and
the name of that file passed to the workspace through a published parameter.
Either a Reader (usually the Text File Reader) or a transformer (the AttributeFileReader) can read the contents of that file.
However, the message is usually in JSON format and must be interpreted before it can be used.

Interpreting the Message
An incoming message can be scanned and processed with a number of different transformers. If the messages are in JSON format
there are transformers such as the JSONExtractor and JSONFlattener. Similarly there are XMLFlattener and XMLFragmenter
transformers for XML content.
These transformers will convert the message from a JSON (or XML) string and into attributes that FME Workbench is able to
process.
Here - for example - an author has added AttributeFileReader and JSONFlattener transformers to their workspace. The
AttributeFileReader reads the JSON content (using FME_TOPIC_MESSAGE to identify the file) and the JSONFlattener
transformer processes the JSON to extract the message as an attribute called subscriber_content

If the incoming message was an email then the JSON content may look like this:
{
"fns_type": "email_publisher",
"email_publisher_to": "demo@somehost.com",
"email_publisher_subject": "MIME message from sender",
"email_publisher_content{0}": "Testing Email",
"email_publisher_content_type{0}": "text/plain",
"email_publisher_from": "sender@somehost.com",
"email_publisher_received": "Thu May 17 11:15:46 PDT 2012",
"email_publisher_sent": "Thu May 17 11:15:46 PDT 2012",
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}

Notice how it includes the email from and to fields, plus the content itself.
When converted into FME attributes using the JSONFlattener transformer the result – as shown in the FME Data Inspector – will
look something like this:

Now the content is available to the workspace as a set of attributes and can be processed as required.

Using the Message
What you do with the message depends on your required setup. If the topic is merely a trigger, and the message is unimportant, it
could be ignored. However, in most case the message content is important.
There are almost limitless ways FME could be used to process an incoming message. However, one useful example to consider is
when the message contains the name of a dataset that the workspace should read. There are two possible scenarios there.
If an email arrives with a dataset attached, the attachment will be stored on the file system and part of the JSON content will
specify the attachment as a path:
"email_publisher_attachment{0}": "C:\\Temp\\demo246129673106713_canada.dwg"

Similarly, the message might just include the name of a dataset that needs to be read (without it being an attachment). In both
cases a Reader can't be used because we need to extract the name of the dataset before we can read it, so a FeatureReader
transformer - with its ability to read data mid-workspace - becomes the perfect solution.
Another interesting scenario is where the message contains an X/Y coordinate - for example the location of a person. Here the x/y
coordinate could be converted into a point feature with the VertexCreator transformer and from there any number of FME
transformers could be used to carry out spatial processing such as a geofence.
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Exercise 4

Orthophoto Notification System

Data

Orthophoto images (GeoTIFF)

Overall Goal

Provide email-driven access to orthophoto files

Demonstrates

Processing an incoming email message

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Notifications-Ex4-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Notifications-Ex4-Complete.fmw

As a technical analyst in the GIS department a recent project involved setting up a Data Download solution for users to serve
orthophoto data to themselves. Having read up about notifications in FME Server, you think that it should be possible to set up a
system that uses email-based automation.
So far you have set up a system for incoming email notifications to be registered by FME Server and proved that you can use that
to trigger a workspace. Now you must actually edit the workspace to process the incoming email.
One part of the Data Download project clipped raster features to the boundary of a neighborhood. It should be possible to set up
the workspace to have extract the neighborhood name from the subject line of the incoming email.

Miss Vector says...
This exercise continues where exercise 3 left off. You must have completed exercise 3 to carry out this
exercise.

1) Open Workspace
Start FME Workbench and open the workspace: C:\FMEData2016\Workspaces\ServerAuthoring\Notifications-Ex4-Begin.fmw
(you should open this workspace, even if you created one in exercise 3):

This workspace is a cut-down version of the one used for your Data Download project. Notice raster data is read and clipped to
the boundary of a chosen neighborhood.

2) Add Reader
We now need to add a new Reader, which is what we'll use to obtain the content of the email message.
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Select Readers > Add Reader from the menubar. When prompted set the parameters as follows:
Reader Format

Text File

Reader Dataset

C:\FMEData2016\readme.txt

Reader Parameters

Read Whole File at Once: Yes

It doesn't really matter what text file we use as the source, it won't be used anyway. It will be replaced by the content of the
incoming email. The Read Whole File at Once parameter is important. With it we'll receive the email content as a single chunk of
text. Without it we'll receive the content as lots of lines of text, which would be much harder to parse.

3) Add JSONFlattener
Now add a JSONFlattener transformer to the workspace, after the Text File Reader:

Open the parameters dialog. In there select text_line_data as the source of the JSON content. Under Attributes to Expose
manually enter imap_publisher_subject and email_publisher_subject - this will provide us with the email subject line whether we
are using IMAP or SMTP.

There are other components of the incoming email we could expose, but these are all we need for now.

4) Add FeatureMerger
Now we need to filter the flow of neighborhood features to include only the neighborhood defined in our email attribute. There
are various ways of doing this - maybe the ChangeDetector or Matcher would work - but here we'll use the FeatureMerger
combined with the existing Tester.
So, add a FeatureMerger transformer. The Neighborhood features are the Requestor, the JSONFlattener output the Supplier. The
best way is to tidy the canvas to look like this:
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Open the FeatureMerger parameters dialog. Set the requestor and supplier join values to two identical constant values, like so:

This means that the JSON attributes will be copied onto ALL neighborhood features.

5) Edit Tester
Now open the Tester transformer's parameters dialog. You need to set up two test clauses: one to test if NeighborhoodName =
email_publisher_subject and one to test if NeighborhoodName = imap_publisher_subject - the test should be an OR:

Now the feature will pass if it exists in the email subject line - regardless of whether we use the IMAP or SMTP email protocol.

6) Publish to FME Server
Publish the workspace to FME Server. You may (or may not) need to also upload the source raster and KML datasets (depending
on whether your FME Server can access the files on your authoring system). Simply register the workspace with the Job
Submitter service.

7) Update Subscription
The subscription created in the previous exercise was for a different workspace. Therefore navigate to that subscription in the
FME Server interface and change it to run the workspace published in the previous step.
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On choosing the workspace you should get the option to set a couple of more parameters, including where you want the data to be
written to. Choose to write it to Resources > Data > Output (creating the Output folder if it doesn't already exist).
Also - vitally - you get to choose where to send the incoming message. Choose the published parameter for the text file Reader:

This is how the text file Reader knows where to read the incoming JSON email message from.

8) Test Workspace
Test the workspace by sending an email to the Publication email address. Be sure to make the subject line one of the
neighborhoods in Vancouver:
Downtown
Fairview
Kitsilano
Mount Pleasant
Strathcona
West End
Check to ensure the workspace is triggered and run (in the Topic Monitoring and/or Jobs pages) and then look for the output
dataset in Resources > Data > Output

Ms Analyst says...
If the output dataset is missing, check the FME log to see what might have gone wrong. You can return to
the workspace and add Logger transformers at strategic places and try again, giving the log file a bit
more information to help debug problems.

CONGRATULATIONS
By completing this exercise you have learned how to:
Set up a workspace to read and process an incoming JSON message
Filter data in a workspace depending on the value of an incoming message
Update a workspace Subscription to specify where to write output
Update a workspace Subscription to specify where to receive input from
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Workspaces as a Publisher
When a workspace needs to send an outgoing notification it is done by having the workspace trigger a particular topic. In other
words it published information to subscribers.

When that topic is triggered any Subscriber connected to that topic receives the notification, plus any message that the workspace
is passing on.
Publishing notification messages from FME is useful for both sending messages containing content from the data being processed,
and for reporting the status of a translation, such as whether it has run successfully or ended in a failure.
Workspaces can be set up to trigger topics in one of two ways:
Registering with the topic when published
Using a transformer
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Registering a Workspace Publication
The first way to have a workspace communicate notifications is to register it with a topic when the workspace is published to
FME Server.

Here, for example, the workspace is registered with the Data Download service. When the workspace is run using that service, it
will post to the RoadInfo topic on successful completion.
Notifications are sent once the workspace is complete. The way in which the workspace is run is not important. Notifications can
be sent for workspaces run using the Job Submitter Service, or the Data Download Service, or any other service.
Having two Topic parameters is useful because different notifications can be sent depending on whether the workspace succeeds
or fails.
A third parameter - Post Data from Writer - defines the content of the message being sent (more on that to come).

Ms. Analyst says…
Four Topics are pre-installed with FME Server to handle workspace notifications. There are two topics for
the Job Submitter Service (one for success, one for failure) and two for the Data Download Service
(again, one for success, one for failure). These topics are triggered automatically by FME Server so a
system administrator – for example – could subscribe to these topics to receive notifications from all
workspaces.

Miss Vector says...
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I want my workspace to send me an email when it is run, so I know when people are using it to download
data. When I publish it, what should I register it to?
1. The Notification Service
2. The Data Download Service
3. The Email (SMTP) Protocol
4. The Workspace Subscriber Protocol
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Workspace Publishing with a Transformer
Instead of using a Writer and sending a notification at its completion, a workspace can send a notification through a special
transformer called the FMEServerNotifier.
Here a workspace author is sending an FME Server notification when a feature fails the conditions of a Tester transformer:

Notification properties are set in the transformer parameters dialogs (it is a wizard composed of two panes)
The transformer parameters include those for connecting to FME Server, and ones for the topic to post to and the message to be
included. Here the author intends to publish information to a topic called RoadInfo:

There are two advantages to issuing a notification this way, over using the registration method:
The workspace can issue a notification during a translation, rather than at the end of it.
The workspace does not need to be run on FME Server to generate an FME Server notification. It will produce the same
notification when run using FME Desktop.

Miss Vector says…
I've got a workspace that reads 50,000 features, transforms them, and writes them out. If I want to send a
single notification that the features have been read, which combination of transformers would be of most
use?
1. Creator/FeatureWriter/FMEServerNotifier
2. Creator/FMEServerJobSubmitter
3. Creator/FeatureReader/FMEServerNotifier
4. FeatureHolder/Sampler/FMEServerNotifier
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Outgoing Message Content
When a workspace triggers a topic it can include (like other publications) a message.
The ability to construct message content from a variety of sources – including spatial – is a key reason for using FME workspaces
as a publisher. Workspaces can transform data in multiple ways, use it to construct a message, and then dispatch that message to
users as a notification.
When a topic is triggered by the FMEServerNotifier transformer, the message can be defined by an attribute, constructed in a text
editor, obtained from a user parameter, or even set up as a conditional value:

When a topic is triggered by registering the workspace with a service topic, the message is sent via a Writer:

Here the message is being passed through a text file Writer.

Content Format
For the purposes of FME notifications, the content of a workspace publication can be in any format, maybe just a plain text
message. However, for the benefit of a web-based subscriber the outgoing message is often in a JSON or XML format.
For example, here a workspace constructs a plain-text weather (lightning) alert using an AttributeCreator. The message attribute is
connected to a Text File Writer in order to provide a means for publishing the outgoing message:
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Importantly, the text file Writer has a MIME type setting that can be applied:

So even if the message were JSON or XML, standard practice is to use a text writer.

Ms Analyst says...
A Text File Writer is the usual method of supplying messages, regardless of format. i.e. even if the message
is constructed as a snippet of JSON or XML, it would still be passed through the Text File Writer.

Email Content in a Workspace
The message being passed out of a workspace may need to be in the form of an email. This, like any other message, can be
constructed as an attribute with transformers.
For example, for a JSON-formatted email you could construct an attribute like this:
{
"email_to" : "notifications@enduser.com",
"email_cc" : "",
"email_from" : "notifications@fmeserver.com",
"email_replyto" : "",
"email_subject" : "Notification Subject",
"subscriber_content" : "Notification Content"
}

This could be created using an AttributeCreator transformer, where the email addresses and content can be substituted with
attribute or parameter values as required.
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The actual email content could be plain text or, if the Email format is set to HTML in the Notification GUI, then it could be
constructed as HTML instead.

Ms Analyst says...
The FMEServerEmailGenerator is a custom transformer available in Workbench for generating email
content in the correct format and structure
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Exercise 5

Orthophoto Notification System

Data

Orthophoto images (GeoTIFF)

Overall Goal

Provide email-driven access to orthophoto files

Demonstrates

Sending an email response to the user

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Notifications-Ex5-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Notifications-Ex5-Complete.fmw

As a technical analyst in the GIS department you are setting up a solution to deliver raster imagery that is triggered by email.
So far you have set up a system for incoming email notifications to be registered by FME Server and triggered a workspace to run
in response and process the email content. Now let's send a response to the users to let them know their data is ready to download.

Miss Vector says...
This exercise continues where exercise 4 left off. You must have completed exercise 4 to carry out this
exercise.

1) Add Subscription
Open the FME Server web interface and navigate to the Notification management page. Click the Subscriptions tab and then click
New to create a new Subscription. This will be an email service through which a response will be sent.
Give the subscription a name like Send Image Response and create a new topic for it such as ImagesOutgoingResponse (it's
important to use a different topic than the incoming message).
Set the protocol to Email and set up your SMTP email server parameters.

InteropGeek68 says …
If you don’t have access to an email server, use fmeimageprocessing@gmail.com with the password
FMENotifications.

In case it is of use, the server information for Gmail is as follows:
SMTP Server: smtp.gmail.com
SMTP Server Port: 465
Connection Security: SSL
Regardless of the email provider, you should set these parameters as follows:
Email From: Your account name (for example fmeimageprocessing@gmail.com)
Email Subject: "Your Data is Ready"
Most of the general settings (Email To, Email Template, etc.) will be set by the content we are going to provide.
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2) Edit Workspace
Open the workspace from exercise 4 (or the begin workspace listed above). Add two new transformers - the
FMEServerEmailGenerator (a custom transformer) and an FMEServerNotifier - as a separate stream of data:

3) Edit JSONFlattener
To send an email back to the same person who sent the incoming email, we need to expose an attribute with that account name.
So, open the properties dialog for the JSONFlattener and in the Attributes to Expose parameter, add email_publisher_from and
imap_publisher_from

4) Edit Clipper
We need the exposed attributes in the two transformers we placed earlier, but currently it's unlikely such attributes make it past the
Clipper transformer. So, open the Clipper parameters dialog and check the box labelled Merge Attributes:

5) Edit FMEServerEmailGenerator
Now open the parameters dialog for the FMEServerEmailGenerator. We could just set the To parameter to one of the attributes
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we've exposed, depending on what incoming protocol we are using. However, a better solution is to set up the workspace to work
regardless of protocol.
So, click the drop-down arrow to the right of the To parameter and choose Conditional Value. Double-click the first row (where it
says "If") and a dialog will open in which to enter a test condition. Set up a test where email_publisher_from "Has Value". Set the
output value to the email_publisher_from attribute:

In other words, if email_publisher_from has a value then use it for the To field. Click OK to close that dialog.
Now, back in the previous dialog, double-click in the Else > Output Value field and select Attribute > imap_publisher_from from
the attribute list:

In other words, if email_publisher_from has a value then use it for the To field, else use imap_publisher_from
Close this dialog and in the other fields of the FMEServerEmailGenerator, enter a Subject and Message (such as "Your Data is
Ready"):
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Click OK to close the dialog and we have an email ready to send.

6) Edit FMEServerNotifier
Now edit the parameters for the FMEServerNotifier transformer. In the first dialog enter the connection parameters. In the second
dialog pick the topic created earlier (ImagesOutgoingResponse) and for the content select the attribute text_line_data (this is what
was created by the FMEServerEmailGenerator):

7) Publish to FME Server
Publish the workspace to FME Server. You may (or may not) need to also upload the source raster and KML datasets (depending
on whether your FME Server can access the files on your authoring system). Simply register the workspace with the Job
Submitter service.
If the workspace you publish has a different name to that in exercise 3, be sure to navigate to the workspace subscription (Process
Images Request) and change it to point to the correct workspace.

8) Test Workspace
Test the workspace by sending an email to the Publication email address. Be sure to make the subject line one of the
neighborhoods in Vancouver:
Downtown
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Fairview
Kitsilano
Mount Pleasant
Strathcona
West End
You should receive an email in return, alerting you to when your data is ready to collect. If there is no return email, remember to
check to ensure the workspace is triggered and run (in the Topic Monitoring and/or Jobs pages) and then look for the output
dataset in Resources > Data > Output

CONGRATULATIONS
By completing this exercise you have learned how to:
Set up an outgoing email subscription
Set up email content within an FME workspace
Trigger an email subscription through the FMEServerNotifier transformer
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Workspaces as a Subscription AND a Publication
We've looked at how to set up a workspace to subscribe to notifications, and how to set up a workspace to publish notifications. A
workspace can do each task individually, but when it is set up to both subscribe to and publish notifications, the overall setup
looks like this:

In this scenario the same workspace receives an incoming notification sends an outgoing notification. It is set up as a workspace
subscription (in order to receive incoming notifications) and registered with the notification parameters set on a different service
(in order to send outgoing notifications).
For example, details of a lightning strike are received via a LightningStrike topic. The workspace then processes the information –
for example it determines which state/province/county the strike occurred in – creates a new message and dispatches it to
subscribers via a WeatherAlert topic.
The important thing to notice is that the scenario involves two different topics, here Topic I and Topic II.
A major problem occurs if you set up such a scenario but only use one topic. That’s because for every notification the workspace
receives it will publish back to the same topic, triggering itself again and causing an infinite loop of messages.

Daily Interop Reporter, Chad Pugh-Litzer says …
Using the same topic for incoming and outgoing notifications is like setting up your email to forward all
incoming messages to yourself; or like automatically retweeting your own tweets. You’ll end up with a
loop that continues until you crash the system!
To avoid confusion it’s a good idea to clarify which topics are for in and out communication through their
names. For example, use LighningStrike_In and LightningStrike_Out to differentiate topics that are
triggered by incoming alerts and those triggered by outgoing alerts.
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Exercise 6

Shape Dataset Processing

Data

Contour Datasets (Esri Shapefile)

Overall Goal

Trigger notification for new files

Demonstrates

Processing Directory Watch notifications

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\Notifications-Ex6-Complete.fmw

Having carried out various notification tasks, your mind goes back to a Directory Watch project you started but didn't finish. It
involved watching for Shape datasets representing contours. Let's see if we can put that start to a good use.

Miss Vector says...
This exercise continues where exercise 1 left off. You must have completed exercise 1 to carry out this
exercise.

1) Create Workspace
Start Workbench and begin with an empty workspace.
Select Readers > Add Reader from the menubar. When prompted set the parameters as follows:
Reader Format

Text File

Reader Dataset

C:\FMEData2016\readme.txt

Reader Parameters

Read Whole File at Once: Yes

As you know by now, it doesn't really matter what text file we use as the source, it won't be used anyway. It will be replaced by
the content of the incoming message.

2) Add JSONFlattener
Now add a JSONFlattener transformer to the workspace, after the Text File Reader:
Open the parameters dialog. In there select text_line_data as the source of the JSON content. Under Attributes to Expose
manually enter dirwatch_publisher_content
Add Logger transformers after the JSONFlattener

3) Publish to FME Server
Publish the workspace to FME Server, registering it under the Job Submitter service.

4) Create Subscription
Now log in to the FME Server web interface and navigate to Manage > Notifications.
Click on the Subscriptions tab and click New to create a new Subscription.
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Call the subscription "Process Incoming Shape". Subscribe to the topic ShapeIncomingFile
Now set the protocol to Workspace and select the workspace uploaded in the previous step. Under Notification Message Mapping,
select the published parameter for the Text File Reader source dataset.
Click OK to create the Subscription.

5) Test Topic
Locate the source Shape datasets in C:\FMEData2016\Data\ElevationModel\Contours - select a set of Shape files (.dbf, .prj, .shp,
.shx) and create a zip file out of them (as you did in Exercise 1).
Copy the zip file into the newly created Resources folder. You can do this through the file system (by copying the file to
C:\ProgramData\Safe Software\FME Server\resources\data\ShapeContours) or using the web interface.

6) Check Results
Now Navigate to Manage > Jobs. Under completed jobs should be the workspace you just caused to run. View or download the
log file and look for the logged feature. You should find it has an attribute containing JSON, and a number of attributes extracted
from the JSON.
dirwatch_publisher_action

CREATE

dirwatch_publisher_content

ENTRY_CREATE C:\ProgramData\Safe Software\FME
Server\resources\data\ShapeContours\K11.zip

dirwatch_publisher_path

C:\ProgramData\Safe Software\FME Server\resources\data\ShapeContours\K11.zip

So now we know what the data looks like and can process it accordingly.

7) Edit JSONFlattener Transformer
Back in FME Workbench open the JSONFlattener transformer parameters. Under Attribute to Expose add the attribute
dirwatch_publisher_path

8) Add FeatureReader Transformer
Now add a FeatureReader transformer in place of the Loggers:

This is a transformer that will let us read the contents of the dataset. Open the parameters dialog. Set:
Reader Format

Esri Shapefile

Reader Dataset

Select Attribute Value > dirwatch_publisher_path

Output Port

Single Output Port
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Click OK to close the dialog. You may receive a warning message, but it can be ignored.

9) Add Writer
Having read the data from Shape, we can now add it to our corporate database.
Select Writers > Add Writer from the menubar. When prompted set the parameters as follows:
Writer Format

SpatiaLite

Writer Dataset

C:\FMEData2016\Output\Contours.sl3

Writer Parameters

Overwrite Existing Database: No
Drop Existing Tables: No

Add Feature Types

Table Definition: Manual

In the new feature type that is created, simply change the name to contours:

Click OK to close the dialog and connect the new feature type to the FeatureReader transformer's <Generic> output port:

10) Republish Workspace
Publish the workspace back to FME Server
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11) Adjust Subscription
Navigate to Manage > Notifications and open the Process Incoming Shape Subscription for editing. The settings should now
include one for the output database. Change it to write the database in the Resources folder:

Don't - for fairly obvious reasons - write it back to the same folder as the incoming Shape data!

12) Test Solution
Now test the solution by putting more zipped Shape data into the directory watch folder. You will find that each dataset put into
the folder is added to the SpatiaLite database:
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CONGRATULATIONS
By completing this exercise you have learned how to:
Use Loggers to identify what JSON attributes an incoming message provides
Use a FeatureReader transformer to read the data added to a Directory Watch folder
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Troubleshooting for Administrators
This section shows a few basic troubleshooting techniques in case of emergency

FME Server Fails to Receive Email
If you are unable to receive email on FME Server then the following suggestions may be of help:
Ensure you carry out the post-installation configuration steps as noted in the reference manual. Without this only local mail
could be delivered.
Is the FME Server’s email SMTP port open? Typically this will be port 25 or 465.
Does your FME Server have a DNS name that is available on an internet name server or your local DNS setup? Email cannot
be delivered to it if it cannot be found!
For IMAP, is the FME Server’s IMAP port open? Typically this will be port 993.

FME Server Fails to Send Email
If you are unable to send email on FME Server then the following suggestions may be of help:
Have you created and properly configured the Email Subscriber? The Data Download and Job Submitter services have predefined Subscribers, but they will need to be properly configured
Is the FME Server’s email SMTP port open? Typically this will be port 25 or 465
Does the FME Server have an internet connection?

Email Uses Defaults
If email sent by FME Server uses default parameters instead of those you had configured, then the following suggestions may be
of help:
If you are sending an email using the FMEServerNotifier transformer ensure that the Content parameter is set to an attribute
that contains the email message information in JSON format (use the custom transformer FMEServerEmailGenerator)
If you are sending an email from a completed workspace using the Notification Service and Topics to Notify (Success)
ensure the Notification Writer is set to the Text File writer which is writing the email information

Cannot Connect to WebSockets Server
If you cannot connect to a WebSockets server then the following may be of help:
Ensure the FME Server’s WebSockets port (default 7078) is open
Ensure you are using the correct stream_id for sending and receiving between your applications

Workspace Subscription is not Triggered by Topic
If a workspace set to subscribe to a topic is not triggered by it, then the following suggestions may be of help:
Check the Push subscription for the workspace in the Web User Interface and make sure the required Topic is in the list of
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Topics subscribed to
Check the Push subscription for the workspace in the Web User Interface and confirm the username and password for the
subscription. If you have changed your password recently the password for the subscription needs to be changed as well

Topic Monitoring Fails
If topic monitoring fails then the following may be of help:
Monitoring requires the use of WebSockets, so ensure the FME Server’s WebSockets port (default 7078) is open
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Module Review
This module introduced you to FME Server’s Notification Services.

What You Should Have Learned from this Module
The following are key points to be learned from this module.

Theory
Real-time systems are message driven and involve small amounts of information.
The Notification Service handles individual messages. Topics are keywords that define a notification subject.
Publications are FME Server objects that listen for and respond to notifications from clients
Subscriptions are FME Server objects that push notifications to clients
Incoming Notification messages are received from Publishers, outgoing messages are sent to Subscribers
Protocols are the method of communication (for example, email, FTP, Amazon S3, etc.)

FME Skills
The ability to create Topics, Publications, and Subscriptions
The ability to use the Email protocol for Publishing and Subscribing
The ability to use workspaces to process incoming notification messages
The ability to use workspaces to construct outgoing notification messages

Further Reading
For further reading why not check out this blog article on the FME Server notification services being used to create reports in
response to earthquake alerts.
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
All notification setups must have which of these:
1. Incoming components (Publisher, Publication) AND outgoing components (Subscription, Subscriber)
2. Incoming components OR outgoing components OR both
3. Incoming components OR outgoing components but never both
4. None of the above
Although the diagram (under Elements of the Notification System) shows a continuous process, it is not
necessary for all of these components to be used in a setup. If the system is designed for FME Server to
only receive notifications, then only a publisher/publication is needed. Likewise, if the system is intended
for FME Server to only send notifications, then only a subscription/subscriber is required. But if both
receiving and sending notifications is required then all components apply.

Miss Vector says...
Please don't get this wrong! Publications and Topics have what relationship?
1. One:One (Each publication has one topic, each topic belongs to one publication)
2. One:Many (Each publication can have many topics, each topic belongs to one publication)
3. Many:One (Each publication has one topic, each topic can belong to multiple publications)
4. Many:Many (Each publication can have many topics, each topic can belong to multiple publications)
You got it wrong? I'm not angry... just terribly, terribly disappointed!

Miss Vector says...
Tell me, which one of these statements is correct:
1. SMTP and IMAP can both be used as either a Subscription and/or a Publication protocol
2. SMTP can be used as both a Subscription and a Publication; IMAP can only be used for a
Publication
3. SMTP can only be used for a Publication; IMAP can only be used as both a Subscription and a
Publication
4. SMTP can only be used for a Subscription; IMAP can only be used for a Publication
See the table under Notification Protocols for the full list of which protocol can be used for which type of
notification

Miss Vector says...
256

Q+A Answers

When a workspace is part of a notification system, processing incoming messages, it is a...
1. Subscription
2. Publication
3. Protocol
4. Client
It is a client! In this case it is a subscriber (it is subscribing to messages produced by a Publication). If it
were sending messages it would be a publisher (publishing messages to a Subscription).

Miss Vector says...
I want my workspace to send me an email when it is run, so I know when people are using it to download
data. When I publish it, what should I register it to?
1. The Notification Service
2. The Data Download Service
3. The Email (SMTP) Protocol
4. The Workspace Subscriber Protocol
I'm setting it up for people to download data, so I register it as a Data Download service. It's as simple as
that. To get a notification I just have to pick a topic to trigger in the Data Download settings. Of course, to
get an email I must set up an email Subscription connected to that topic - but that has nothing at all to do
with how I register the workspace!

Miss Vector says...
I've got a workspace that reads 50,000 features, transforms them, and writes them out. If I want to send a
single notification that the features have been read, which combination of transformers would be of most
use?
1. Creator/FeatureWriter/FMEServerNotifier
2. Creator/FMEServerJobSubmitter
3. Creator/FeatureReader/FMEServerNotifier
4. FeatureHolder/Sampler/FMEServerNotifier
I'm sending a notification (not running a job) so use the FMEServerNotifier. I already have a Reader so I
don't need a transformer to read or write data. However I do need a Sampler transformer to reduce the
number of features down to one; otherwise I'll send 50,000 notifications. The FeatureHolder ensures the
notification is not triggered until all features have been read. It would look like this:
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Message Streaming with FME Server
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What is Message Streaming?

Message Streaming
Message Streaming is a real-time technique. Whereas Notifications are one-off messages, Message Streaming involves a
continuous flow of information
For our purposes, “continuous” means messages arrive at the FME Server at a faster rate than the notification service could
handle; say more than one message per second.

Why Use a Message Stream?
When a workspace is involved as a subscriber, processing messages, the notification service operates by starting and running the
workspace on demand, in response to an incoming publication.
However, problems occur when the average message interval is less than the time taken for the notification service to start and run
a workspace. A message interval of one second or less is the threshold at which the notification service starts to struggle.
In a message stream the workspace used for message processing is constantly running and doesn’t need to be started each time.
Because of this it can process data at a much faster rate than the notification service.
When used in this way we call it High Capacity Message Streaming, as thousands of messages can be processed every second.
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Elements of a Message Stream
Like Notifications, Message Streams can be either into or out of FME, or both:

However, rather than use the Notification service with Readers and Writers, Message Streams are handled by transformers. A
"receiver" transformer acts as a subscriber, listening to a message stream and responding when one is received. A "sender"
transformer acts as a publisher, creating a message and sending it to an open message stream.

Transformers and Protocols
A number of transformers can handle message streams, each of which is tied to a specific protocol.
Transformer
Receiver

Protocol
Sender

JMSReceiver

JMSSender

Java Messaging Service (JMS)

WebSocketReceiver

WebSocketSender

HTML5 WebSockets

TCPIPReceiver

TCPIPSender

Transmission Control Protocol (TCP)

SQSReceiver

SQSSender

Amazon Simple Queue Service (SQS)

KinesisReceiver

KinesisSender

Amazon Kinesis Streams

TweetStreamer

Tweeter

Twitter API

PythonCreator

PythonCaller

Others

Receiver Transformers
All receiver transformers in this list are designed to listen continuously to a message source and emit features only when a
message arrives. Even then, the transformers will go on listening and awaiting more messages. Therefore a workspace containing
any of these transformers will run continuously and not need to be stopped or started for each message.

Sender Transformers
All sender transformers in this list will emit a message for each feature that enters. They don't, by themselves, keep a workspace
running continuously and will shutdown when incoming data is exhausted. However they will keep their connection open if a
Receiver is still running, therefore a continuous flow of outgoing messages requires both a Receiver and Sender.

Python Transformers
The PythonCreator and PythonCaller aren't specifically designed to connect to particular message protocols, but they can be made
to do so and are particularly useful for protocols not otherwise supported in FME.
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Miss Vector says …
Which of the Receiver transformers has a parameter to stop it running continuously? Select all that apply.
1. SQSReceiver
2. WebSocketReceiver
3. JMSReceiver
4. TCPIPReceiver
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Message Streaming Architecture
A Message Streaming architecture that both receives and sends messages looks like this:

A stream of messages is read into the workspace via one of the available transformers, for example the JMSReceiver
Each message is processed by any of the available FME transformers, according to the needs of the project
A stream of messages is sent out of the workspace via one of the available transformers, for example the TCPIPSender
Although the diagram shows a continuous process, it is not necessary for all of these components to be used in a setup. If the
system is required to only receive messages, then only a Receiver transformer is needed. Likewise, if the system is intended to
only send messages, then only a Sender transformer is required.
If both receiving and sending messages is required, then all components are necessary. However it's still possible to split those
actions up across several workspaces.

Databases
The Database components in this diagram are optional, but usual. Messages will usually need to be processed against some other
datasets (for example overlaid against a geofence) and a database is the quickest solution for reading and writing data.
Data read from a database is intended to be used to process the incoming message. For example perhaps the message represents a
point feature (maybe a vehicle location) that is used to filter database data (maybe traffic conditions) against.
Data written to the database is usually to record a stream of message information. For example, perhaps each incoming message
represents a point feature (a lightning strike) that needs to be written to a database for an historic record.

Miss Vector says …
Writing to a database in a High Capacity Message Streaming setup requires that the transaction interval
is set to what value?
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1. <Not Set>
2. Zero (0)
3. One (1)
4. Infinity (∞)

264

Exercise: Handling Emergency Phone Call Streams

Exercise 1
Data

Event Messages (JSON)

Overall Goal

Create a workspace to read, parse, and filter WebSocket messages; keeping only events that
affect transit stations.

Demonstrates

Creating a workspace to handle a message stream

Start Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\DataStream-Ex1-begin.fmw

End Workspace

C:\FMEData2016\Workspaces\ServerAuthoring\DataStream-Ex1-Complete.fmw
C:\FMEData2016\Workspaces\ServerAuthoring\DataStream-Ex1-Process-Complete.fmw

As a technical analyst in the GIS department you deal with spatial data. Sometimes you need to process that data in real-time and
sometimes that data can arrive in great quantities and at great speed.
In one such case, the city has been given access to the monitoring systems of emergency services. That means the ability to access
in real-time information about all emergency calls.
By emergency calls we mean the equivalent of 911 calls in North America, 999 in the UK, 112 in most of Europe, and 000 in
Australia.
Of course, these calls can arrive at a tremendous rate, and at unknown intervals. If the city wishes to respond to any of these, and
even if they wish to just record a history of the calls, you must implement a message streaming setup in FME Server.

1) Open Workspace
Unfortunately (I'm talking from a training point of view) we don't have access to a real-time stream of emergency phone calls, so
we will have to generate our own.
Open the workspace C:\FMEData2016\Workspaces\ServerAuthoring\DataStream-Ex1-begin.fmw
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.1 UPDATE
The Cloner transformer gained a Rejected port in FME2016.1

Notice that the workspace generates a stream of events. A random number of events are generated, at random times, and at
random locations. Additionally random severity and event type attributes are generated.
Each event is wrapped up into a JSON format message. All that we need to do is push that message out as a stream.

Miss Vector says...
This workspace is just generating "events". Those events could be lightning strikes, vehicle locations,
traffic accidents, or even UFO sightings! For this exercise, we'll pretend they are emergency phone calls.
In real life you would be connecting to an existing stream of data, and wouldn't need to generate one in
this way.

2) Add WebSocketSender Transformer
Add a WebSocketSender transformer after the JSONTemplater. Open the parameters dialog. Set the parameters as follows:
WebSocket Server URL

ws://localhost:7078

Verify SSL Certificates

No
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{
ws_op: "open",
ws_stream_id: "EmergencyEvents"

Connection Preamble
}

{
ws_op: 'send',
ws_msg: '@Value(EventMessage)'

Data To Transmit
}

Click OK to close the parameters dialog and then save the workspace.

3) Create Workspace
Now we have the ability to generate a stream of data we will create the workspace that is to process the data. Start Workbench and
begin with a blank canvas (don't close the stream generator workspace, as we'll need that as well in a moment).
In the blank canvas add a Creator transformer and follow it with a WebSocketReceiver. Open the WebSocketReceiver's
parameters dialog. Set the parameters as follows:
WebSocket Server URL

ws://localhost:7078

Verify SSL Certificates

No
{
ws_op: "open",
ws_stream_id: "EmergencyEvents"

Connection Preamble
}

Output Attribute

IncomingMessage

Close the dialog and add a Logger transformer after the WebSocketSender.

4) Publish Workspaces
Let's test what we have by publishing the workspaces and running them on FME Server.
Publish each workspace in turn. In both cases simply register it with the Job Submitter service. There are no datasets or other
parameters we need worry about.

5) Run Workspace
Log in to FME Server, locate the data stream generator workspace, and run it. The dialog in response will look like this:
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The workspace will run for a long time and we can leave it to do so. Click the Home button and locate the processing workspace.
Now run that.
Again the workspace will run as report that it will continue to do so.

6) Check Jobs and Cancel
From the menu select Manage Jobs and click the tab labelled Running. You will see the two jobs:

Let the jobs run for a minute or two. Then choose each of them and click the Cancel button to cancel them:

Once cancelled, go to the Completed jobs tab. You'll see the two cancelled jobs:
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Click on the processing workspace job and check the log. You should see messages in the log like this:
|===========================================================================
INFORM|WebSocketReceiver_Output: Feature is:
INFORM|+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
INFORM|Feature Type: `WebSocketReceiver_Output_LOGGED'
INFORM|Attribute(encoded: utf-8): `IncomingMessage' has value `{ "EventID" : 6.....
INFORM|Attribute(string)

: `fme_geometry' has value `fme_undefined'

INFORM|Attribute(encoded: utf-8): `fme_type' has value `fme_no_geom'
INFORM|Geometry Type: Unknown (0)

This proves that the WebSocketReceiver is acting as expected and receiving messages from the message stream.

Miss Vector says...
You've proved that you can create a workspace to process a message stream, which is the important part
of this exercise. But if you have the time, let's see what improvements we can add to make the result more
realistic.

7) Add JSONFlattener
The first thing to do with incoming messages is to extract information as attributes. Because the incoming data is JSON format,
add a JSONFlattener transformer to the processing workspace. Open the parameters dialog and set the attribute IncomingMessage
as the JSON Document to process.
Under Attributes to Expose manually enter:
EventID
EventLocation.EventXCoord
EventLocation.EventYCoord
EventSeverity
EventType
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You will now have the information from the message available as a set of attributes in the workspace.

8) Add VertexCreator
Now add a VertexCreator. Set it up to use the X/Y attributes to create a true point feature:

With this we now have a true geographic feature and can process it as required.

9) Add Reader
The public transportation team within the city has learned you are working with this emergency data. They wish to be alerted
immediately if there is an emergency event within 200 metres of a transit station. Let's show them how easy it is to set this up.
Firstly we need the transit station data, so select Readers > Add Reader and add the following:
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Reader Format

Esri Geodatabase (File Geodb API)

Reader Dataset

C:\FMEData2016\Data\CommunityMapping\CommunityMap.gdb

When prompted (or in the parameters dialog) ensure that only the TransitStation table is selected.

10) Filter Data
Now let's filter the emergencies.
Firstly, add a Bufferer transformer to the TransitStation feature type and buffer the features by 200 metres.
Secondly, add a PointOnAreaOverlayer to assess whether an emergency falls inside one of these buffers. The workspace will now
look like this:

.1 UPDATE
The Bufferer transformer gained a Rejected port in FME2016.1

At the moment there is one big problem that stops this from working. The PointOnAreaOverlayer transformer is a Group-Based
transformer, sometimes called a "blocker". It will hold on to features until it has finished being fed them, before outputting any
data. In our case we want to make it Feature-Based; i.e. it will process each message at once.
So, open the PointOnAreaOverlayer parameters and set Areas First to Yes:

This tells the transformer that all area features (buffered stations) will be first to arrive, therefore any point features (message
locations) can be processed immediately. However, we have to ensure that the transit features will arrive first. Therefore open the
Creator transformer parameters and set Create at End to Yes:

Now, all being well, the transit features will arrive first at the PointOnAreaOverlayer
Finally, add a Tester transformer after the PointOnAreaOverlayer. Set up the test to check for _overlaps > 0 (i.e. where the
message location falls inside a transit station buffer). Connect some Logger transformers to the Tester output ports:
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Note that, if there were other parameters (for example the transit team were only interested in Event Types 7, 8, 9, and 10) you
could add them to this Tester as well.

11) Publish Workspaces
Now publish the two workspaces again (you may or may not have to upload the TransitStation Geodatabase along with the
workspace) and run them using the same process as before, but leave it for a few minutes longer, as it may take a while for one of
the random events to fall inside a transit station buffer.
Once stopped, check the logs and you should see that messages falling within 200 metres of a transit station are logged (with a
different header).

Miss Vector says...
If you want to adjust the settings to get a result quicker, then go ahead. For example, you might set the
buffer size to 500 metres instead of 200, or you might reduce the interval time on the message generator.
Feel free to make whatever parameter changes you like to test the setup. You could even bypass the
Decelerator transformer altogether to see how fast FME can deal with the incoming messages! But if you
do that, be sure to start the processing workspace first, else the generator might finish by the time you do
get the processor started!

12) Add Writer
The messages that are being received are not all being used by the transit team, but we should probably keep a record of them. So
select Writers > Add Writer from the menubar. Use the following parameters to add a database Writer:
Writer Format

SpatiaLite

Writer Dataset

C:\FMEData2016\Output\EventMessages.sl3

Writer Parameters

Advanced : Transaction Interval = 1

Add Feature Type(s)

Table Definition: Automatic

In the newly added feature type, change the name to events and close the dialog. Connect the feature type to the VertexCreator
output port (i.e. we're recording all events, not just the filtered ones):
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The attributes are added automatically, but include a few we don't need. So open up the properties dialog again for the feature type
and click the User Attributes tab. Change it from Automatic to Manual and delete the attributes:
_creation_instance
incomingmessage
eventlocation_eventxcoord
eventlocation_eventycoord

Notice that the attributes were automatically renamed (to lower case and removing disallowed characters) to match SpatiaLite
requirements.
If you publish and run the workspace now you should be able to see - while the workspace is still running - the results being added
to the database. You can inspect the file in the FME Data Inspector to prove this.

13) Create Notification
One last task (I promise). The filtered messages are important to the transit team, but at the moment they are going nowhere. We
should set up a way to inform them.
We could add another messaging transformer, such as the WebSocketSender, JMSSender, SQSSender, or even a Tweeter. That
would make the processing workspace a "pure" messaging workspace.
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On the other hand, the outgoing messages are nothing like the same rate as the incoming messages. With the parameters as
described in this exercise, there is only a transit message once every minute. So, we can create a "hybrid" solution by setting
output messages to be sent via the notification service.
Go to the FME Server web interface and navigate to Manage > Notifications.
Create a new Topic called EmergencyTransitMessages:

Now create a new notification Subscription. There are various protocols we could realistically use for sending a message (email
springs to mind) but for the purposes of this exercise use the Logger protocol. Set the Log Level parameter to High:

14) Add FMEServerNotifier Transformer
Back in the processing workspace in Workbench, remove any Logger transformers at the end of the workspace. Add an
FMEServerNotifier transformer connected to the Tester:Passed port:
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Open the parameters dialog and set it up to send a message to the EmergencyTransitMessages topic. Set the message content to be
whatever you like. You could use the text editor dialog to create something out of the available attributes (it can be plain text, it
doens't have to be JSON or XML).

15) Publish and Run Workspaces
Re-publish and set the workspaces running again. Click Manage > Notifications and click on the Topic Monitoring tab. Set the
EmergencyTransitMessages as the topic to monitor.
In a short while you will start to see emergency messages like this:

Visit Manage > Resources > Logs > core > current > subscribers > logger.log to find the results as recorded by the Logger
protocol notification.

CONGRATULATIONS
By completing this exercise you have learned how to:
Send and receive messages via WebSockets
Publish and run message-streaming workspaces
Cancel message-streaming workspaces and check their log files
Extract attributes from JSON messages
Use transformers to transform and filter a message according to its content
Set up workspaces to handle group-based transformers in a real-time scenario
Record incoming messages into a database
Set up a hybrid system with message streaming and notifications

275

Exercise: Handling Emergency Phone Call Streams

276

Module Review

Module Review
This module introduced you to FME Server’s Automation Functionality.

What You Should Have Learned from this Module
The following are key points to be learned from this module.

Theory
Message Streams are set up using transformers and involve a workspace that runs continuously receiving/sending messages

FME Skills
The ability to create a workspace for handling a message stream

Further Reading
For further reading why not check out this blog article on JMS message streaming at 125,000 messages per hour!
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Which of the Receiver transformers has a parameter to stop it running continuously? Select all that apply.
1. SQSReceiver
2. WebSocketReceiver
3. JMSReceiver
4. TCPIPReceiver
The SQSReceiver has the ability to switch to a number of messages to read, and the TCPIPReceiver has
the option to close the connection once the publishing client disconnects.

Miss Vector says...
Writing to a database in a High Capacity Message Streaming setup requires that the transaction interval
is set to what value?
1. <Not Set>
2. Zero (0)
3. One (1)
4. Infinity (∞)
Setting the transaction interval to one means that each message is committed as it arrives. Any other value
(in this list at least) would probably mean the data is never committed until the workspace was terminated.
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Course Wrap-Up
Although your FME training is now at an end, there is a good supply of expert information available for future assistance.
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Product Information and Resources
Safe Software Web Site
The Safe Software web site is the official information source for all things FME. It includes information on FME products, Safe
Software services, FME solutions, FME support and Safe Software itself.

Safe Support Team
Behind FME are passionate, fun, and knowledgeable experts, ready to help you succeed, with a support team philosophy built on
the principle of knowledge transfer.
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Your Local Partner
Safe Software has partners and resellers around the world to provide expertise and services in your region and your language.
You can find a list of official partners on the Safe Software web site.

Safe Software Blog
The Safe Software blog provides technical information about FME, articles about customers' use cases, and general thoughts on
spatial data interoperability.
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FME Manuals and Documentation
For FME Server documentation, look under Documentation in the Start Menu:

For FME Desktop use the Help function in FME Workbench to access help and other documentation. Alternatively, look on our
web site under the Knowledge Center section.
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Community Information and Resources
Safe Software actively promotes users of FME to become part of the FME Community.

The FME Knowledge Center
The FME Knowledge Center is our community web site - a one-stop shop for all community resources, plus tools for browsing
documentation and downloads.

Knowledge Base
The FME Knowledge Base contains a wealth of information; including tips, tricks, examples, and FAQs. There are sections on
both FME Desktop and FME Server, with articles on topics from installation and licensing to the most advanced translation and
transformation tasks.

Community Answers
FME community members post FME-related messages, ask questions, and share in answering other users’ questions. Members
earn "reputation" and "badges" and there is a leaderboard of the top-participating users. Come and see how they can help with
your FME projects!

Ideas Exchange
FME development is very much user-driven. The Ideas Exchange gives users the chance to post their ideas for new FME
functionality, or improvements to existing functionality, and allows everyone to vote on the proposed ideas. The more votes an
idea gets, the more likely it is to be implemented!
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The FME Channel
This FME YouTube channel is for those demos that can only be properly appreciated through a screencast or movie. Besides this
there are a host of explanatory and helpful movies, including recordings of most training and tutorials.
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Feedback and Certificates
The format of this training course undergoes regular changes prompted by comments and feedback from previous courses.

Course Feedback
Miss Vector says...
There's one final set of questions – and this time you'll be telling me if the answers are correct or not!
Safe Software greatly values feedback from training course attendees and our feedback form is your chance to tell us what you
really think about how well we’re meeting your training goals.
You can fill in the feedback form now, but you'll also be reminded by email shortly after your course. Safe Software's partners
who carry out training may ask that you fill in a separate form, but you can also use the official Safe Software form if you wish.

Certificates
Mr. E. Dict, (Attorney of FME Law)says...
In order to prove you have taken this training course, a certificate will be emailed automatically to anyone
who was logged on for the duration of Safe Software hosted courses.
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Thank You
Thank you for attending this FME training course.
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Congratulations!
As a reward for reading this far, here's a little quiz for you to try out.
As you may know, if you opt in, FME records information about what formats and transformers you are using. It lets us create
general statistics and shows us where to focus our development work.
The following questions are based on these statistics for FME2016 beta (from the time it first appeared on our web site, up until
December 2015). They refer to the number of times a transformer or format was added to a workspace, by a user.
Each question has a number of correct answers. Your job is to pick one of these answers, but get the LOWEST score you can; i.e.
identify a transformer or format that was used as little as possible during the beta period!
The ultimate answer is one that is pointless (i.e. with no score)!
So, here goes...

Miss Vector says...
Without looking in Workbench (that would be cheating) identify a transformer that is in the Filters
category in the transformers gallery in FME2016. Remember, you're trying to guess one that was as little
used as possible!
One answer is very high (you can probably guess which). But there are two transformers that were not
used at all in the 2016 beta phase and so will score zero points. Will the transformer you select be one of
those?!
If the transformer you select is incorrect - i.e. it is not a transformer in the Filters category - then you will
score 100 points!

Dr Workbench says...
Again without looking in Workbench, identify a Reader in FME2016 that includes the word "XML" in its
full FME name.
I don't just want an XML-based format. For example "GeoRSS/RSS Feed" might be XML-based, but it
doesn't have the string "XML" in its name, so it doesn't count. There are nine different formats to choose
from, and four of them will score you zero points, so your chances are quite good!

Sister Intuitive says...
I'll be kind to you. All I need is a transformer whose name begins with the word "Attribute".
There are lots of these - and I'm including aliases - so you shouldn't get a completely wrong answer.
However, it will take a lot of meditating to choose the one transformer that is a zero score.
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Police Chief Webb-Mapp says...
So! You think you're good, do you? Well here is a really tough question to sort out the good guys from the
bad.
The What's Great in 2015 article on the FME blog listed 18 transformers that were new in 2015 (or a
2014 Service Pack). All you have to do is name one.
That shouldn't be too hard, should it? Not many were used much in the 2016 beta period, so if you can get
it right, you will score well!

Miss Vector says...
Have you written down your answers? And are you sure you didn't cheat? Good.
To find out what your score is, visit this page: http://www.safe.com/training/quiz/
Good luck!
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